8966 Pro Software
Tax Year 2018 Help Manual

by 1099 Pro, Inc.

1099 Pro, Inc.—a leader in information reporting and compliance solutions—proudly offers advanced, user-friendly software products. 8966 Pro software prints FATCA Form 8966 to plain paper and generates XML files that can be compiled into an IDES compatible data archive.

This help manual provides comprehensive instructions on the utilities and features of 8966 Pro software.
# Table of Contents

**Ch. 1 Getting Started**
- About 1099 Pro, Inc. ................................................................. 1
- Disclaimer ................................................................................. 4
- Registration & Upgrades .......................................................... 5
  - Demo Mode ............................................................................. 6
- SSAE 16 SOC I Type II Certification ........................................... 6
- System Requirements ................................................................. 6
- Browser Requirements ............................................................... 6

**Ch. 2 Getting Help**
- Quick-Tour ............................................................................... 7
- Special Help .............................................................................. 8
- Support Options ......................................................................... 9
- Keyboard Shortcuts ................................................................. 10
- Tag Records ............................................................................. 10

**Software Installations**
- Single-User Installation ............................................................ 11
- Multi-User Installation .............................................................. 12
  - Multi-User Considerations ..................................................... 13
- Update Software ....................................................................... 14

**Data Files** ............................................................................ 15
- Backup Data ........................................................................... 15
- Restore Data ........................................................................... 17
- Roll Forward Data ................................................................... 17

**Ch. 3 Deadlines**
- Form 8966 Deadlines ............................................................ 18
- Penalties .................................................................................. 19

**Ch. 4 Menu Bar Items**
- File ....................................................................................... 20
  - Filers .................................................................................. 20
    - Browse Filers ..................................................................... 20
      - Sponsored Entity/Intermediary ........................................ 21
      - Add a Filer ..................................................................... 21
      - Contact Information ..................................................... 22
      - Duplicate Filers ........................................................... 22
      - Change a Filer .............................................................. 23
      - Delete a Filer .................................................................. 23
      - Filer Record Details ..................................................... 23
        - GIIN Composition ....................................................... 26
        - Select GIIN ............................................................... 27
        - FATCA Identification Number ...................................... 28
Ch. 6 Troubleshooting

Error Messages .................................................................................................................. 138
Error Code 0002:0005 ................................................................................................. 139
Invalid Record Declaration (47) ................................................................................. 139
Uploaded Data Size Mismatch ...................................................................................... 139
Unable to Open Required File (ProTips): 2—File Not Found ...................................... 140
Unable to Open Required File (ProTips): 3—Path Not Found ...................................... 140
Unable to Open SystemID: 2—File Not Found ............................................................ 140
Unable to Open SystemID: 3—Path Not Found ............................................................ 141
Unable to Open SystemID: 5—Access Denied ............................................................. 141
Unable to Open SystemID: 53—Invalid Clarion File .................................................. 142
Clarion Trappable Runtime Errors ............................................................................. 142
EC002 - Unable to Open Files ..................................................................................... 144
Error Code 0008—Can't Find Stub Loader .................................................................. 145
Error Could Not Load DLL Library ............................................................................. 145
Single User Version Error ........................................................................................... 145
File Not Found: Information Request .......................................................................... 145
Software Not Responding ............................................................................................ 146

Printer Issues ................................................................................................................. 146

Ch. 7 Tax Supplies .......................................................................................................... 147
Ch. 1 Getting Started

Welcome to 1099 Pro, Inc., an industry leader in business tax software solutions!

Getting Started
We encourage you to get started now—prior to the onset of tax season. Take a Quick-Tour and familiarize yourself with our software interface. Download a sample import file and review Import File Conventions. Review IRS penalties for non-compliance.

Getting Help
This season all 1099 Pro software products feature improved context-sensitive help files. Click the "Help" button or <F1> key at any screen for detailed instructions. Need more help? Learn about our online video tutorials, WIKI site, fast & friendly LiveChat support and additional support options too.

Basic Software Functionality
Add Filers
Add Recipients
Add Records
Import Wizard
XML Filing Overview
IDES Packager
Roll Forward Data

Deadlines
8966 FATCA Report

v. 7/31/2018

About 1099 Pro, Inc.

1099 Pro, Inc.

Founded in 1989, 1099 Pro, Inc. is a market-leading provider of information-reporting solutions and services for 1099, W-2, 1042-S, ACA, 8966 and CRS Filers. 1099 Pro develops and markets a comprehensive range of products that enable any size business or institution to effectively manage and be compliant with IRS requirements. 1099 Pro products range from Client Server / ASP applications (capable of filing 100+ million records) utilizing an MS SQL back end with a multi-year presentation of forms via Internet Explorer, to desktop software products for filing from 20 – 100,000 forms, to eFileMyForms.com for Internet filing of < 20 forms. Adjunct products include secure Hosting and Services for information processing, printing, filing and penalty abatement. With the ever-changing IRS laws and regulations, 1099 Pro develops new services, solutions, and software enhancements, remaining ahead of the curve of the industry. 1099 Pro is a Microsoft Certified Partner; MBE certified and has received SSAE 16 SOC I Type II certification.

1099 Pro Software Products

1099 PRO PROFESSIONAL
Professional edition offers a streamlined, cost-effective answer to your tax season. Prepares printing and paper filing for all forms in the 1098, 1099, 3921, 3922, 5498 and W-2G series. For an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

1099 PRO ENTERPRISE
Enterprise software is a powerful information reporting solution designed with simplicity in mind. Enterprise supports the processing, printing, and paper or electronic filing of forms from series 1098, 1099, 3921, 3922, 5498, and W-2G. Through the software users may generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

1099 PRO CORPORATE SUITE
The 1099 Pro, Inc. Corporate Suite software combines the power of our Professional and Enterprise software with the speed, performance, and security of Microsoft’s SQL Server technology, making it the ultimate solution for businesses. Corporate Suite supports the processing, printing, and paper or electronic filing of forms from series 1095 (ACA Compliance), 1097, 1098, 1099, 3921, 3922, 5498, 592-B*, W-2, W-2G, 1042-S and Puerto Rico. Through the software users can generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS/SSA.

1042-S PRO
Prepares form 1042-S on plain paper and allows users to print recipient copies B, C, and D on one page with instructions on a separate page. Through the software users can generate a formatted transmittal file for the IRS FIRE site, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing to the IRS.

W-2 PRO
Prepares forms W-2, W-2C, W-3 and W-3C transmittals. Supports printing to blank or preprinted forms. Through the software users can generate SSA electronic files in the EFW2 format, or for an additional fee, upload data to our Service Bureau for printing, mailing, and electronic filing.

FATCA 8966 REPORTING
1099 Pro's intuitive 8966 Pro software was designed for tax form management and IRS XML reporting. The IRS requires Foreign Financial Institutions (FFIs) from Model 2 countries to report FATCA Form 8966—the FATCA report—directly to the IRS. FFIs from Model 1 countries must report to their host country who in turn transmits to the IRS. Includes the FATCA 8966 IDES Packager™.

FATCA 8966 IDES PACKAGER™
1099 Pro's FATCA IDES Packager allows you to take a plain text Form 8966 XML file generated by 8966 Pro or any other source and compile it into an IDES compatible data archive. The IDES Packager will sign, compress and encrypt your data and save it to the directory of your choice. The FATCA IDES data preparation utility provides drag & drop functionality, certificate verification, and an output log for saving results. The FATCA IDES encrypting and packaging utility will create the sender payload file, encrypt the AES key file, create the metadata file and
create the transmission data packet. The process assumes an HCTA or FFI has an IRS issued Global Intermediary Identification Number (GIIN) or FATCA Entity ID.

**CRS PRO**
CRS Pro allows users to enter an unlimited number of Reporting Financial Institutions (Reporting FI’s) into the software. Each Reporting FI can be setup to transmit to a specific receiving country (e.g., Cayman Islands) and has drop-down menus to help users select the proper CRS codes for:

- Identification Number Type (i.e., TIN / US GIIN / EIN)
- Reporting FI Name Type (e.g., OECD207 - Legal)
- Legal Address Type (e.g., OECD303 - Business)

**eFileViewer® UTILITY**
eFileViewer allows users to easily view and edit Electronic Files generated per specifications from Publications 1220, 1187, EFW2 plus most Puerto Rico filings. eFileViewer is an add-on utility and is sold and run separately from 1099 Pro software products.

**1099 Pro Service Bureau**
The 1099 Pro, Inc. Service Bureau helps companies ease successfully through the tax season. The Service Bureau features a highly secure SSAE 16 SOC I Type II[8] and PCI Compliant environment, configured to process an unlimited volume of records and form types. The Service Bureau can print and mail records to your Recipients, display records online securely via the Web Presentment service, and electronically file your records with the IRS—all at highly competitive rates.

Continue reading to learn more about the services that 1099 Pro offers. Using the simple upload wizard and secure FTP agent available in your 1099 Pro software, users can easily transmit records for printing, mailing, or filing. To make sure users are taking full advantage of our information reporting solutions, we provide extensive support options.

Services include:

**IRS FILING**
We can handle any volume of records for electronic filing. An upload feature, to securely send your files directly to our Service Bureau, is built-in to every version of our software.

**PRINT + MAIL SERVICES**
Printing, mailing, and electronic delivery services are available! Our SSAE 16 SOC I Type II[8] Service Bureau offers a secure, efficient, and user-friendly solution.

**BULK TIN MATCHING**
The Service Bureau can transmit your file to the IRS Bulk TIN Matching Program. A transmission of up to 100,000 records is simple via the 1099 Pro software’s upload wizard and secure FTP agent.

**HOSTING**
Our hosted service provides unparalleled speed, security, and bandwidth in which to run 1099 Pro software. Learn more about our Managed Services (online).
ELECTRONIC DELIVERY
Give your Recipients the option to access their forms from a secure Internet site instead of receiving a mailed form. The electronic delivery option significantly reduces costs.

PRINT + MAIL PLUS WEB PRESENTMENT
The Service Bureau can make your forms available for online viewing and reprinting via our secure Internet site.

WEB PRESENTMENT ONLY
Print and mail your forms in-house and have them available to view via our secure Internet site.

PRESSURE SEAL PRINTING
Our Pressure Seal paper stock, for customers uploading forms for printing and mailing, adds additional security for Recipients. This eliminates the possibility for information to be viewed through an envelope window.

FULL SERVICE
Throughout the year, our regulatory team will work with your team to process your payee and payment information, imports, and balances, as well as reconcile posted information to your business areas. Additionally, we will produce all federal/state returns, act as a transmitter on your company’s behalf, and generate payee statement files, B Notices, and management reports for you.

* The Service Bureau does not print, mail or electronically file Forms 592-B or 8966.

Disclaimer
The 1099 Pro, Inc. methodology of flagging errors and warnings is merely a tool to help detect some of the possible inconsistencies or omissions in your data.

1099 Pro, Inc. does not assert that our system of detecting Errors and Warnings matches that of the IRS/SSA or that our system will detect any or all errors in your data. You may in fact have records that flag no Errors or Warnings and the IRS/SSA may both reject your files and or records and assess significant penalties on the data or lack of data that you submitted or did not submit. 1099 Pro, Inc. assumes no responsibility or liability for the detection of errors, omissions, inconsistencies, warnings, formatting, accuracy or complete filing or processing of your data. This software application identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this application. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.
Registration & Upgrades

Software Activation
To activate a "DEMO" version of software, users must enter their 14 character Authorization code. Activating a demo provides access to all software features and retains existing data. Purchase the software online or contact Sales to obtain your code.

Activate Software
1. On the menu bar select Utilities > Registration And Upgrades.
2. At the Product Registration/Demo Activation screen enter your Authorization Code and click the "Activate Now" button.
3. If your code does not work, please verify the correct version of the purchased software is installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation.

Purchase an Authorization Code

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>New customers can go to <a href="https://www.1099pro.com/products.asp">https://www.1099pro.com/products.asp</a> to purchase software. Renewal customers can go to <a href="https://www.1099pro.com/prodRenewals.asp">https://www.1099pro.com/prodRenewals.asp</a> to renew software.</td>
</tr>
<tr>
<td>Phone</td>
<td>Call Sales toll-free at (888) 776-1099, Monday to Friday, 7AM to 5PM PST. International customers can call Sales at (818) 876-0200.</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:Sales@1099pro.com">Sales@1099pro.com</a></td>
</tr>
</tbody>
</table>

Transaction Limits (Bump Codes)
Transactions are the number of actual tax forms that can be entered or imported—regardless of record status—into 1099 Pro, 1042-S Pro, W-2 Pro or 8966 Pro. A standard installation allows for 5,000 transactions. To enter additional transactions users must upgrade their software installation with a bump code. Bump codes can be purchased online at www.1099pro.com or by contacting Sales at (888) 776-1099.

In multi-user environments, the Bump Code must be entered at the Admin or Web Update work station; this option may not be available at individual work stations (depending on access rights).

Upgrade Transactions
1. On the menu bar select Utilities > Registration And Upgrades.
2. Enter your Upgrade/Bump Code and click "Upgrade Now". Newly entered Bump Codes are immediately reflected in the Current Record Limit.

How Many Transactions Do I Have?
To track records or transactions, refer to the Product Registration/Demo Activation screen:
1. On the menu bar select Utilities > Software Registration/Demo Activation.
2. The Product Registration/Demo Activation screen displays both the Current Record Limit and Current Record Total.
In this example, 236 out of 5,000 transactions have been used.

**Demo Mode**

This software allows testing in demo mode. Certain features including Service Bureau Uploads, Electronic Filing and printing of live data are only available to registered users of this product. Please purchase and register this software to activate all features.

**SSAE 16 SOC I Type II Certification**

1099 Pro, Inc. prioritizes the security of customer data. Every year 1099 Pro goes through an independent SOC I Type II audit from an independent third party, as well as third party AVS compliance scans, to assure protection of all Personally Identifiable Information (PII). The successful confirmation and documentation of those audits and scans are available online at [Independent 3rd Party Audit Results](Independent 3rd Party Audit Results) on the 1099 Pro, Inc. website.

For further information please contact 1099 Pro Sales at [sales@1099pro.com](sales@1099pro.com) or the Service Bureau at [sb@1099pro.com](sb@1099pro.com).

**System Requirements**

**1099 Pro Software Products Minimum System Requirements**

- Windows 7/8/8.1/10
  - 8966 Pro software requires Windows 7, 8, 8.1 or higher with an MS .NET Framework 4.0
- 32 or 64 bit operating system compatible
- Intel Pentium II/Celeron or AMD Athlon/Sempron/Turion (Minimum)
- 512MB RAM or more preferred
- 500+MB free hard drive space
- Video display settings of 800 x 600 (minimum) and small fonts to properly display windows and type.
- For use with ANY Windows compatible printer
- Windows compatible network (optional)
- Review [Browser Requirements](Browser Requirements)

**Browser Requirements**

**Increased User Security**

Effective 6/15/2018, [www.1099pro.com](www.1099pro.com) exclusively supports TLS 1.1 or higher enabled Internet browsers.

**What is TLS?**

Transport Layer Security (TLS) is a protocol that provides privacy and data integrity between two applications.
Why This Is Good For You
This change strengthens the 1099 Pro Service Bureau and software products by requiring that a more secure method of encryption is used to transmit your credit card, account information and tax form data between your computer, the 1099 Pro website, and 1099 Pro Service Bureau.

TLS V1.1 Compatible Browsers
Google Chrome—V22 or higher
Mozilla Firefox—V27 or higher
Microsoft Internet Explorer—V11 or higher
Microsoft Internet Explorer Mobile—V11 or higher
Microsoft Edge—All Versions
Opera—V12.18 or higher
Apple Safari—V7 or higher
Apple Safari (mobile)—V6
Click here to see which browser and version number you are currently using: https://www.whatismybrowser.com.

What If You Are NOT Using a Compatible Browser?
You must use a TLS V1.1 compatible browser to access the 1099 Pro website and/or transmit files to the 1099 Pro Service Bureau via our software or FTP. If you are using an older, incompatible browser we strongly encourage you to contact your IT team and upgrade ASAP!

More information on TLS is available from the PCI Security Standards Council.

Ch. 2 Getting Help

Quick-Tour
All 1099 Pro software products feature an intuitive, user-friendly interface. Context-sensitive help is available at any screen via the <F1> key.
Menu Bar
The menu bar is located horizontally at the top of the screen, underneath the software title bar. The menu bar contains drop-down menus for File, Reports, Forms, IRS, Utilities and Help. Use the <Alt> key and the underlined letter of any menu bar item to access a drop menu, e.g., ALT + U to access "Utilities".

Task Panel
The task panel is the vertical blue bar on the left side of the software screen which provides quick access to common tasks. The task panel is composed of expandable sections including: Reporting FI, Preparing My Forms, Create XML, Utilities and Help & Extras.

Current Filer / Form Type
The currently selected Filer and form type are displayed above the task panel; use the "Select Another Filer" button and/or "Current Form" drop menu to change selections.

Special Help
Some wizard screens include a "?" button for quick access to special help topics. This button typically offers more detailed information than what is available via the standard "Help" button or <F1> key.
Support Options
All 1099 Pro, Inc. software products include context-sensitive help screens—accessible via the "Help" button and/or <F1> key—at every screen. Additional support including immediate, email and phone options are available. Technical support is limited to questions regarding 1099 Pro, Inc.'s software products. We are NOT authorized to provide accounting, tax or legal advice. Please direct such questions to your accountant or attorney.

Immediate Support Options
- Online Video Tutorials
- Review User Error Messages
- TLS Browser Security Requirements
- WIKI Documentation:
  - Software Downloads and Updates, too!
  - Import Field Specifications
  - Service Bureau FAQs

Email Support Options
Email support is available during Office Hours. Corporate Suite users should directly email their designated Account Manager. Please ensure that our emails are white-listed and go to your inbox.

- Online LiveChat Support
- Software Technical Support: support@1099pro.com
- Sales Support: sales@1099pro.com
- Service Bureau Support: sb@1099pro.com

Phone Support Options
If the above options do not resolve your issues, contact Technical Support by phone during Office Hours. Calls are limited during tax season.

In order for us to best assist you please:
- Provide your Customer ID number (located on your invoice) or company name.
- Be seated at your computer with software open.
- Have a list of steps taken prior to the issue or question.
- Provide any error messages that you have encountered.

<table>
<thead>
<tr>
<th>Technical Support</th>
<th>Service Bureau</th>
</tr>
</thead>
<tbody>
<tr>
<td>(888) 776-1099 (toll-free)</td>
<td>(866) 444-3559</td>
</tr>
<tr>
<td>(818) 876-0200</td>
<td></td>
</tr>
</tbody>
</table>

1099 Pro, Inc. Office Hours

<table>
<thead>
<tr>
<th>Regular Hours</th>
<th>Tax Season Hours (January)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monday to Friday: 7AM to 5PM PST</td>
<td>Monday to Friday: 5AM to 5PM PST</td>
</tr>
<tr>
<td>Saturday: Closed</td>
<td>Saturday: 8AM to Noon PST</td>
</tr>
<tr>
<td>Sunday: Closed</td>
<td>Sunday: 8AM to Noon PST</td>
</tr>
</tbody>
</table>

Copyright 1099 Pro® 2018
IRS Telephone Assistance: Information Reporting Support
For IRS specific questions about Forms 1096, 1098, 1099, 5498, W-2G and W-3, please call the IRS at (866) 455-7438 (toll-free) or (304) 263-8700 (not toll-free). For TTY/TDD equipment, call (304) 267-3367. The call site can also be reached via email at mccirp@irs.gov.

IRS General Support
For other tax information related to business returns or accounts, call (800) 829-4933 or visit the IRS website.

Keyboard Shortcuts
All 1099 Pro software products include keyboard shortcuts to increase user efficiency.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;ALT&gt;</td>
<td>At any screen or drop menu hold and press the &lt;ALT&gt; key to view</td>
</tr>
<tr>
<td></td>
<td>underlined characters indicating a shortcut. Then use &lt;ALT&gt; and the</td>
</tr>
<tr>
<td></td>
<td>underlined letter to access the screen or menu. For example, on the</td>
</tr>
<tr>
<td></td>
<td>menu bar use &lt;ALT&gt; + F to access &quot;File&quot; or &lt;ALT&gt; + U to access &quot;Utilities&quot;.</td>
</tr>
<tr>
<td>&lt;F1&gt;</td>
<td>Access context-sensitive help topics at any screen.</td>
</tr>
<tr>
<td>&lt;F2&gt; or right-click mouse</td>
<td>With your cursor in the appropriate box, use the &lt;F2&gt; key or right-click your mouse to access box specific data:</td>
</tr>
<tr>
<td></td>
<td>- Recipient TIN field: Access the Select a Recipient database.</td>
</tr>
<tr>
<td></td>
<td>- State/Payer’s State ID No.: Access the Select Filer State &amp; ID database (available at 1099-MISC box 17, 1099-R box 11 and W-2G box 13)</td>
</tr>
<tr>
<td></td>
<td>- Calendar: Access a multi-year calendar (available at 1099-A box 1, 1099-B box 1, 1099-C box 1, 1099-S box 1, W-2G box 4 and 1099-LTC).</td>
</tr>
<tr>
<td>Incremental Index (or Search)</td>
<td>Access any Recipient or Filer via the Search Name field.</td>
</tr>
<tr>
<td>Drop Menus</td>
<td>Right-click your mouse to view additional record options. This is</td>
</tr>
<tr>
<td></td>
<td>available at the Recipients List, Filers List and Work With My Tax Forms screens only.</td>
</tr>
</tbody>
</table>

Tag Records
All 1099 Pro software products include "tag" buttons to select individual records or ALL records. The "tag" buttons are available at various screens. An item is tagged or selected when a green check appears to the left of the item as illustrated below.
Tag Key Functions

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>&lt;ALT&gt; + T</td>
<td>Select individual records.</td>
</tr>
<tr>
<td>Tag All</td>
<td>&lt;ALT&gt; + A</td>
<td>Select ALL records.</td>
</tr>
<tr>
<td>Untag</td>
<td>&lt;ALT&gt; + U</td>
<td>Deselect individual records.</td>
</tr>
<tr>
<td>Untag All</td>
<td>---</td>
<td>Deselect ALL records.</td>
</tr>
<tr>
<td>Flip</td>
<td>&lt;ALT&gt; + F</td>
<td>Reverse the selection of individual records.</td>
</tr>
<tr>
<td>Flip All</td>
<td>&lt;ALT&gt; + L</td>
<td>Reverse the selection of ALL records.</td>
</tr>
<tr>
<td>Prev Tag</td>
<td>&lt;ALT&gt; + P</td>
<td>Scroll backwards through selected records.</td>
</tr>
<tr>
<td>Next Tag</td>
<td>&lt;ALT&gt; + N</td>
<td>Scroll forwards through selected records.</td>
</tr>
</tbody>
</table>

Software Installations

All 1099 Pro, Inc. software products are available in single, multi-user or unlimited-user licenses. The algorithm of your Authorization Code indicates the edition, user license and number of transactions purchased.

See Single-User Installations, Multi-User Installations and Multi-User Considerations.

Single-User Installation

Download any 1099 Pro, Inc. software product at http://host.1099pro.com. All software installations are two-step and require both the Full Install and the most recent Update.

Caution—AV Programs

Users are encourage to disable all anti-virus programs (e.g., Norton, McAfee, ViruScan, Sophos, etc.) prior to software download and installation to avoid potential corruption. Random software errors are typically due to the installation of software while running an AV program. After a successful installation, re-enable the virus checker.

Install Single-User (or Demo) via Internet Download

2. The executable file will auto-run after download.
3. Click "Next" to start the setup program.
4. Follow the instructions provided by the setup program. The Roll Forward Utility initiates if prior year data is located on your system.

Install Single-User (or Demo) via CD-ROM
1. Insert the CD-ROM into your computer's CD-ROM drive.
2. On your Windows desktop click the "Start" button and select "Run".
3. In the Open field, type \setup.exe, where x is the name of the CD-ROM drive and setup.exe is the name of the executable.
4. Click "OK" to start the setup program.
5. Follow the instructions provided by the setup program. The Roll Forward Utility initiates if prior year data is located on your system.

Multi-User Installation
For Multi-user installations, all 1099 Pro® software products require that one machine is designated as a Server and all others as Workstations. The Server may be any Windows® machine on the network or having a local or remote drive accessible by all computers that will function as Workstations. The Server installation must be performed prior to any Workstation installation.

Server Installation:
1. Determine the network computer, drive and folder in which to install your software. All Workstations must have full rights to this folder.
2. Install your software on the network computer to be designated as the Server. Enter your Multi-User Activation Code when prompted. Select Server Installation as the Install Type. Allow the program files to reside on the local or remote drive.
3. After successfully installing your software to the network, click on the 1099 / W-2 / 1042-S / 8966 Pro® icon on your desktop. The Getting Started Wizard will walk you through setting up the software. By default, Audit Trails are enabled and Security is disabled.*
4. After completing the Getting Started Wizard, re-launch your software.
5. Administrator Password—For their intial logon, Administrators should enable Security* and use "Administrator" for their User ID and the Password "NEW" (must be in all caps).
6. The Administrator should create Users and assign rights prior to installing 1099 / W-2 / 1042-S / 8966 Pro® on Workstations.

*Administrators are encouraged to enable Security. If Security is disabled, ANY USER on ANY WORKSTATION can access your software and View/Modify Administrator settings and all data. This includes the potential for ANYONE to create himself as Administrator and lock you out of the software.

Workstation Installation:
1. Open the Server installation and set security On or Off before proceeding.
2. Complete Server installation prior to installing Workstation(s).
3. Locate the Server installation drive and folder from the Workstation. To map the Server installation’s network drive from a Workstation, open Windows Explorer from each Workstation.
Locate the network drive, right click your mouse and select Map Network Drive. Each installation will refer to this drive as the Global Data Path.


5. Select Workstation Installation as the Install Type. Browse for the network drive and folder of the Server installation (e.g., X:\1099 Pro\Pro99TXX\ where “X” is the mapped Network Drive). Allow the program files to reside on the local drive (e.g., C:\1099 Pro\Pro99TXX).

6. If the Administrator enabled Security, then the Workstation is deemed a “user.”

7. **New User Password** — The first time a new User opens the software at their Workstation, they must enter their User ID (as assigned by the Administrator) and the Password ”NEW” (must be in all caps). The User is then required to create a unique password.

**INI Files**

All 1099 Pro software products use a local .INI file to store the data path of your remote data. If your software install was done under a different account with a drive letter mapping, then that same path will need to be mapped with the same drive letter. For example: If the Administrator of the computer has the remote drive as "L:" and the User has the mapped drive as "K:" then the user will be unable to access the data.

See [Multi-User Considerations](#) [13]

**Multi-User Considerations**

When running a multi-user version of any 1099 Pro software product, some tasks require exclusive control of certain files. These tasks are detailed below.

**Record Locking**

The multi-user version of this software utilizes record locking when two or more users concurrently open the same record. This allows users to simultaneously view the same record but prevents them from overriding each other's changes. For example, Users A and B open the same record. User A changes an amount and saves the record. User B then changes an amount and attempts to save the record. User B receives a "Record Was Not Updated" warning and the record is automatically updated with User A’s changes. User B may then select a field to restore and use the <F4> key to repopulate what they had originally entered.

**Import Locking**

During the final step of the Import Wizard—Post Import Session—the software attempts to gain control of all records. If the software is unable to gain control of a record (because someone else has the record open) it will notify the user and offer to post the files the slow, non-locking way or allow them to cancel.

**Unlock Records**

1. On the menu bar go File > Security and Administration.
2. In the "Business Rules and Options" section, click on "Browse System Process Locks".
3. Highlight User and click "Delete/Remove the Selected Lock".
Update Software

1099 Pro, Inc. regularly publishes software updates to keep up with the evolving rules and regulations of the IRS, SSA, and state agencies. To ensure your compliance, frequently check for software updates. By default, the software checks for updates occasionally during the summer, more frequently as tax season approaches and every day at the height of tax season. Users are strongly encouraged to take advantage of this process; an active Internet connection is required.

Users can verify they are running the most up-to-date version of our software:
- When starting any version of the software, a pop-up prompts to run a software update, OR
- Perform a Manual Update (as discussed below), OR
- Visit our WIKI download site at host.1099pro.com

Perform Updates

There are two methods to manually check for software updates.

Method 1
1. On the menu bar select Help > Check for Updates.
2. Use the "Check for Updates" button to run an update. Your computer must have an active Internet connection.

Method 2
1. Close the 1099 Pro software.
2. Use the Windows Start button to locate your 1099 Pro software product and select "Check for Updates" to initiate the Web Update Wizard.
3. Follow the prompts by clicking "Next". If there is a new version, a message displays the version number and provides a brief summary of items included in the update. Download the update and allow the update to install. This process should begin automatically.
4. After the process is finished, confirm that the new version number of the software corresponds with the version number of the update by opening your 1099 Pro software product and on the menu bar select Help > About.

Users experiencing issues downloading updates may have a firewall on their network or local machine preventing them from retrieving updates. Check with your Administrator, IT personnel or temporarily disable the firewall.

All updates are available for download at the 1099 Pro WIKI site host.1099pro.com.

Update Options

Users can modify the frequency and/or type of software updates performed. To edit these settings see .

Considerations:
- If an installation of this software has Security enabled, the User must have Administrator level access to modify the Checking for Updates options.
- For multi-user installations only the Server (not the Workstations) can view and modify the Checking for Updates option.
• Workstations cannot run the actual web update process -- they can only check for new versions. Once your Server has been updated, each workstation automatically updates itself the next time this software is run on that machine.

Data Files
All 1099 Pro software data files are suffixed with ".TPS" and are logically named. For example, "filers.tps" contains Filer data and "states.tps" contains state data. These files are located in the Data folder and in a typical installation can be found at C:\1099 Pro\ProXXX18\Data. See Backup Data.

INI File
The PrXXX18.INI file contains information specific to your installation such as data paths and version. For example:

NetPath=C:\1099 Pro\Pro99T18
LocalPath=C:\1099 Pro\Pro99T18
InstallVersion=2018.08.16
CurrentVersion=2018.16.05

INI File Folder Locations

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default INI File Location</th>
<th>File Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1099 Pro Professional</td>
<td>C:\1099 Pro\Pro99T18\Admin</td>
<td>Pro99T18.INI</td>
</tr>
<tr>
<td>1042-S Pro</td>
<td>C:\1099 Pro\Pr42ST18\Admin</td>
<td>Pr42ST18.INI</td>
</tr>
<tr>
<td>W-2 Pro</td>
<td>C:\1099 Pro\ProW2T18\Admin</td>
<td>ProW2T18.INI</td>
</tr>
<tr>
<td>8966 Pro</td>
<td>C:\1099 Pro\Pro66T18\Admin</td>
<td>Pro66T18.INI</td>
</tr>
<tr>
<td>Corporate Suite</td>
<td>Contact your in-house Administrator or assigned CS Account Manager for assistance.</td>
<td></td>
</tr>
</tbody>
</table>

The PrXXX18.INI file may or may not be deleted during a custom uninstall. This file can be manually deleted to totally remove software from your system or to perform a clean re-installation. This file can remain if a user wants to reinstall the software but retain their settings.

The ProNTS.INI File
Do not edit this file unless directed to do so by Tech Support.

Backup Data
All 1099 Pro software products include a Backup Wizard to copy all data files and compress them into a WinZip format. By default, the software prompts for a daily backup. It is smart to backup your data on a regular basis. If a problem occurs and data files need to be restored, a backup can save time, aggravation and expense! See Restore Data.

Did you know? IRS regulations require tax data to be maintained by Filers for five years.
Modify Backup
1. On the menu bar select File > Security and Administration.
   - Users with restricted Security settings may not have access to this area; such users should consult with their in-house software Administrator.

2. At the Global Administrative Options screen click the "Program Options" button and under Business Rules and Options click the "Preference, Update and Program Options" button.

3. At the Preferences screen, General tab, refer to the Backing Up Your Data Files subsection.
   - Change the frequency of the backup prompt; "0" or zero for every time the software is exited, "1" for once per day, "2" for every two days, etc.
   - Deselect the checkbox to disable backup prompts (not recommended).

Backup Data
Access the Backup Wizard as automatically prompted by your 1099 Pro software product (see Modify Backup above). The Backup Wizard application, Backup18.EXE, can also be accessed directly through File Explorer. Prior to running the backup all users must exit the software.

1. At the Backup Wizard screen click "Next" to proceed.

2. Select Backup Location and File Name and click "Next" to continue:
   - Accept the default location for the backup file or use the ellipses button to select another location such as a network drive or flash drive.
   - The program automatically includes the date and time of the backup file in the default name. Accept the default name (recommended!) or manually enter a name. The extension of your backup file defaults to .ZIP. Backup twice to the same file name and the existing backup file will be overwritten!

3. Review your backup choices and click "Back" to revise or "Proceed with Backup" to continue. This screen details Total [data] Files, Total Size and Estimated Zip Size.

4. The Administrator indicates if backup was successful.
   - Use WinZip (a shareware utility) to access your backup data. Download it at www.winzip.com.

Data Backup Folder Locations

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default Data Backup Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1099 Pro Professional/Enterprise:</td>
<td>C:\1099 Pro\Pro99T18\Data Backups</td>
</tr>
<tr>
<td>1042-S Pro</td>
<td>C:\1099 Pro\Pr42ST18\Data Backups</td>
</tr>
<tr>
<td>W-2 Pro</td>
<td>C:\1099 Pro\ProW2T18\Data Backups</td>
</tr>
<tr>
<td>8966 Pro</td>
<td>C:\1099 Pro\Pro66T18\Data Backups</td>
</tr>
<tr>
<td>Corporate Suite</td>
<td>Contact your in-house Administrator or assigned CS Account Manager for assistance.</td>
</tr>
</tbody>
</table>

Corporation Suite
### Restore Data

Users are strongly encouraged to backup data on a regular basis. If data is damaged or destroyed a backup file can quickly restore data. Restoring a data file means losing ALL changes made since the last backup. See [Backup Wizard](#).

**No backup file?** If you used the Service Bureau to process your forms, we may be able to recover a limited version of your data files for a fee. Contact the Service Bureau for more information.

1. **Restore Data**
   - Re-install the software to its BASE version (run the Full Install only). Software downloads are available on the [1099 Pro Wiki](#). Download the appropriate Tax Year and Version. Contact Technical Support with questions.
   - Locate your .ZIP backup file (e.g., "1099 Pro Backup 9-AUG-2018 9-38AM.ZIP") in your Data Backups folder.
   - Double-click the .ZIP file to open the WinZip utility and then extract the contents of this backup file — .TPS (data) files — to your Data folder. Learn more about [WinZip](#).
   - Open your software and run a [Form Counts by Filer](#) report to verify accuracy of restored data.
   - After successfully restoring your data, update your software to its most recent version.

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default Data Backup Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1099 Pro Professional/Enterprise:</td>
<td>C:\1099 Pro\Pro99T18\Data Backups</td>
</tr>
<tr>
<td>1042-S Pro</td>
<td>C:\1099 Pro\Pr42ST18\Data Backups</td>
</tr>
<tr>
<td>W-2 Pro</td>
<td>C:\1099 Pro\ProW2T18\Data Backups</td>
</tr>
<tr>
<td>8966 Pro</td>
<td>C:\1099 Pro\Pro66T18\Data Backups</td>
</tr>
</tbody>
</table>
| Corporate Suite        | Contact your in-house Administrator or assigned CS Account Manager for assistance.

### Roll Forward Data

All 1099 Pro software products allow users to roll forward 2017 Filer and/or Recipient information (including names, TINs and addresses), Transmitter and Security settings and customized Import Maps. Rolled forward Recipient data is available at the [Recipient Master List](#) screen for viewing or changes; Filer data is likewise available at the [Filer Master List](#) screen.

**NOTE:** The roll forward utility does not copy 2017 tax form specific information such as dollar amounts into the new 2018 installation. For example, a 2017 tax form can only be accessed in the 2017 version of our software. The exception is Corporate Suite—a multi-year software product.
Select Filers/Recipients AFTER Roll Forward

- Select Filers: Use the "Select Another Filer" button, located at the top of the task panel, to switch between Filers.
- Select Recipients: At any tax form data entry screen, users can place their cursor in the Recipient TIN field and right-click their mouse or use the <F2> key to select a Recipient and auto-populate the tax form with the Recipient’s name, TIN and address.

How To Roll Forward Data

Users can roll forward their prior year data during the Installation Wizard or from the Windows Start Menu >1099 Pro/1042-S Pro/W-2 Pro/8966 Pro> Roll 2017 Data to 2018 Software. The roll forward utility is unavailable if any Filer and/or Recipient data has already been added into the 2018 software; perform the roll forward PRIOR to entering or importing any data into the software. To perform a roll forward AFTER adding data, users must uninstall the 2018 software and then perform a fresh installation.

Roll Forward data option available through initial Installation Wizard.

See File Not Found: Information Request Error

Ch. 3 Deadlines

Form 8966 Deadlines

Form 8966 is required to be filed for the 2018 calendar year on or before March 31, 2019. A Reporting Model 2 FFI must file Form 8966 on the same filing dates that apply to a PFFI, unless a different reporting date is specified in an applicable Model 2 IGA.
Electronic Filing Requirement
An entity that is a financial institution is required to file Form 8966 electronically, irrespective of the number of Forms 8966 filed. All other entities that file 250 or more Forms 8966 for the calendar year are required to electronically file Form 8966.

Extensions To File
An automatic 90-day extension of time to file Form 8966 may be requested. To request an automatic 90-day extension of time to file Forms 8966, file Form 8809-I, Application for Extension of Time to File FATCA Form 8966. You should request an extension as soon as you are aware that an extension is necessary, but no later than the due date for filing Forms 8966. No extension of time to file is permitted for Forms 8966 filed by a Reporting Model 2 FFI to report a non-consenting U.S. account or a non-consenting nonparticipating FFI. A Reporting Model 2 FFI should refer to the applicable Model 2 IGA for the due dates for those filings.

See the Instructions for Form 8966.

Penalties
Penalties Increased Effective 2018
The following penalties generally apply to the person or entity required to file information returns. The penalties apply to both paper and electronic filers. Reference the IRS's 2018 General Instructions for Certain Information Returns, page 18.

Failure To File Correct Information Returns by the Due Date (Section 6721)
If you fail to file a correct information return by the due date and you cannot show reasonable cause, you may be subject to a penalty. The penalty applies if you fail to file timely, you fail to include all information required to be shown on a return, or you include incorrect information on a return. The penalty also applies if you file on paper when you were required to file electronically, you report an incorrect TIN or fail to report a TIN, or you fail to file paper forms that are machine readable. The amount of the penalty is based on when you file the correct information return. The penalty is as follows.

- **$50** per information return if you correctly file within 30 days (by March 30 if the due date is February 28); maximum penalty $547,000 per year ($191,000 for small businesses).
- **$100** per information return if you correctly file more than 30 days after the due date but by August 1; maximum penalty $1,641,000 per year ($547,000 for small businesses).
- **$270** per information return if you file after August 1 or you do not file required information returns; maximum penalty $3,282,500 per year ($1,094,000 for small businesses).

If you do not file corrections and you do not meet any of the exceptions to the penalty described later, the penalty is $270 per information return. Please see the IRS Help for Taxpayers site for information and advice on late filings and penalties.

Intentional disregard of filing requirements. If any failure to file a correct information return is due to intentional disregard of the filing or correct information requirements, the penalty is at least $540 per information return with no maximum penalty.
Form 8966 Specific Requirements
An entity that is a financial institution is required to file Form 8966 electronically, irrespective of the number of Forms 8966 filed. All other entities that file 250 or more Forms 8966 for the calendar year are required to electronically file Form 8966.

If you are required to file electronically but fail to do so, and you do not have an approved waiver on record, penalties under sections 6721 through 6724 may apply.

For up to date information regarding FATCA related penalties please visit: irs.gov/fatca

Ch. 4 Menu Bar Items

File
Filers
Browse Filers

Did you know? "Filer" refers to the business, individual or entity issuing a form to a Recipient. The terms Filer and Employer are sometimes used interchangeably, depending on the type of tax form being issued. Use the Filer Master List screen to add, change, delete and view Filers. Use the Select Filer button to quickly jump between existing Filers.

Filer Overview
Access the Filer (Withholding Agent) Master List screen via the menu bar > Filers List. This screen displays ALL Filers OR sort them by default options or create a custom query.

- Unlimited Filers are allowed.
- All 1099 Pro software products accept multiple Filers with one TIN. This is useful for companies issuing forms from multiple departments or for batch processors. See Create a Duplicate Filer
- All 1099 Pro software products allow US, Canadian and foreign Filers.
- Filer Record Details provides a thorough explanation on each Filer specific field.

Viewing Options

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Users can sort Filers by Filer Name, TIN or PCode.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all Filers are displayed. Users can display a subset of Filers via the &quot;Current Query&quot; drop menu and select a readymade query, e.g., &quot;Combined Fed/State Filing&quot; or &quot;TIN is an EIN&quot; or create their own custom query, e.g. &quot;Address Type Code = Other Foreign&quot;, etc.</td>
</tr>
</tbody>
</table>

Onscreen Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Add&quot;</td>
<td>Use to manually add individual Filers. Unlimited Filers are allowed. See Add a Filer</td>
</tr>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit a Filer. Cascading updates are applied to all existing records in the software with a &quot;Pending&quot; status; records with</td>
</tr>
<tr>
<td><strong>Button</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>any other status are locked and will not reflect Filer updates. See Change a Filer and Cascading Updates</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Use to delete any Filer with no associated Recipient records; if any Recipient records are associated with the Filer (including deleted records) the Filer is locked and cannot be deleted. See Delete a Filer</td>
</tr>
<tr>
<td>&quot;Run Filer Report&quot;</td>
<td>This report provides detailed information on a selected Filer including Name, TIN, Contact Information, State ID Numbers and a history of any address changes. See Filer Listing Report</td>
</tr>
</tbody>
</table>

**Sponsored Entity/Intermediary**

8966 Pro users can review or add Sponsored Entity or Intermediary List information on the task panel > Reporting FI > Intermediary/Sponsored Entity. Please review the IRS 2018 Instructions for Form 8966 for specific definitions of Intermediaries and Sponsored Entities.

**Modify Indicators on Existing Data**

Users can edit Sponsored Entity / Intermediary information on existing Forms 8966. First add the Sponsored Entity or Intermediary as outlined above. Then at the Work With My Tax Forms screen open the appropriate record and use the "Spon ENT Type" drop menu to select "No Spon ENT Type", "Intermediary" or "Sponsored Entity". Tab to the TIN field and right-click your mouse to display available Sponsored Entities or Intermediaries to auto-populate the form.

Another option is to re-import your data by creating a new map with the "Spon ENT Type" field added to your data file as outlined below.

**Import File Conventions**

Mark the "Spon ENT Type" column in the 8966 sample import file as follows:

- 1 / I / i = Intermediary
- 2 / S / s = Sponsored Entity
- S / s = Sponsored Entity

**Add a Filer**

All 1099 Pro software products allow unlimited Filers. Please watch our online How to Add a Filer video tutorial.

See Import Filers, Create a Duplicate Filer and Filer Record Details for a thorough explanation on all entry fields.

**Add a Filer**

1. On the menu bar select File > Filers List .
2. At the Filer Master List screen click "Add".
3. At the Adding a Filer Record screen complete all fields and click "OK" to save the Filer.

**Create a NIL Filer**

8966 Pro only allows a NIL Filer to create a NIL Report.
1. On the task panel select > Reporting F1 > My Filers List.
2. At the Filer Master List screen add a new Filer or edit an existing Filer.
   - The "Filer Is Used ONLY for NIL Reporting" box must be checked. This box is not available if editing a Filer with existing data.
   - A Payer Code (PCode) is required, but the Filer/Agent EIN is not.
3. Click "Save".

Contact Information

At the Filer Record screen add or edit a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records (change contacts at the Adding a Form Record screen via the "Dept" button). At least one contact is required. The contact phone number prints on ALL copies and the 1096/W-3/1042-T Transmittals; the contact name prints only on the Transmittals. The exception is 8966 Pro wherein the Contact Phone Number does NOT print on the Form 8966.

Add/Edit Contacts

1. On the menu bar select File > Filers List.
2. At the Filer Master List screen highlight a Filer and click the "Change" button.
3. At the Filer Record screen (General tab) use the "Add", "Change" or "Delete" buttons as appropriate.
   - Dept. Code—The Filer's internal reference such as AP, Sales, HR, LA Office, NY Office, etc.
   - Full Dept. Name—For example, "Accounts Payable".
   - Default—Only one contact can be selected as default.
4. Use the "Save" button to save changes or "Cancel" to abort changes and exit.

Duplicate Filers

Users can duplicate a Filer to isolate data by Department, Date, User, etc. Some sers may need to isolate revised data as directed by 1099 Pro Technical Support. Use the Payer Code (PCode) field to differentiate—and thus isolate—otherwise identical Filer data. Payer Codes (PCodes) are internal reference values, visible in the software only. See Filer Record Details.

Create a Duplicate Filer

1. On the menu bar select File > Filers List.
2. At the Filer Master List screen click "Add".
3. At the Adding a Filer Record screen complete all fields identically to the original Filer.
4. In the Payer Code (PCode) field enter "REVISED", "CORRECTIONS" or any appropriate phrase.
5. Click "OK" to save the Filer.

When importing, printing or uploading data the user always has the ability to view and select Filers by Payer Code (see Image).
Change a Filer
Changes to a Filer only affect records with a "Pending" status. To quickly switch between existing Filers use the "Select Another Filer" button.

Change a Filer
1. On the menu bar select File > Filers List.
2. At the Filers Master List screen select the Filer and click "Change".
3. At the Changing a Filer Record screen make changes and click "OK".
   - Modify TIN Masking settings at the Extra Options tab. By default, this feature is enabled for all Filers.
4. The Administrator prompts to update all pending records with the new Filer information. Click "Yes" to apply the updates or "Cancel" to abort changes and exit the screen.

Review [Filer Record Details](#) for a thorough explanation of each Filer field.

Delete a Filer
If a Filer is associated with any records—including deleted or voided records—it cannot be deleted.

Delete a Filer
1. On the menu bar select File > Filers List.
2. At the Filers Master List screen select the Filer and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the Filer or "No" to cancel.

Filer Record Details
Visit the [1099 Pro WIKI](#) to download software specific Filer Import Maps and review additional import field specifications.

Access the Filer Record Details on the menu bar > File > Filers List > highlight Filer and select the "Add" or "Change" buttons.

Fields in RED are required.
General Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filer TIN</strong></td>
<td>The Filer Taxpayer Identification Number field is required. If the Filer does not have a TIN but has applied for one, enter &quot;Applied For&quot; in this field.</td>
<td>11</td>
</tr>
<tr>
<td></td>
<td>• Filers can use an EIN or SSN to issue most forms.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Filers with an &quot;Applied For&quot; status can issue forms but cannot generate an electronic file or 1096 Transmittal until their TIN is entered.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The Filer TIN prints on all copies of Recipient records; it cannot be masked.</td>
<td></td>
</tr>
<tr>
<td><strong>Location Code</strong></td>
<td>• Use the Location Code to create multiple Filers sharing one TIN — allows different return addresses for different form types. Also used by batch processors grouping by month. Location Codes are alpha-numeric and appear in Filer specific reports; they do not print on any tax forms.</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>• If applicable, enter an SSA assigned Establishment Number in this field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• This field flows through to the B record positions 41-44 as the &quot;Payer’s Office Code&quot; (applies to electronic filers only). Per the IRS, the Location Code must also appear on backup withholding notices.</td>
<td></td>
</tr>
<tr>
<td><strong>Payer Code</strong></td>
<td>Use the Payer Code (PCode) to setup multiple Filers with the same TIN. For example, uses PCodes of &quot;Sales&quot;, &quot;Tech&quot;, &quot;Exec&quot; to differentiate subsets of Recipient records for a Filer. PCodes must be unique, if an already in use PCode is entered, the software prompts to create a new one.</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>• PCodes are alpha-numeric and visible in the software only.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Typically, security and the return address settings are unique for each PCode.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• See <a href="#">Duplicate Filers</a>                                                                -----------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td><strong>Filer Name</strong></td>
<td>Prints on all tax forms.</td>
<td>40</td>
</tr>
<tr>
<td>Filer Name 2</td>
<td>Prints on all tax forms.</td>
<td>40</td>
</tr>
<tr>
<td>Filer Name 3 &amp; 4</td>
<td>In Corporate Suite only, prints on Recipient copies only.</td>
<td></td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>Defaults to USA. Select Canada or Other to reformat the address fields.</td>
<td>25</td>
</tr>
<tr>
<td><strong>Address Line 1</strong></td>
<td>Prints on all tax forms.</td>
<td>40</td>
</tr>
<tr>
<td><strong>Address Line 2</strong></td>
<td>Prints on all tax forms.</td>
<td>40</td>
</tr>
<tr>
<td><strong>City</strong></td>
<td>Prints on all tax forms.</td>
<td>40</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Max Characters</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>State / Province / Locale</td>
<td>Prints on all tax forms.</td>
<td>23</td>
</tr>
<tr>
<td>ZIP / Postal</td>
<td>Prints on all tax forms.</td>
<td>15</td>
</tr>
</tbody>
</table>
| **Contact Information**       | Use the "Add" button to add a Contact Person, Department and Phone Number. Adding multiple contacts allows users to change the contact information on different records (change contacts at the Adding a Form Record screen via the "Dept" button). At least one contact is required.  
  • Dept. Code: For example, "HR".  
  • Full Dept. Name: For example, "Human Resources"  
  • Contact Name: The individual to contact with questions regarding the issued forms. The contact name prints on the IRS/SSA paper transmittal only; it does NOT print on Recipient copies.  
  • Phone: The phone number to call for questions regarding the issued forms. The phone number prints on all copies and IRS/SSA paper transmittals. Note: The exception is 8966 Pro wherein the Contact Phone Number does NOT print on the Form 8966. | 40             |
| Fax                           | A fax number is optional.                                                                                                                                                                                    |                |
| Email                         | An email address is optional.                                                                                                                                                                                 |                |
| Notes / Has Notes             | Enter notes specific to a Filer/Pcode for reference purposes. Indicates if notes are present for this Filer.                                                                                                 |                |

**State I.D. Number Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Select the appropriate State Abbreviation via the &quot;Add&quot; button.</td>
<td>2</td>
</tr>
<tr>
<td>State Name</td>
<td>The State name auto-fills after selecting the State Abbreviation.</td>
<td></td>
</tr>
<tr>
<td>State ID Number</td>
<td>State ID Numbers are assigned by the individual state. For example, in California the Employer Development Department (EDD) assigns a state ID number. Users should check with their accountant or attorney to determine if their company has a state ID number. Not all Filers have a State ID Number. Multiple State ID numbers are allowed. See State ID Number.</td>
<td>15</td>
</tr>
</tbody>
</table>

**Corporate Suite Only**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>W/H %</td>
<td>Withholding Percentage</td>
<td></td>
</tr>
<tr>
<td>Unemployment ID</td>
<td>SUTA ID and Experience Rating for this Filer (W-2 Only)</td>
<td></td>
</tr>
</tbody>
</table>
**Field** | **Description** | **Max Characters**
--- | --- | ---
SUTA Percentage | State Unemployment Tax Act (SUTA) percentage sets a limit to the taxable wage base and varies by state (W-2 Only) |  
Wage Plan Code | Wage plan codes are used by the Employment Development Department (EDD) (W-2 Only) |  

### Prior Address Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>This tab displays only if a Filer's address has been modified. Prior Filer address information is preserved here for reference purposes and cannot be changed or deleted.</td>
<td>n/a</td>
</tr>
</tbody>
</table>

**GIIN Composition**

GIIN is a Global Intermediary Identification Number assigned to a PFFI or Registered Deemed Compliant FFI. A separate GIIN will be issued to the FI to identify each jurisdiction, including the FI’s jurisdiction of residence, in which the FI maintains a branch that is not treated as a Limited Branch. It is anticipated that the IRS FFI list will be updated on a monthly basis to add or remove FIs (or their branches). The GIIN may be used by an FI to identify itself to withholding agents and tax administrations for FATCA reporting. A GIIN will be issued to only those FIs that are not Limited FFIs, Limited Branches, or U.S. branches of an FFI, and will be issued after an FI’s FATCA Registration is submitted and approved. See [Select a GIIN](#)  

The GIIN is a 19-character identification number that is a composite of several other identifiers. These identifiers include the following:

- Each registering FI will be given a FATCA ID that will be used for purposes of establishing and accessing the FI’s online FATCA account. For all FIs other than Member FIs, the FATCA ID is a randomly generated six character alphanumeric string. These 6 characters are upper case letters excluding the letter O, or numbers, or a combination of both. For Member FIs, the FATCA ID will be comprised of 12 characters: the first 6 characters will be the Lead FI’s FATCA ID, followed by a period, and the last 5 characters will be alphanumeric and assigned sequentially to each Member. The FATCA ID is not the same as the GIIN. See [FATCA Identification Numbers](#)  

The Financial Institution Type can be Single, Lead of an Expanded Affiliated Group, Member (not Lead) of an Expanded Affiliated Group, or Sponsoring Entity. The Financial Institution type is provided by the Financial Institution when creating its FATCA account.

The Category Code is a two-character abbreviation identifying either the Financial Institution Type as previously described or a branch of the Financial Institution.

The Country Identifier will be the ISO 3166-1 numeric standard country code for the Financial Institution’s country of residence for tax purposes that the Financial Institution identified in question

---

Copyright 1099 Pro® 2018
3 on the registration form, or, if the GIIN is for a branch, the branch country identified in question 9A on the registration form.

Global Intermediary Identification Number (GIIN) Composition Format: XXXXXXX.XXXXX.xx.xxx

<table>
<thead>
<tr>
<th>Character Representation</th>
<th>Characters</th>
<th>Position</th>
<th>Description / Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>FATCA ID (first six characters)</td>
<td>6</td>
<td>1-6</td>
<td>Alphanumeric upper case only. For all Financial Institutions, this is the same as the first 6 characters of the FATCA ID. For leads and singles, this is your FATCA ID, for members; this is just the first six characters. Note: The first six characters of any Financial Institution’s FATCA ID are randomly generated and will never use the letter “O”.</td>
</tr>
<tr>
<td>Separator 1</td>
<td>1</td>
<td>7</td>
<td>Period = .</td>
</tr>
<tr>
<td>Financial Institution Type</td>
<td>5</td>
<td>8-12</td>
<td>Alphanumeric upper case only. Lead = 00000 Sponsoring Entity = 00000 Single = 99999 Member = Same as the last 5 characters of the Member’s FATCA ID (sequential, starting from 00001 and going to 99998, then A0000 – ZZZZZ; will never use the letter “O”)</td>
</tr>
<tr>
<td>Separator 2</td>
<td>1</td>
<td>13</td>
<td>Period = .</td>
</tr>
<tr>
<td>Category Code</td>
<td>2</td>
<td>14-15</td>
<td>Alpha upper case only. Based on Financial Institution or Branch category LE = Lead SL = Single ME = Member BR = Branch (the first thirteen characters of a branch’s GIIN will match the first thirteen characters of the GIIN of the Financial Institution with which the branch is associated) SP = Sponsoring Entity</td>
</tr>
<tr>
<td>Separator 3</td>
<td>1</td>
<td>16</td>
<td>Period = .</td>
</tr>
<tr>
<td>Country Identifier</td>
<td>3</td>
<td>17-19</td>
<td>Numeric ISO 3166-1 numeric standard country code of the Financial Institution or branch Note: Use 999 for country code “Other”.</td>
</tr>
</tbody>
</table>

Select GIIN

The Global Intermediary Identification Number or GIIN is a 19-character identification number formatted as XXXXXXX.XXXXX.xx.xxx Learn more about GIIN Composition.
Browse GIIN File
Access the Select the GIIN screen at any GIIN data entry field. Use the <F2> key or right-click the mouse to access a current IRS GIIN database.

Update GIINs
8966 Pro's GIIN database is updated regularly with IRS approved data per software updates. Users are strongly recommended to run all updates.

Manually Add GIIN
Users can manually add a GIIN at any GIIN data entry field but must follow the exact GIIN Composition rules. The Administrator responds with a Warning and the User must decide to keep the GIIN or make a different GIIN selection from the IRS approved list.

Administrator
WARNING: The GIIN you have entered is NOT on the current IRS GIIN list. If you are absolutely certain this GIIN is valid, click on "Keep this GIIN" to stop the list from re-appearing before the record is saved.

[Select from List] [Keep this GIIN]

Import GIINs
Users can include GIINs in their import files but must follow the exact GIIN Composition rules. The 8966 Pro sample import file includes a "SPON ENT GIIN" field to automap this data. Imported GIINs that do NOT validate against the IRS GIIN approved list will trigger an Error in the software; Users can decide to continue and ignore the error or cancel the import.

FATCA Identification Number
1099 Pro, Inc. does not provide legal or accounting advice. Please check with your legal or accounting resources and/or the appropriate government entities. 8966 Pro software requires a Filer to have either a GIIN or FIN; it is an important identifier in the XML schema. See GIIN Composition and Filer Record Details

F1. How do I submit the FATCA XML Schema if I am a U.S. Withholding Agent (USWA), Territory Financial Institution (TFI), third party preparer, or other entity that is not required to have a GIIN?

Certain entities, such as USWAs, TFIs, or other third party preparers (not sponsoring entities) submitting information on behalf of another entity, are not required to register or to obtain a GIIN and, therefore, should not do so. USWAs, TFIs, and other entities that are not required to have a GIIN (“non-GIIN filers”) must follow the procedure, below, in order to obtain a FATCA ID number (FIN) that they will use in lieu of a GIIN to enroll in and use IDES (including submitting an Intergovernmental FATCA XML schema v1.1 (electronic Form 8966).
The FIN, along with the associated identifying information that you provide, will be treated as
return information by the IRS. This FIN and the associated information provided will be used by
the IRS to validate the non-GIIN filer’s IDES enrollment and submission of files via IDES and for
other FATCA purposes. The FIN, but not the associated information (such as your name), will be
published on the Foreign Financial Institution (FFI) List to facilitate the IDES enrollment and your
submission of files via IDES. For more information about the FFI List, see IRS FFI List FAQs.

Your published FIN will be accompanied by a generic name (e.g., “U.S. Withholding Agent 1”) on
the FFI List, and publication of your FIN on the FFI List does not change your status for FATCA
purposes. That is, having your FIN published on the FFI List does not make you an FFI, and the
FIN does not serve any function related to withholding tax on payments under FATCA. Note: In
order to request a FIN, you must consent to the IRS’s publication of the FIN on the FFI List because
the FIN is return information. Visit the IDES Resources page for more information.

F3. How do I complete the FATCA XML Schema if I am a third party preparer or other
entity that is not required to have a GIIN?

If you are a third party preparer (not a sponsoring entity) or commercial software vendor and you
are submitting the FATCA XML Schema on behalf of another entity (or on behalf of several other
entities), enter your FIN, which you obtained to enroll and use IDES, in (1) “SendingCompanyIN”
data element in the FATCA XML Schema Message Header and (2) "FATCAEntitySenderID" data
element in the FATCA XML Metadata Schema. Note: For additional information, please read FAQ
Q2 under the “Reporting” section on the General FAQ page.

IRS References:

Recipients

Browse Recipients

Did you know? "Recipient" refers to the individual or entity receiving a form issued by a Filer. The
terms Recipient and Employee are sometimes used interchangeably, depending on the type of tax
form being issued.

Use the Recipient Master List screen to add, change, delete and view Recipients. To access Recipients
at any data entry form, place your cursor in the Recipient ID Number field and use the <F2> key or
right-click your mouse.

Recipients Overview

Access the Recipient Master List screen via the menu bar > Recipients List. This screen displays ALL
Recipients OR sort them by default options or create a custom query.
- Unlimited Recipients are allowed; however, a maximum of 5,000 transactions (or records) are allowed in a standard software installation. Additional transactions can be purchased via Bump Codes.
- All 1099 Pro software products allow US, Canadian and foreign Recipients.
- Recipient Record Details provides a thorough explanation on each Recipient specific field.
- Multiple Recipients—One TIN, although rare, are allowed.
- Select a Recipient record at any tax form.
- Deleted Recipient tax forms can be made visible at the Work With My Tax Forms screens.

### Viewing Options

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Sort Recipients by Name or TIN.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all Recipients are displayed. Users can display a subset of Recipients via the &quot;Current Query&quot; drop menu and select a prebuilt query, e.g., &quot;TIN is an SSN&quot;, &quot;TIN is an EIN&quot; or create their own custom query, e.g. &quot;Address Type Code = Other Foreign&quot;, etc.</td>
</tr>
</tbody>
</table>

### Onscreen Buttons

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Add&quot;</td>
<td>Use to manually add individual Recipients—most users prefer to import records. Unlimited Recipients are allowed, however a maximum of 5,000 transactions (or records) are included in a standard software installation. See Add a Recipient.</td>
</tr>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit a Recipient. Cascading updates are applied to all existing records for that Recipient with a &quot;Pending&quot; status; records with any other status are locked and will not reflect Recipient updates. See Change a Recipient and Cascading Updates.</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Use to delete any Recipient with no associated records; if any records are associated with the Recipient (including deleted or voided records) the Recipient is locked and cannot be deleted. See Delete a Recipient.</td>
</tr>
<tr>
<td>&quot;Run Recipient Report&quot;</td>
<td>The Recipient Listing includes the Name, TIN, and Address of all Recipients in the database. For more detailed Recipient information, including Account Numbers and status of any forms, run the Control Totals report. See Recipient List Report.</td>
</tr>
<tr>
<td>&quot;Run Forms Issued Report&quot;</td>
<td>The Forms Issued for Recipient report details all forms issued to each Recipient including the Form Type, Form Status, Filer TIN, Account Number and Date Created.</td>
</tr>
<tr>
<td>&quot;Delete All With No Forms&quot;</td>
<td>All Recipients without any associated forms are permanently deleted. Recipients cannot be deleted if they are associated with any DELETED or VOID records.</td>
</tr>
<tr>
<td>&quot;Issue W-9/B Notice&quot;</td>
<td>This button initiates the wizard to generate a W-9 for the selected Recipient. This allows the user to issue forms individually without creating a batch. This</td>
</tr>
</tbody>
</table>
**Button** | **Function**
---|---
 feature is not available in 1042-S Pro and 8966 Pro.
"Lookup" | Use the Recipient Lookup feature to run a program wide search for a Recipient and view a list of associated form types with detailed information including form(s) status / error status, Filer TIN, Payer Code and Filer Name. This is a quick and powerful tool for locating a single Recipient for those users with a large volume of records and multiple Filers. This utility is not available in 1042-S Pro, W-2 Pro and 8966 Pro.

### Multiple Recipients—One TIN

Although rare, a Filer may need to issue multiple forms to the same Recipient or issue forms to two individuals sharing one SSN or EIN. For example, "Jane Doe DBA Jane's Courier Service" and "Jane Doe" both use an SSN of 123-45-6789. However, Jane Doe DBA and Jane Doe have different addresses.

#### Enter Multiple Recipients—One TIN
1. Enter Jane Doe as normal at any Adding a New Record screen. This is the "master" Recipient record for Jane Doe. Click "Save" to save Jane Doe's record.
2. At the next Adding a New Record screen, enter the shared TIN in the Recipient TIN field. Jane Doe's name and address auto-populate the screen.
3. Use `<SHIFT> + <TAB>` to move backwards through the fields and overwrite the name and/or address fields with Jane Doe DBA's information. Click "Save" to save changes.
4. The Administrator indicates a possible Recipient information mismatch. Click "No" to not update Jane Doe DBA with the "master" record. Also deselect the "Update All Other Pending Forms" box.

*Note: At the Recipient Master List screen only the "master" record, Jane Doe, is listed. However, the Recipient record lists the DBA under the Accounts/Name 2 tab.*

### Recipient Record Details

Visit the [1099 Pro WIKI](#) to download software specific Recipient Import Maps (Corporate Suite Only) and review additional import field specifications. Please see IRS Pub. 1586, Chapter 9, [IRS Matching Process and Name Controls](#) (online) for guidance on creating Recipient records for Individuals, Sole Proprietors, Corporations, etc.

Access the Recipient Record Details on the menu bar > File > Recipients List > highlight a Recipient and select the "Add" or "Change" buttons.

*Fields in RED are required.*

### Name/Address Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Taxpayer ID (SSN/EIN)</td>
<td>The placement of the hyphen (dash) in the TIN field is critical. The entry of an SSN or EIN determines the formatting of the Name</td>
<td>11</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Max. Characters</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
<td><strong>Max. Characters</strong></td>
</tr>
<tr>
<td>First Name (optional)</td>
<td>If TIN is an SSN, enter the Recipient's First Name. Do NOT enter both the Recipient's First + Last Names in this field.</td>
<td>40</td>
</tr>
</tbody>
</table>
| **Company or Last Name**     | • If TIN is an EIN, enter the Company Name.  
• If TIN is an SSN, enter the Recipient's Last Name. It is acceptable to enter both the Recipient's First + Last Names in this field.     | 40              |
| Note: The formatting of this field is determined by the TIN type (SSN vs EIN) entered in the Taxpayer ID field.                                                                                               |                 |
| Name Line 2 (optional)       | If TIN is an SSN and Recipient is a Sole Proprietor, enter their DBA in this field.                                                                                                                       | 40              |
| Name Line 3                  | Corporate Suite only field.                                                                                                                                                                                 | 40              |
| Name Line 4                  | Corporate Suite only field.                                                                                                                                                                                 | 40              |
| USA Residency Status         | Corporate Suite only field.                                                                                                                                                                                 | 40              |
| Address Type                 | Defaults to USA. Select Canada or Other to reformat the address fields.                                                                                                                                  | 1               |
| Street Address               | Prints on all tax forms.                                                                                                                                                                                    | 40              |
| Apt./Ste. Address            | Prints on all tax forms. Per USPS regulations, the Apt./Ste. Address field prints ABOVE the Street Address field.                                                                                          | 40              |
| City                         | Prints on all tax forms.                                                                                                                                                                                    | 40              |
| State / Province / Locale    | Prints on all tax forms.                                                                                                                                                                                    | 23              |
| ZIP / Postal                 | Prints on all tax forms.                                                                                                                                                                                    | 15              |
| Country                      | Country, if Address Type = O (Other)                                                                                                                                                                         | 25              |
| Verification Required        | Check this box if the Recipient's TIN, Name or Address needs to be verified.                                                                                                                                | 1               |
| **Notes / Has Notes**        | Enter notes specific to a Recipient for reference purposes. Indicates if notes are present for this Recipient.                                                                                               | 512             |
### Pending* Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outstanding Information Request (IR)</td>
<td>Lists the type of IR and date issued.</td>
<td>--</td>
</tr>
<tr>
<td>Original Information Printed on W-9</td>
<td>Displays the original information provided on issued IR. Use the Printer icon to reprint a copy of the originally issued Information Request.</td>
<td>--</td>
</tr>
<tr>
<td>Current (Corrected) Information</td>
<td>Enter the corrected Name and TIN information.</td>
<td>--</td>
</tr>
<tr>
<td>Update Status</td>
<td>Update the status of the IR. Once an Information Request is closed it is no longer available for edits.</td>
<td>--</td>
</tr>
</tbody>
</table>

*Pending Tab displays only if there is an Open/Pending Information Request for this Recipient.

### Contact/Info Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address</td>
<td>This optional field is useful for emailing encrypted tax forms to Recipients upon request</td>
<td>11</td>
</tr>
<tr>
<td>Phone Number 1</td>
<td>Optional.</td>
<td>--</td>
</tr>
<tr>
<td>Phone Number 2</td>
<td>Optional.</td>
<td>--</td>
</tr>
<tr>
<td>Extra Information</td>
<td>These fields are optional and are for software specific, internal use only.</td>
<td>40</td>
</tr>
</tbody>
</table>

### Issued Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Form Type / Account Number</td>
<td>The issued form type and associated Recipient account number.</td>
<td>n/a</td>
</tr>
<tr>
<td>Form Status / Error Status</td>
<td>The issued record's status at the Work With My Tax Forms screen and any Errors.</td>
<td>n/a</td>
</tr>
<tr>
<td>Filer TIN / Filer Name</td>
<td>The issuing Filer and Filer's TIN.</td>
<td>n/a</td>
</tr>
</tbody>
</table>

### W-9/B Notices Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requestor (Filer)</td>
<td>The Filer issuing the Informational Request</td>
<td>n/a</td>
</tr>
<tr>
<td>Request Type</td>
<td>The type of request, W-9, B Notice, etc.</td>
<td>n/a</td>
</tr>
</tbody>
</table>
Accounts Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Numbers</td>
<td>Multiple account numbers can be associated with a Recipient.</td>
<td>20</td>
</tr>
</tbody>
</table>

Add Recipients

All 1099 Pro software products allow unlimited Recipients. In a standard software installation up to 5,000 Recipient transactions (tax records) are allowed; bump codes can be purchased at any time.

*Note: All 1099 Pro software products allow users to manually add individual Recipient records. Most users prefer to import data—including tax form and Recipient information—thereby greatly reducing the need to manually add Recipients. Corporate Suite allows user to import Recipient-only data.*

Manually Add Recipients

1. On the menu bar select File > Recipients List.
2. At the Recipient Master list screen click "Add".
3. At the Adding a Recipient Record screen complete all fields. Use the <F1> key at any time to access field specific information.
4. After completing all fields click "OK" to save the Recipient.
   - Access the Recipient Master List at the Adding a Tax Form screen by placing your cursor in the

Change a Recipient

Changes to a Recipient only flow-through to associated tax forms with a Pending status.

Change a Recipient

1. On the menu bar select File > Recipients List.
2. At the Recipient Master list screen highlight the Recipient and click "Change".
3. At the Changing a Recipient Record screen make changes and click "OK".
4. The Administrator prompts to update all pending records with the new Recipient information.
   - Records with a Printed, Filed or SB Filed status are not updated.

Delete a Recipient

A Recipient cannot be deleted if they are associated with ANY records including DELETED or VOİDED tax forms. Users are strongly encouraged to backup data prior to deleting Recipients.

Delete INDIVIDUAL Recipients

1. On the menu bar select File > Recipient List.
2. At the Recipient Master list screen highlight the Recipient and click "Delete".
3. At the Confirm Delete screen click "Yes" to delete the Recipient or "No" to cancel.

Delete Recipients With No Forms

1. On the menu bar select File > Recipient List.
2. At the Recipient Master list screen click "Delete All With No Forms".
3. The Administrator warns this action cannot be reversed. Click "Yes" to continue with deletion or "No" to cancel and exit this screen.

**Select Recipients**

All Recipient records are stored in a master database which is accessible at any tax form.

**Access Recipients**

1. To access Recipient information at any data entry screen place your cursor in the Recipient TIN field and select the <F2> key or right-click your mouse.
2. The Select a Recipient screen displays ALL Recipients for ALL Filers in the software database.
3. At the Select a Recipient screen, highlight a Recipient and click "Select" or double-click the Recipient. All Recipient associated information (i.e., TIN, Name and Address) automatically populates the form.

   ![Select a Recipient screen with Last Name filter in place.]

**Filter Recipients**

1. Place your cursor in the Search/Filter box.
2. Select the View by TIN (SSN/EIN) or View by Last Name tab.
3. Enter your search criteria and click <TAB> on your keyboard. For example, enter "BA" and <TAB> to display only recipients with a Company or Last Name starting with those letters.
4. To remove the filter click the "Show All (remove filter)" button.

**Recipient Lookups**

Use the Recipient Lookup and Forms Issued utility to run a program-wide search for a Recipient and view a list of associated form types with detailed information including form(s) status / error status, Recipient Account Number(s), Filer TIN, Payer Code and Filer Name. This is a quick and powerful tool to locate a Recipient for those Users with a high volume of Filers and records in their database.

For a more refined search, use the Custom Query Wizard at the Recipient Master List screen to search by state, dollar amounts, dates, etc.

**Run Recipient Lookup**

1. On the menu bar select File > Recipient Lookup OR at the Recipient Master List screen click the "Recipient Lookup" button.
• Determine your search criteria; by TIN, Last Name/Company or Account Number. Enter the first few characters and then click on the corresponding "by TIN", "by Account" or "by Name" button.

• All tax forms associated with the Recipient are displayed, including their status and the associated Filer. If more than one Recipient matches the search criteria, the Select a Recipient screen displays.

2. From this screen forms can be viewed, changed or corrected as available per their status and printed via the Quick-Print button.

* The Recipient Lookup feature is not available in 1042-S Pro or 8966 Pro.

Global Notes
Users can add notes to individual tax forms, Recipient records and Filer records. Notes can contain up to 512 characters and unlimited notes are allowed. Every time a note is created or updated, the note displays the date and time of the action and either the User ID of the person who made the change (assuming Security is enabled) or the network name/ID of the machine where the change was made.

Depending on the type of note, users can view and update them from multiple places within the software. At a tax form data entry screen, if there are any notes associated with the Recipient, Filer or the specific tax form the "Notes" button changes to "Has Notes".

Global Notes
Global notes are visible everywhere within the program, these notes can be viewed and updated from every Notes browse. Users can also enter these notes directly from the main File menu via the 'Global Notes' option.

Filer Notes
Filer notes are associated with a specific Filer, and are only available on the update form for that Filer. When entering notes for a Filer, you can also view/update all Global notes.

Recipient Notes
Recipient notes are associated with the individual Recipient, and can be viewed and/or updated from both the Recipient update form and from every tax form associated with that Recipient. When entering notes for a Recipient, you can also view/update all Global notes.

Tax Form Notes
This type of note is attached to one specific tax form for one Recipient. When entering notes for a tax form, you can also view/update the notes for the Recipient and Filer of the form, as well as view/update all Global notes.

Update Notes
Use this screen to add or modify notes. Please see Browse Notes/Attachments for all available note types.
Transmitters
Transmitter/Submitter Information
Transmitter requirements are specific to the type of form being electronically filed. See Create Transmitter.

1099 Informational Returns / Forms 1042-S
A Transmitter Control Code number or (TCC) is required when filing electronically. A TCC for FIRE is composed of five alpha-numeric characters starting with "22". If filing electronically via the Service Bureau a TCC is not required and this information does not need to be entered.

Request a TCC for IRS FIRE System
To obtain a TCC file Form 4419 to request authorization to file forms electronically. Form 4419 must be filed no later than 45 days before the due date of the information returns. Print Form 4419 via the task panel > Help & Extras > IRS Pubs & Links. For more information on TCC's, contact the IRS's Technical Services Operation (TSO) Customer Service Section toll-free at (866)- 455-7438. A single TCC can be used to file on behalf of multiple Filers.

Form 8966
Transmitter information is provided to the IRS for contact purposes. This basic information must be filled out prior to creating the XML file that is packaged and sent to the IRS.

8966 Pro requires transmitters to have either a GIIN or FIN to generate XML files; this information is contained in the <ftc:MessageSpec> element of your XML file.

FIN Numbers
Certain entities including U.S. withholding agents (USWA), territory financial institutions (TFI), third party preparers, or commercial software vendors are not required to have GIINs. These non-GIIN filers are required to obtain a FIN (FATCA Identification Number) in place of a GIIN to access IDES. The FIN is the 19-character identifier entered in the metadata and FATCA XML message header.

Browse Transmitter/Submitter
Transmitter information is required when generating electronic files and is specific to the form type; see Transmitter Information. Transmitter information is not needed if filing via the Service Bureau.

Forms 8966
Create a Transmitter
1. On the menu bar select File > Transmitter Information.
2. At the Update Electronic Filing Transmitter Information screen enter the Company specific information:
   o Company Name
   o Address Formatting:
     ▪ USA
     ▪ CANADA
     ▪ OTHER
3. Enter the FIN if a third party preparer.
   o Certain entities including U.S. withholding agents (USWA), territory financial institutions (TFI),
     third party preparers, or commercial software vendors are not required to have GIINs. These
     non-GIIN filers are required to obtain a FIN (FATCA Identification Number) in place of a GIIN
     to access IDES. The FIN is the 19-character identifier entered in the metadata and FATCA XML
     message header.
4. Click "OK" to save changes or "Cancel" to abort.

**NQI & I/FTE Lookup**

Corporate Suite, 1042-S Pro and 8966 Pro software make it easy to add, change and delete NQI and
flow-through entities associated with Form 1042-S. Review IRS information on Flow-Through Entities
and Payments to Nonqualified Intermediaries (NQIs).

**Browse Filer NQI File Screen**

1. On the Corporate Suite menu bar select File > 1042-S NQI Lookup List, OR
2. On the 1042-S Pro menu bar select File > Intermediary/Flow-Through Entity Lookup List, OR
3. On the 8966 Pro menu bar select File > Intermediary/Flow-Through Entity Lookup List.
4. This screen allows user to add, change and delete NQI and I/FT entities.

The Browse Filer NQI File screen is accessible directly from:

The Adding a Form 1042-S Record screen via the <F2> key (or right-click the mouse) in Box 15a or
Boxes 15d - 15g. Accessed this way, users can also Select and Clone entities.

The Adding a Form 8966 Record screen via the <F2> key (or right-click the mouse) in Part I, TIN field.
Accessed this way, users can also Select and Clone entities.

See Update Filer NQI[38] for information on Nonqualified Intermediaries (NQIs) and Flow-Through
(FT) Entities.

**Update Filer NQI**

At the Adding or Changing a NQI record screen complete fields. If the TIN is unknown it is acceptable
to leave this field blank.

**Country Alias**

All 1099 Pro software products support custom country name and validation options during the
import process. This is useful in situations where the code used for a particular country does not
match the one used by the IRS. For example, if using "JPN" to denote Japan, an error would occur as
the IRS country code for Japan is "JP". To correct this error, the software allows users to create an
alias for any country in the IRS database.
**Create Country Alias**
These instructions make use of the above Japan, invalid "JPN" code, example.

1. On the initial import attempt, 1099 Pro generates an "Invalid Country" warning at the Edit, Post or Abandon Import Records screen.

2. Double-click on the record to determine that the country code—in this example, "JPN"—is invalid.

3. Click the "Update Country Alias File" button at the bottom center of the Edit, Post or Abandon Import Records screen. The Browse Country Alias/Translations screen lists any existing country alias. To create a new alias, click "Add".

4. At the Adding a Country Alias Record screen, in the top box enter the alias (or incoming value) and in the bottom box enter the name of the country OR click on the ellipses button for a complete list of IRS country names and codes. After entering both the alias and corresponding IRS country code, click "OK" to continue.

5. After configuring the alias, click the "Close" button on the Browse Country Alias/Translation window to return to the Import Wizard.

6. Click the "Reapply Alias/Validation" button and the Administrator prompts the user to apply the alias/translations. The alias can be applied to ALL records or only problem records.

7. Once the aliases/validations are applied, 1099 Pro software properly translates "JPN" to Japan or "JP" and the "Invalid Country" warning is removed.

**Update Country Alias**
See [Country Alias](#) for an overview.

**Add/Update Alias**
1. At the Adding a Country Alias Record screen, in the top box enter the country alias (or incoming value). In the bottom box enter either:
   - The legal name of the country, OR
   - Use the ellipses button to select from a complete list of IRS country names and codes.
2. After entering both the alias and corresponding IRS country code, click "OK" to save changes and return to the Browse Country Alias/Translation screen.
Security & Administration

Access the Global Administrative Options screen via the menu bar > File > Security and Administration. Only Administrators and select Users can access these options.

Security Options

Through the use of settings and rights Administrators can restrict Users and thereby help protect sensitive company data. See Security Overview. Use the "Security Groups" button to access the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Turn Security On/Off</strong></td>
<td>1099 Pro offers two levels of security; on and off. If security is enabled, access to 1099 Pro is limited to Users with valid User ID/Password combinations. These Users are restricted to specific tasks assigned by the Administrator. This provides a twofold method of protecting sensitive company data.</td>
</tr>
<tr>
<td><strong>Add/Update Individual Users</strong></td>
<td>Administrators can use the Add/Update Individual Users screen to create Users and assign them to specific tasks.</td>
</tr>
<tr>
<td><strong>Access Groups and User Profiles</strong></td>
<td>Create new Access Groups and User Profiles based on the user’s custom settings. Your groups will be available when adding or changing a User and are included in all security reports.</td>
</tr>
<tr>
<td><strong>Passwords</strong></td>
<td>Passwords can help protect sensitive company data.</td>
</tr>
<tr>
<td><strong>Security Access Logs</strong></td>
<td>The Security Access Log tracks every time Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all logon attempts.</td>
</tr>
<tr>
<td><strong>Security Reports</strong></td>
<td>1099 Pro offers numerous reports to track users and access groups. These security reports are available only to Administrators or Users with administrative rights.</td>
</tr>
</tbody>
</table>

Tax Form Audit Trail and Action Logging Options

Audit trails allows Administrators or Users with administrative access to track changes and actions taken on tax forms. Use the "Audit Trails & Logging" button to access the following items:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View Audit Trail Records</strong></td>
<td>Use this button to access the Master Audit Trail Browser and view both manual and cascading updates to all tax forms. Use the Record History screen to view audit trails for individual tax forms.</td>
</tr>
<tr>
<td><strong>Print TINCheck Activity Report</strong></td>
<td>Use to view a report of all TINCheck requests and results associated with an individual record. This utility is not available in W-2 Pro and 8966 Pro.</td>
</tr>
<tr>
<td><strong>Purge Excess Log Records</strong></td>
<td>The Audit Trail Record Log is invaluable for tracking tax forms changes. If the log becomes so large that the performance of this software is compromised, older records may be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system.</td>
</tr>
</tbody>
</table>

Business Rules and Options

Review and modify overall program options and settings. Use the "Program Options" button to access the following items.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preference, Update and Program Options 50</td>
<td>Configure many of the software general settings such as date range warning, update checking and backup reminders.</td>
</tr>
<tr>
<td>Tax Form Validation 52</td>
<td>Adjust settings to configure the warning and error messages displayed when importing or manually entering forms.</td>
</tr>
<tr>
<td>Configure TINCheck Account</td>
<td>Users with active TINCheck accounts can associate their account with this software and perform instant TIN Validations when adding or changing a tax form. This utility is not available in W-2 Pro and 8966 Pro.</td>
</tr>
<tr>
<td>Tax Form Print Codes &amp; Custom Messages</td>
<td>Corporate Suite Only Feature</td>
</tr>
</tbody>
</table>

**Security Groups**

Administrators and select Users can access Security settings via the menu bar > File > Security and Administration > "Security Groups" button. See [Global Administrative Options](#).

**Security Overview**

*Step 1: Password Requirements* 43
*Step 2: Access Groups* 42
*Step 3: Manage Profiles* 44
*Step 4: Add/Update Individual Users* 46
*Step 5: Add Users to a Profile* 46

**Security—Step 1: Password Requirements**

The Security Preferences/Password requirements area allows Administrators to configure details regarding User passwords including: password length, lockout settings, expiration and password format. Learn about First Time Login Password.

**Set Password Requirements**

1. To configure password and login requirements click the "Set Password Requirements" button.

2. At the Modify System Security Settings window, configure the following settings:
   a. Login Type: (Corporate Suite Only)
   b. Minimum Password Length: Defines the minimum character length the password can be; range is from 5-15 characters
   c. Lock a User ID after this many invalid login attempts: Sets the maximum number of times a User can fail to login before needing to have their account unlocked by an Administrator.
   d. Days before a password expires: Sets the length of time a User’s password is valid before they must choose a new one.
   e. Days to warn a user before their password expires: Defines when the software will start notifying the User that their password is going to expire.
f. Times before a password can be used again: Defines how many different passwords must be used before a User can use the same password again.
g. Ignore case when validating Passwords ['e' = 'E']: Determines whether or not case matters when a User is entering their password. (Corporate Suite Only)
h. Require at least One (1) Uppercase Character: Determines whether or not there must be at least one uppercase character in a User’s password.
i. Require at least One (1) Lowercase Character: Determines whether or not there must be at least one lowercase character in a User’s password.
j. Require at least One (1) Numeric Character: Determines whether or not there must be at least one numeric character in a User’s password.
k. Require Special Characters in Password: Determines whether or not special characters (i.e., !, @, #, $, % ,^, etc.) are required in a User’s password. Admin must specify which special characters are allowed before enabling this option (see "l" below).
l. Special Characters (Up to 15): Define special characters which may be used during password creation.


Security—Step 2: Access Groups

Access Groups allow an Administrator to define the Program Areas and Form types that a User will have access to, as well as their level of access. Users only have the rights specifically assigned to them; any rights not assigned are denied by default. The rights available within 1099 Pro software products include: View/Access area, Create, Modify, Delete, Report, Correct, Print, and Reset/Void where applicable.

Assign Access Groups


2. At the Security Options screen click the "Create and Manage Access Groups" button to access the Access Groups screen.

3. Click “Add” to open the Update Access Groups screen and create a new access group. Admin can also select “Change” or "Delete" to modify any existing access groups or to view the contents of a built in Access Group.
   - *This software includes multiple built-in access groups (indicated in BLUE) that cannot be modified or deleted.*

4. At the Update Access Groups screen enter a Group Name.

5. Use the "Tag" button to select the Forms or Program Areas to include in this group.

6. After selecting each item, use the "Modify Highlighted Record" button to assign rights within this area. If a Program Area or Form type is selected (or "tagged") but no rights are assigned to it, a "View Only" access rule is created. This allows assigned users to enter/view an area or form only; they will NOT be allowed to edit or save changes.
7. After selecting all Forms and/or Program Areas AND assigning rights, Administrators can add detailed Notes for the Access Group. Click "Save Changes to Group" to return to the Update Access Groups screen.

8. At this point the Admin can "Add", "Change" or "Delete" other Access Groups as necessary; excluding 1099 Pro's built-in access groups. When finished click “Close” to return to the Security Options screen.

9. Continue to Security—Step 3: Manage Profiles

**Access Rights**

When creating or modifying an Access Group, Administrators select the Form(s) and/or Program Area(s) to include and must also assign a level of access rights. By default, NO access rights are preset. If a Program Area or Form type is selected (or "tagged") but no rights are assigned to it, a “View Only” access rule is created. This allows assigned users to enter/view an area or form only; they will NOT be allowed to edit or save changes.

**Assign Access Rights**

1. At the Update Access Groups screen, highlight any selected Form or Program Area and click the "Modify Highlighted Record" button.

2. At the Modify Access Rights screen Admin can "Select ALL Rights" or individually select rights. Options include:
   - Create new items or initiate processes
   - Modify exiting items
   - Delete existing items
   - Run Reports in this area
   - Items that are grayed out are unavailable for selection.

3. Click "Save" to return to Update Access Groups.

**Tag Access Groups**

At the Tag Access Groups screen, Administrators can assign access groups to Users; thus restricting a User's access to a selected Filer(s) and permissions within that Filer. For example, an Administrator may assign to User "John Doe", access to Filers "ABC Company" and "123 Company", but only for "W-9 Tracking" and to "Allow TINCheck Access". User "Jane Doe" however, has access to the same Filers but with "Tax Forms (Full Rights)".


**Assign Access Groups**

1. On the menu bar select Filers > Security and Administration.

2. At the Global Administrative Options screen select "Security Groups".

3. At the Security Options screen select "Create and Manage User Profiles for Filers and Access Groups".
4. At the User Profiles screen click the "Add" button.

5. At the Update User Profile screen enter a Profile Name for the user.
   • Profile names must be unique and contain a minimum of four characters.

6. Tag (or select) the Filer(s) this user can access. Highlight Filers individually and click the "Assign Access Group(s) to Highlighted Record" button.

7. At the Tag Access Groups screen tag access groups to assign to the user profiles (see Step 2: Creating and Managing Access Groups). Click the "Save" button to save changes and exit this screen.
   • Use the "Show Tagged" button to display only the Access Groups assigned to this user profile.
   • If there are multiple Filers assigned to the user profile, the above steps 5 - 6 must be repeated separately for each Filer.

8. After assigning Access Group rights to all Filers associated with the User Profile, click the "Save Changes To Group" button at the Update User Profile Screen. This newly created User Profile is displayed at the User Profile screen and is available for future changes, deletion or cloning.

Security—Step 3: Manage Profiles

User Profiles allow Admin to apply Access Groups to specific Filers/Departments. When assigning a User to this profile (Step 4), the User only has the specific rights granted by that Access Group to the specified Filers. 1099 Pro’s built-in User Profiles are applied to ALL Filers. In order to access the 1099 Pro system, a User must have rights to AT LEAST one Filer, in other words, they must be assigned to at least one User Profile.

The below diagram illustrates the components comprising a User Profile. In Step 4 the users are assigned to the profiles.
Set User Profiles

1. To create or manage a User Profile click "Create and Manage User Profiles for Filers and Access Groups" from within the Security Options window. 1099 Pro includes built-in User Profiles. Built-in groups are indicated in BLUE and cannot be modified or edited. **By default, all built-in User Profiles have access to ALL current and future Filers.**

2. Click "Add" to create a new user profile or select "Change" to modify any existing User Profiles. The "Quick Assign" button walks users through these steps in a wizard. Use the "Clone Profile" button to clone a previously created profile and then edit the Filers and Access Groups assigned to it.

3. After clicking "Add", "Change" or "Clone Profile" the Update User Profile screen opens. At this screen assign Access groups to Filers.

4. Create or update a User profile:
   A. Create a name for the User profile.
   B. Tag (or select) the Filers to allow access to.
   C. Highlight the Filer to configure and click the "Assign Access Groups" button to attach Access Groups that were previously created to the profiles.
   D. At the Tag Access Group screen select the previously created profiles (Step 2).
   E. After selecting profiles click "Save" to exit. **Repeat Steps C, D and E for each Filer in this profile.**

5. Upon exiting the Update User Profile screen return to the User Profiles screen where Admin can continue to add, change or delete profiles. After updating profiles click "Close" to return to the Security Options window.

6. Continue to [Security—Step 4: Add/Update Individual Users](#)
Security—Step 4: Add/Update Individual Users
Generally there is one assigned User for each physical user of the software. This section assists in the creating, updating, and deleting of Users. Remember, built-in accounts cannot be modified or deleted but they can be copied and then modified.

Set Individual Users
1. To configure Users, click on "Add/Update Individual Users" at the Security Options screen.

2. The Users screen displays all current users in the software. Use the "Add User" button to add a new user and the "Change" button to modify an existing User or view their associated profiles. The "Delete" button removes Users from the system.

3. Click the "Add User" button to open the Adding a User window where Admin creates the login information required for the new User to access the software (or Change User in the case of clicking the "Change" button). Define User Login Settings:
   - **User ID**—Enter a User ID (User Name) for software login.
   - **Password**—By default, all new Users are assigned NEW (all caps) as their password—this cannot be changed at this screen. To set the user requirements for password see Security Password Requirements.
   - **Lock Status**—Indicates if a user account is locked due to login failures. Click "Change" to lock or unlock an account. The Admin can reset the password as necessary.
   - **Pre-W2K Domain (Corporate Suite only)**—This is only used when Active Directory Login type is selected by clicking “Set Security Preferences” on the “Security Options” screen.
     - Optional Information includes:
       - **User Name**—User’s full name; this information does not impact login credentials.
       - **Phone**—User's contact phone number.
       - **Other Info**—Add other information such as user's department, e-mail address, location, etc.
       - **User Profile Membership**—This field displays all of the User Profiles associated with the User.


Security—Step 5: Add Users to a Profile
This final step in configuring security guides Admin through the process of assigning a User to a profile created during Step 3: Manage Profiles.

Assign Users to Profiles
1. Click on the "Add/Remove Users from Profiles" button located on the Security Options window.

2. At the Security—Assign Users screen assign newly created Users to a profile.

3. Select the profile to add Users to via the “Available User Profiles” drop menu.

4. Tag the Users to apply to the selected profile. Click "Save" prior to adding Users to another profile.
To tag a User highlight the user and click the “Tag” button or click in the column to the left of their UserID.

**Turn On/Off Security**

**Activate Security**
2. At the Security Options screen the Security status is displayed as ON or OFF.
3. If security is OFF (or not enabled) click the "Activate Security" button to enable it.
4. Restart the program for settings to take effect.

**Security Reports**

All 1099 Pro software products offer reports to track Users, User Profiles, and Access Groups. These security reports are available only to Admin or Users with administrative rights.

1. On the menu bar select File > Security and Administration.
2. At the Administration screen click the "View/Print Security Reports" button. Available reports include:
   - Print Users by Name: Lists all users sorted by User ID.
   - Users and Attached Profiles: Lists all access users and all of their associated User Profiles.
   - Access Group Detail: Lists Access Groups and all of the permissions assigned to them.
   - Detailed Security Report: Summarizes the User Profiles and Access Groups selected Users are assigned to.
   - Security Log: Generates a report based on the security audit trail.
3. All reports offer a **print preview** option.

**Security Access Log**

The Security Access Log tracks every instance that Security or Audit Trails are enabled or disabled. If Security is enabled, the Security Access Log also tracks all log-on attempts.

**Browse & Manage the Security Access Log**

1099 Pro includes predefined queries for sorting access log records including:
- All Records: Default selection that displays all records.
- Access for One Date: Select this query and then enter the date for which you want to show logs.
- Access for One User: Select this query and then click "Select User to Show" to pick a user, or click "Show Records with No Users" for any records with an unknown user.

**Export Log-on Records to Excel Spreadsheet**

The Security Access Log tracks all attempts to open 1099 Pro. This log can be exported for review in an Excel document.
1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. Click on "Export to XML" located near the bottom left.
4. Select your destination folder and click "OK"

**Purge Log-on Records**
The Security Access Log tracks all attempts to open 1099 Pro. If the log becomes so big that the performance of 1099 Pro is compromised, older records may be purged. When purging records ONLY successful logons are deleted.

**Purge Records**
1. On the menu bar select File > Security and Administration.
2. At the Administration screen click "Manage Security Access Logs".
3. At the Browse & Manage the Security Access Log screen click the "Purge Log-on Records" button.
4. The Purge Audit History screen allows the user to indicate the date PRIOR to which log-on records are purged. Modify this date as necessary.
5. Click "Begin" to start deleting records. A warning screen reminds that all deletions are permanent. Click "Start Deleting" to continue or "Cancel" to abort. All purge attempts are permanently recorded in the log.

**Audit Trails & Logging**

**Audit Trails Activity Report**
Audit trails track certain activities related to a Tax Form, Recipient Record or Filer Record including Created, Viewed, Deleted and any Quick-Prints or ASCII Exports. Audit trails detail the Date/Time and User ID associated with the activity.

**Run Audit Trails Report**
Administrators and Users with permissions can generate reports of all audit trail activity related to one or more areas in your 1099 Pro software product.

2. At the Tax Form Audit Trail and Action Logging Options screen click the "View/Print Audit Changes Report" button.
3. Set [Audit Trail Filters](#) and click "OK" to generate report.

**Run Recipient Specific Audit Trails Report**
Users with permissions can view all activity related to a specific Recipient form; for example, all activity on a TY 2018 1099-MISC issued to John Doe.

1. At the Work With My Tax Forms screen select the record to review.
2. Click the "Change" button to open the Changing a Form screen.
   - If record has a Filed status, click the "View the Form" button at the Protected Form Update screen to continue to the Viewing a Form screen.
3. Click the "Audit Trail" button to view the record history.
4. Click the "Print Current Changes Report" button and select "Yes" to preview the report.
**Audit Trails Report Legend**
- T = TIN (Tax ID Number)
- N = Recipient Name
- R = Recipient Name
- A = Account Number
- D = Filer Department
- Subtype: Audit report tool doesn't know what was done with the record.
- TransType: Audit report tool doesn't know what was changed on any transactions.

**Master Audit Trail Browser**
Audit Trails track certain activities related to a Tax Form, Recipient Record or Filer Record including Created, Viewed, Deleted and any Quick-Prints or ASCII Exports and more. Audit trails detail the Date/Time and User ID associated with the activity. Audit trails do NOT track cascading updates.

**Master Audit Trail Browser**
The Master Audit Trail Browser is available only to Administrators or Users with permissions. Use it to view all manual changes to ALL tax forms (the Record History screen allows the viewing of individual tax forms only). From this browse screen users can run an Audit Trails Activity Report and view highly detailed audit trail information.

2. At the Tax Form Audit Trail and Action Logging Options screen click the "View Audit Trail Records" button.
3. Specify Audit Trail Filters, otherwise the report can be very large and slow to generate. Click "OK" to continue.

**About Record History**
The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record; cascading updates are not reflected. See Record History for more information.

**Purging Audit Trail Logs**
The Audit Trail Record Log is invaluable should you need to track tax forms changes. If the log becomes so big that the performance of 1099 Pro is compromised, older records can be purged. For most users however, purging is not necessary and is generally not recommended as this valuable information is permanently deleted from the system. See Purging Audit Trail Logs for more information.

**Disable Audit Trails**
Only Corporate Suite allows the disabling of Audit Trails.

**Purge Audit Trails**
This functionality is not enabled in this software product.
Audit Trail Report Filters

It is important to set Audit Trail Filters, otherwise generated reports and/or the Master Audit Trail Browse screen can be very large and slow to generate.

<table>
<thead>
<tr>
<th>Set Filters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options</strong></td>
<td><strong>Limit Report to Changes for Form Type:</strong></td>
</tr>
</tbody>
</table>
| | - All Forms  
| | - One Form Type  
| | **Limit Report to Changes for one PCode (payer code):** |
| | - All Filers  
| | - One Filer  
| | **Limit Report to Changes from one User ID or Workstation:** |
| | - All Users  
| | - One User  
| | - One Workstation  
| | **Limit Reports to a Date Range:** |
| | - None  
| | - Today or Yesterday  
| | - Last 7 Days, Last 14 Days or Last 30 Days  
| | - Specify Other Range—Set the date range for this report. *If the range is too large, the report may be very slow to generate.*  
| | **Record Activity Options:** |
| | - All Activity  
| | - All But Views  
| | - Only Deleted  

Program Options

Preferences/Options

All 1099 Pro software products allow Users to customize the program via Preferences. Any User with access to Security and Administration can modify these settings. Changes made at the Preferences screen are universal to the program; they are not user-specific. In multi-user environments, Administrators can restrict user access to this area by setting permissions within Access Groups.

Modify Preferences

1. On the menu bar select File > Security & Administration > Program Options.

2. At the Business Rules & Options screen click the "Preference, Update and Program Options" button to access the Preferences screen.

3. At the Preferences screen, tabs include; General, General (More) and Checking for Updates. Many items are checked "on" by default with the objective of safeguarding user data. Functions can be set ON/OFF at the user’s discretion by inserting or removing a check in the corresponding box.

4. Changes take effect AFTER clicking "OK" and then exiting and re-opening the software.
### Preference Settings
Many Preference settings are "ON" by default with the objective of safeguarding user data.

### GENERAL Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Overall Options</td>
<td>Auto capitalize names, addresses and localities during manual entry.</td>
</tr>
<tr>
<td>Backing Up Data Files</td>
<td>Remind me to backup every X days. Users are strongly encouraged to backup data on a regular basis. To backup once per day enter &quot;1&quot;, every two days enter &quot;2&quot;, etc. Set to zero to backup every time the program is exited. <strong>Administrators are strongly encouraged to create backup copies of data on a regular, if not daily, basis.</strong> IRS regulations require tax data to be maintained by Filers for five years.</td>
</tr>
</tbody>
</table>
| Global Date Range Checking*               | Warn if dates entered on forms are outside of this range. Set dates are within the respective tax year. Dates may be modified by clicking the ellipses buttons.  
  ● Date is before 1/01/2018 (default entry), OR  
  ● Date is after 12/31/2018 (default entry)                                                     |
| Options for Manually DELETED Tax Forms    | ● Allow previously deleted tax forms to be visible at the Work With My Tax Form screen.  
  ● Allow users to revert previously deleted tax forms. **Available in Corporate Suite only.** |
| Other Global Options                      | ● Suppress/turn off the Report Wizard 'Custom Reports' option on Browses.  
  ● Suppress/hide all TINCheck functions and capabilities.                                    |
| Recipient Address ZIP Code/City Options   | ● Convert City to UPPER case during manual entry ZIP lookups  
  ● Always convert Recipient City to UPPER case during printing                                |
| Other Options                             | ● Automatically reselect the last Filer at program start  
  ● Show a reminder when using "Add Recipient"                                                 |
| Task Menu Display                         | ● Suppress the "Control Total Reports" option  
  ● Suppress the "Recipients List" option                                                      |

### CHECKING FOR UPDATES Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ask for Confirmation Every Time Checkbox</td>
<td>● Ask for confirmation every time before checking for updates. Only deselect this box if your Internet connection is always on. When an update is available, users are always prompted prior to download/installation, regardless of the status of this box.</td>
</tr>
</tbody>
</table>
| How Often Should Program Check for Updates? | ● Automatic Adjustment (recommended)—The program will check for updates occasionally during summer, more frequently as tax season approaches and every day at the height of tax season.  
  ● Specified Interval (1 - 45 days) Throughout the Year—Checks will occur at the interval specified here. |
## Tax Form Validation

All 1099 Pro software products include standard rules for detecting errors and/or warnings on tax forms such as invalid TINs, ZIP codes plus IRS/SSA rules that govern how boxes should be completed. Users can change existing validation rules as outlined below and create custom validation rules at any time.

**Business rules are in place to provide Users with the highest likelihood of their data being accepted by the IRS/SSA. Users who disable a rule to process their forms have a higher risk of their data being rejected.**

### Deactivate (Turn-Off) Rules

1. On the menu bar go to File > Security and Administration > Program Options > Tax Form Validation for Import and Entry to access the Manage Business Rules/Validation screen. Use the Tax Form drop menu to select a specific tax forms or "Common" rules that apply universally to the software.

2. The Manage Business Rules/Validation screen summarizes the rules for a particular form and indicates if the rule is active, where the rule is active and the severity.
   - Column "DT/Imp/Web" indicates where the rule is applied. **DT** = Manual Data Entry, **Imp** = Imports and **Web** = Web/Internet Module Users.
   - Error message severity is indicated by **W** = Warning (non-fatal), **E** = Error (may be error) and **R** = Reject (form will not be imported or saved).

3. To disable a rule, uncheck the "Rule is active/applied" box and click the "Save" button. Rules can be reactivated at any time.
   - To customize or edit a rule highlight it and click "Change" to access the Rule Will Be Changed screen.

Business Rule 13—An error is flagged if the **GIIN** contains the characters "SP" but Sponsored Entity Type is not set to “Spon ENT Type”.

### Reports

#### Unfiled Forms Summary Report

**New for TY 2018**—The Unfiled Forms Summary report details "Filed" or "Not Filed" status for all records by form type. **This report is a great resource to ensure that no records are accidentally overlooked during the filing season.** See Filing Status—Am I Done?

**Unfiled Forms Summary Report**

1. On the menu bar select Reports > Unfiled Forms Summary Report.
2. Click "Yes" to preview the report.
Control Totals Report

The Form Control Totals report is an invaluable tool for reviewing Recipient records and pinpointing errors and warnings. This report is tax form and Filer specific and includes:

- Filer's Name and TIN
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more...

Control Totals Report

1. Select the form type and Filer.

2. On the menu bar select Reports > Control Totals for Current Filer & Form Type OR on the task panel select Preparing My Forms > Forms Totals Report.

3. At the View/Print Control Totals Report screen select a printer. Consider printing to PDF to save paper.

4. Report Filter and Form Selection Options—Choose a method for selecting records:
   - All Pending Originals for this Filer
   - All Original Forms for this Filer
   - Use Query Wizard to choose or create a query
   - Manually select records (tagging)
5. Error and Warning Messages—Determine how to print warnings and/or errors. This option is only available if "Extended Version" is selected under Report Format Options, below.
   - Don't print error and warning details
   - Print error and warning details
   - Print ONLY forms with errors and warnings
   - Print ONLY forms with errors

6. Report Record Ordering Options—Choose how to sort the records:
   - By Last Name
   - By TIN
   - By Account Number, then Last Name

7. Report Format Options—Choose a report format:
   - Summary Version (amounts only, no address, text or error/warning detail).
   - Extended Version (all form details including address and errors/warnings)

8. Additional options include:
   - Add custom notes for this report run
   - Print totals only (suppress individual form details)

9. To generate report click "Print Now".

10. At the preview screen go to the last page to view box-by-box summary totals.

**Form Counts by Filer Report**

The Form Counts by Filer reports generates a listing of all forms sorted by Filer, batched by status, i.e., Pending, Printed, SB Printed, Filed 1096, Mag Filed, SB Filed and Not Filed. The last page of the report totals forms with errors and/or warnings and indicates if original or corrected. This report is very useful for tracking the status of your forms and determining if records contain errors or warnings and their filing status.

**Form Counts by Filer Report**
1. On the menu bar select Reports > Form Counts by Filer/Status (all Filers/all Form types).
2. Click "Yes" to preview the report.

**All Forms Issued by Filer Report**

The Summary of Forms Issued by Filer report details records issued by Filer including Recipient Name, TIN, Address and each record’s respective filing status, i.e., Pending, Printed, SB Printed, Filed 1096, eFiled, Corr/Pending, etc. For detailed Filer specific information see the Filer Listing Report.

**Forms Issued By Filer Report**
1. On the menu bar select Reports > All Forms Issued by Selected Filer.
2. Click "Yes" to preview the report.
3. At the Browse the Filers File screen click the "Tag" button to select Filers. A red check displays to the left of each tagged Filer. To sort Filers prior to tagging, use the View drop menu.
4. After tagging appropriate Filers click "Proceed to Next Step" to run the report.
Recipient Listing Report

The Recipient Listing includes the Name, TIN, and Address of all recipients in the software database. For more detailed recipient information, including Account Numbers and status of any forms, use the Control Totals report.

Recipient Listing Report
1. On the menu bar select Reports > Recipients List or alternately, at the Recipient Master List screen click the "Run Recipient Report" button.
2. At the Recipient Master List screen the Admin prompts to preview report, click "Yes".

Filer Listing Report

The Filer/Employer/Payer Listing provides detailed Filer specific information including Name, TIN, Contact Information, State ID Numbers and a history of any address changes. All Filers are automatically included in the report. For a detail of Recipient records issued by Filer, see Summary of Forms Issued by Filer.

Filer Listing Report
1. On the menu bar select File > Filers List.
2. At the Filer/Employer/Payer Master List screen select "Run Filer Report".
3. The Administrator prompts to "Print One Filer Per Page" and preview the report. Select as appropriate.

Forms
Create, Edit & View

The Work With My Tax Forms screen serves as the primary place to view, edit and track your records. Users are encouraged to familiarize themselves with it now—prior to the onset of tax season.

Work With My Tax Forms Overview

Access the Work With My Tax Forms screen via the Preparing My Forms task panel > Work With My Tax Forms. The Work With My Tax Forms screen allows users to view ALL forms, sort them by default options or create a custom query. From this screen users can Add, Change, Delete, Quick-Print and Email individual records plus initiate Group Actions.

Viewing Options

<table>
<thead>
<tr>
<th>Current Sort/View Order</th>
<th>Users can sort forms by Last Name/Company, TIN, Account or by creating a custom view. See Current Sort/View Order for further details. Scroll through results with the mouse or the keyboard UP/DOWN arrow keys.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Query/Filter</td>
<td>By default all forms are displayed. Users can display a subset of the current form type via the &quot;Current Query&quot; drop menu and select a prebuilt query, e.g. &quot;Filed Corrections Only&quot; or create their own custom query, e.g. &quot;Tax State = CA, Corrected Forms Only&quot;, etc. Note: The &quot;Status&quot; of a form can be used to create powerful queries to limit the records displayed. For example, if two batches of forms were imported—</td>
</tr>
<tr>
<td>Status Column</td>
<td>This column indicates an individual record’s position in the filing cycle and is an invaluable reference tool. A record’s Status is directly tied to its position in the filing cycle. See Status Overview.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Filing Status—Am I Done?</strong></td>
<td>Please see Filing Status—Am I Done?</td>
</tr>
<tr>
<td></td>
<td>An asterisk appended to a status indicates that the record contains errors and/or warnings. For example, Pending* or SB Filed*.</td>
</tr>
<tr>
<td>ACA Custom Queries (CS Users Only)</td>
<td>Corporate Suite includes ACA (Forms 1095-B and 1095-C) specific queries to easily sort AIR records and search for dependent related information.</td>
</tr>
</tbody>
</table>

### Onscreen Buttons

| **Add** | Use to manually add individual records; most users prefer to import their records. All 1099 Pro software products allow records to be added (either manually or via import) up to the user’s current transaction limit. Transactions can range from 5,000 in a standard purchase to an unlimited number of transactions. See Add a Record and Registration & Upgrades for more information. |
| **Change** | Use to change or edit any record with a Pending status; records with any other status are "protected" (locked) and cannot be changed. See Protected Forms Options screen and Correct a Record. Cascading updates are changes made to a Filer and/or Recipient’s information globally throughout all tax forms. See Change a Record and Cascading Updates |
| **Delete** | Use to delete any individual record with a Pending status; records with any other status are locked and cannot be deleted. To delete records in batch see Group Actions. See Delete a Record. |
| **Browse by Form** | The "Browse by Form" button allows users to initiate browsing tax forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as when using the standard browse. For example, if when viewing the list of forms in Last Name/Company order, with a Query to only show forms that contain Notes, those settings remain in effect when switching to Browse by Form mode. See Browse by Form for further instructions. |
### Menu Bar Items

<table>
<thead>
<tr>
<th>Menu Bar Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Group Actions&quot;</td>
<td>Use to tag (or select) a number of records and perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of Pending forms allows you to manually select any number of Pending forms for removal. All associated notes for the forms are likewise deleted.</td>
</tr>
<tr>
<td>&quot;Quick-Print&quot;</td>
<td>Use to quickly print an individual tax form, regardless of print status. Simply highlight the form, select &quot;Quick-Print Form&quot; and choose your print options.</td>
</tr>
<tr>
<td>&quot;Email Tax Form&quot;</td>
<td>Use to email individual tax forms to Recipients. Requires a default mailing client for your computer.</td>
</tr>
<tr>
<td>&quot;Print/View Report&quot;</td>
<td>This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report).</td>
</tr>
<tr>
<td>&quot;Custom Report&quot;</td>
<td>Use to create and save Custom Query reports. Visibility to these reports can be limited by User by the Administrator.</td>
</tr>
</tbody>
</table>

---

### Print, Reprint or Reset

All 1099 Pro software products allow users to print forms directly to blank paper or preprinted forms. Many of our users prefer to outsource the printing and mailing of their forms to the 1099 Pro Service Bureau—it is SOC 1 Type 2 secure, cost-effective and efficient.

The Tax Form Print Sessions screen simplifies the in-house printing process. At this screen users can generate Original and Corrected print runs, reprint and reset/void print sessions and more. Access this screen via the task panel > Printing & Mailing > Print/Mail Forms Myself.

### Print Wizard

All 1099 Pro software products allow users to print most forms in-house, directly to blank paper; the exception is IRS Copy A forms which require a preprinted form with a special red ink. Most IRS approved, preprinted tax forms are compatible with our software. See Print Wizard for instructions on printing Original and Corrected forms. To quickly print an individual form see Quick-Print.

### Print Session Considerations

- Print sessions are Filer and Tax Form specific. If a print session is not visible, verify that the correct Filer and tax form are selected.
- The "Session Type" column indicates the type of forms printed including Originals or Corrected.
- Additional columns detail the total number of forms and forms with errors or warnings.
• The "Date Filed" column populates automatically, AFTER an IRS filing is generated for this print session. Options include "Filed 1096", "MagMedia" or "Upload (Service Bureau)". If the "Date Filed" column is empty, an IRS filing (or IRS paper transmittal or SB IRS Upload) has NOT been generated for this print session. If this field is populated, it is the USER's responsibility to ensure that the generated IRS filing was successfully submitted to the IRS.

Reset (Void) Print Session
Highlight any print session that have not been filed to void it. If a print session has been filed (refer to the "Date Filed" column) it cannot be voided until its associated "MagMedia", "1096" or "Upload" (Service Bureau) file has been reset. A voided session cannot be un-voided.

Print Session Summary
This report generates a per record detail of a print session. The last page of this report includes Total Form Count, Number of Forms with Missing TINs, Box-By-Box Totals and a State Withholding Breakdown.

Run Report
1. Click the "View/Print Session Summary" button.
2. Other Report Options include:
   • Preview before printing
   • Print Summary totals only
   • Errors and Warnings only
3. Click "OK" to continue.

Reprint Print Session
Use to reprint an entire print session.

Reprint Print Sessions
All 1099 Pro software products make it easy to reprint an entire print session.

- To reprint an individual record, as opposed to an entire print session, see Quick-Print.
- To reprint a group of forms, regardless of print status or session, see Group Actions.

Reprint a Print Session
1. On the task panel select Printing & Mailing >Print/Mail Forms Myself. Use the Current Form drop menu to select the form type to process.
2. At the Completed Print Sessions screen highlight a print session and click the "Reprint Session" button.
3. Select printer and click "Next" to continue.
   • PDF File Generation—Select a PDF driver such as Adobe PDF to quickly create a digital PDF copy of your tax forms. To protect sensitive data users are encouraged to password protect PDF files and save them to a location on their hard drive or network. See PDF Files
4. Select paper type including:
• **Blank Stock**—Select this option to print the physical form and tax data directly to blank paper. Most users select Blank Stock and Combined Recipient Copies. Review [Blank Paper](#) options.
• **Preprinted Plain Paper Forms**—Adjust [margin alignment](#) as necessary.
• **Pressure Seal/ACL**—Some form types offer unique print layouts.

5. Select the copies to print. Available options are determined by type of paper selected in previous step.
   - Combined Recipient Copies is a smart choice to print all required recipient copies and instructions on a single page. Must select Blank Stock as paper type.

6. Select the sort order to print forms (this field is unavailable if the print session contains only one record):
   - By Last Name/Company Name (default)
   - By TIN/Name/Account
   - By Zip/Postal Code (use to pre-sort mailings for the post office)
   - By State Abbreviation
   - By Account Name

7. Indicate preview preference:
   - Ask me before processing each copy (default)
   - Yes, preview each selected copy type without asking me
   - No, send the forms directly to the printer without previewing them

8. Advanced Options are only available for Recipient copies. Settings apply to this print run only. Options include:
   - Include a brief, standardized message on all forms
   - Force an "X" in the Corrected box on all forms. **IMPORTANT:** Forcing an "X" does not create a valid correction.
   - Force an "X" in the Void box. Most forms do NOT have a Void box. **IMPORTANT:** Forcing an "X" does not void a form.
   - Force "0.00" instead of blanks for all zero amounts
   - Modify TIN Masking settings

9. Select the "Print Now" button or "Cancel" to exit the screen.

**IRS Instructions and Blank Forms**
This software installation includes many helpful IRS/SSA forms and instructions. Additionally, users with an active Internet connection can access current versions of these and other files directly from the IRS/SSA websites. All documents are in PDF format and require Acrobat Reader to be viewed or printed. Download Acrobat Reader for free at [www.adobe.com](http://www.adobe.com).

**Print IRS Forms & Instructions**
**View Local Files**
1. On the task panel select Help & Extras > IRS Pubs & Links.
2. At the View or Print Blank Forms and Instructions screen set the Current View to "Local files installed on my machine".
3. Highlight a PDF document and click "View the Selected Form". The selected file opens automatically in Acrobat Reader.

**View Files on Internet**
1. User must have an active Internet connection.
2. Follow the appropriate links provided at the [Browse IRS Tax Forms](#) help topic.

**CAUTION: Copy A Forms and 1096 / W-3 Transmittals**
The IRS requires most Copy A* forms and **all** 1096 and W-3 Transmittal sheets to be preprinted with a special red ink that is invisible to their scanners. Do NOT send a black and white printout of those forms as they will be rejected.

* Copy A for Forms W-2 and 1042-S can be printed directly to blank paper; the special preprinted red ink is not required for these forms.

**IRS**

**Create Electronic Files**

**Create Electronic Files**
The Electronic Filing Session screen features the electronic filing utilities available in your 1099 Pro* software product. These utilities are appropriate if submitting electronic files directly to the IRS, SSA or other agency. If filing via the 1099 Pro Service Bureau see [Service Bureau Uploads](#).

Access the Electronic Filing Session window via the task panel > Filing My Forms > Electronic Filing.

**Electronic File Formats**

<table>
<thead>
<tr>
<th>eFile Format</th>
<th>Software Product</th>
<th>Accessed Via</th>
</tr>
</thead>
<tbody>
<tr>
<td>Federal Files (1220 Format)</td>
<td>1099 Pro Enterprise &amp; Corporate Suite</td>
<td>Enterprise: &quot;Create a New 1220 Format File for e-File&quot; button. CS: &quot;Create an IRS FIRE or AIR eFile&quot; button &gt; &quot;Create 1220 Format Files&quot; button.</td>
</tr>
<tr>
<td>Federal Files (ACA Format)</td>
<td>Corporate Suite Only</td>
<td>&quot;Create an IRS FIRE or AIR eFile&quot; button &gt; &quot;Create 1095 XML Files&quot; button.</td>
</tr>
<tr>
<td>Federal Files (FATCA XML Format)</td>
<td>8966 Pro Only</td>
<td>&quot;Create an 8966 FATCA XML File&quot; button.</td>
</tr>
</tbody>
</table>
### Completed eFile Sessions List

This screen is composed of logs detailing all electronic files generated via the eFile wizard. Not all columns are included in all 1099 Pro software products.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log</td>
<td>A unique number assigned to each file generated by the eFile Wizard. Logs are batched by Filer, Form Type and Trans Type. Multiple logs can be included in a single session.</td>
</tr>
<tr>
<td>Session</td>
<td>A number assigned to any group of files generated together by the eFile Wizard. One session can include multiple logs.</td>
</tr>
<tr>
<td>Filer TIN</td>
<td>The Filer TIN associated with a specific log.</td>
</tr>
<tr>
<td>Form Type</td>
<td>The form type associated with a specific log.</td>
</tr>
<tr>
<td>Copy Count</td>
<td>The number of forms generated for a specific log.</td>
</tr>
<tr>
<td>Trans Type</td>
<td>The type of transaction for a particular log (varies by software product):</td>
</tr>
<tr>
<td></td>
<td>- 1099 Pro types include: &quot;Originals&quot;, &quot;VOID: Originals&quot;, &quot;G Corrections&quot;, etc.</td>
</tr>
<tr>
<td></td>
<td>- 1042-S Pro types include &quot;Originals&quot;, &quot;Pro-Rate Originals&quot;, &quot;VOID: Originals&quot;, etc.</td>
</tr>
<tr>
<td></td>
<td>- W-2 Pro types include &quot;Originals&quot;, &quot;VOID: Originals&quot;, &quot;Corrections&quot;, &quot;State Subset File - STATE&quot;, etc.</td>
</tr>
<tr>
<td></td>
<td>- 8966 Pro types include &quot;Originals&quot;, &quot;VOID: Amended&quot;, &quot;Void&quot;, etc.</td>
</tr>
<tr>
<td>Info</td>
<td>Indicates if the session was processed for Federal or State eFiling. FEDERAL FILES—</td>
</tr>
<tr>
<td></td>
<td>- CFS: Session had the Combined Federal State Filing flag set &quot;On&quot;.</td>
</tr>
<tr>
<td></td>
<td>- Std.: Session had the Combined Federal State Filing flag set &quot;Off&quot;.</td>
</tr>
<tr>
<td></td>
<td>STATE FILES—</td>
</tr>
</tbody>
</table>
|              | - The information field for the state files uses the following pattern: Letter + Letter, e.g., "U+A".
|              | - The first letter position denotes the primary process filter:                                                                          |
|              |   - U: Unfiled records                                                                                                                   |
|              |   - A: All Records                                                                                                                      |
|              | - The second position is a static "+" (plus).                                                                                               |
|              | - The third letter position denotes the threshold setting used.                                                                          |
|              |   - A: No thresholds were applied (all eligible forms were selected).                                                                    |
|              |   - S: Only state thresholds were applied.                                                                                                 |
### Column Description

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session Date</td>
<td>The date the session file was created.</td>
</tr>
<tr>
<td>Time</td>
<td>The time the session was created.</td>
</tr>
<tr>
<td>Receipt ID (Corporate Suite)</td>
<td>Tracks the IRS confirmation for AIR filings specific to Forms 1095-B and 1095-C (ACA). Use the &quot;Update 1095/1094&quot; button to manually populate this field.</td>
</tr>
<tr>
<td>Reset/Voided</td>
<td>Indicates the date a session was voided or reset.</td>
</tr>
<tr>
<td>File Name</td>
<td>Details the file name and location saved.</td>
</tr>
</tbody>
</table>

### Onscreen Options

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;View/Print Log Report&quot;</td>
<td>Generate an eFile Log Summary report for the currently selected session including box-by-box totals, Recipient count, etc.</td>
</tr>
<tr>
<td>&quot;Reset/Void Session&quot;</td>
<td>Use to Void/Reset the highlighted electronic filing session including all log IDs associated with that session. See <a href="#">Reset eFile Session</a>.</td>
</tr>
<tr>
<td>&quot;Visit IRS FIRE Site&quot; or &quot;Visit SSA BSO Site&quot;</td>
<td>Direct access to government agencies.</td>
</tr>
<tr>
<td>Restore Archived File (Corporate Suite)</td>
<td>The eFile Wizard allows users to create an archival copy of their electronic or magnetic media file in a Binary Large Object (BLOB) retrievable format should their original eFile become corrupted or lost. Click this button to restore such an archived file.</td>
</tr>
<tr>
<td>Session Tracking (Corporate Suite)</td>
<td>Use to document an eFile's upload date, the IRS/SSA/State assigned file name or tracking ID, and if the file was Accepted or Rejected.</td>
</tr>
<tr>
<td>&quot;Update 1094/1095&quot; (Corporate Suite)</td>
<td>Use to document an eFile's upload date, the IRS/SSA/State assigned file name or tracking ID, and if the file was Accepted or Rejected.</td>
</tr>
</tbody>
</table>

### Correct Filed Forms

For a fee the Service Bureau can Print+Mail and/or IRS File your corrections. Most users print the corrections themselves, in-house, and send only an IRS File to the Service Bureau. The cost to IRS File corrections is a flat $45 per upload. The minimum cost to Print+Mail+IRS File is $85 per upload for Original or Corrected records.

### About Corrections—An Overview

The About Corrections screen displays all form types that contain corrected records. To begin the process of making a correction(s), see [Correct a Record](#).
View About Corrections Screen
On the task panel select Help & Extras > Correcting Filed Forms. A red check displays to the left of any form type containing corrected records.

When do I need to create a correction?
If a return is filed with the IRS/SSA and an error is discovered it must be corrected as soon as possible. Some corrections require one return, others require two. All 1099 Pro software products intuitively create the appropriate corrected return(s) based on the type of correction created. Additionally, users must provide corrected returns to Recipients as soon as possible. Filers may be subject to penalties for failure to file correct information returns or furnish a correct payee statement. See Types of Corrections.

Corrections Deadlines
Corrections are due within 30 days of the original filing deadline. After 30 days of the original filing deadline Filers have until August 1st to submit corrections before the next potential penalty tier. For further information reference the IRS General Instructions for Certain Information Returns, Failure To File Correct Information Returns by the Due Date (Section 6721) and Penalties: "If you do not file corrections and you do not meet any of the exceptions to the penalty, the penalty is $270 per information return". It is never too late to file corrections—including prior year corrections, too!

Do I need to file corrections with the IRS?
Filers only need to file a correction with the IRS/SSA if incorrect data was sent to the IRS. For example, if Recipient copies were mailed in January and errors were changed prior to sending data to the IRS/SSA, then no correction is necessary.

Do I need to issue corrections to my Recipients?
Yes, the IRS requires Filers to issue a "correct payee statement" to Recipients.

- If forms were sent with incorrect data to Recipients, but not to the IRS, consider sending Recipients a revised statement reflecting the accurate data. These forms will have a "Pending" or "Printed" status in the software. The corrected box is not marked; however, some Filers manually check the box with a pen to aid the Recipient in distinguishing the revised (good) form from the original issue form.
  o Filers can also force an "X" in the corrected box using the Advanced Print Options. Forcing an "X" does not qualify as a valid IRS correction.

- If forms were sent with incorrect data to Recipients AND filed with the IRS a formal correction is required and corrected copies must be both sent to the Recipient and filed with the IRS. After generating the corrections these forms have a "Corr/Pend" status and the corrected box on the Recipient copy is automatically marked with an "X" when printed. See Correct a Record.

Special Circumstances (10 Day Window)
If an IRS file was submitted within the last 10 calendar days and an error is discovered in it, the Service Bureau may be able to contact the IRS and request the file be marked as "BAD". Based on the User's individual circumstances, the Service Bureau will instruct the User to either 1) submit a new Original
file to the Service Bureau, or 2) submit a Replacement file to the Service Bureau. The Service Bureau charges $85 to take this action on behalf of the customer in addition to any Service Bureau processing fees. Email sb@1099pro.com for assistance as soon as the error is discovered.

For More Information …
Tax year 2018 form specific IRS/SSA instructions are available within this software installation and are accessible via the task panel > Help & Extras > IRS Pubs & Links. Double-click on any form or instruction to open, view or print it.

Utilities
Import Wizard Overview
All 1099 Pro software products include an Import Wizard to streamline the import process. The Import Wizard consists of three simple steps that can be quickly completed at one time or, complete the import at your leisure. Your data is not imported into the software until all three steps are successfully completed.

- See Sample Import Files — Review prior to initiating the Import Wizard.
- See Import Session Summary Report
- Error and Validation Checking is automatically performed on all imports; thereby allowing users the opportunity to find and fix any problem records before importing into the software.

Import Wizard Overview

Step 1: Import Data — Begin the import process.
Step 2: Validate Data — Review your data for errors and warnings.
Step 3: Post Results — Post your imported data into the software, for access at the Work With My Tax Forms screen and other areas.

Step 1: Import Data, Filers or Recipients
Welcome to Step 1 of the Import Wizard! Users can import Data, Filers Only or Recipients Only (Corporate Suite feature) into the program. Imports eliminate the need to manually enter data, reduce data entry errors and save valuable time.

Import Guidelines
- All programs include sample import files.
- Prior to starting your import review Import File Conventions.
- Save your Excel data file in Text Tab Delimited .TXT format to preserve formatting.

Import Wizard—Step 1: Import Data
Please watch our online video, Importing Using Standard Maps, for a brief tutorial on this process.

1. On the task panel go to Preparing My Forms > Import New Tax Forms.

2. At the Start a New Import Process screen select the "Import Records From Excel or a Delimited Text File" button.
3. At the Import LOAD Wizard screen click "Next" to proceed. Use the "Back" button at any time.

4. Select the type of tax form or "FILERS" for a Filer only import. If working in a multi-user or network environment see Troubleshooting Import Issues below.
   - Indicate the Import File Format: Excel or Delimited
   - If your import file does NOT include Header Records, use the "Add/Update Import Maps" button to create a custom mapping. See Manage Import Maps and the Delimited Import Map Wizard.

5. The Tax Forms Revisions Notice appears for any form type with new tax year changes. Check the "I understand and agree" box to cancel the reminder for future imports to this form type. Click "Next" to continue.

6. At the Select the File To Import screen browse for your import file and click "Next" to continue.
   - Your selected import file should appear in the display box; the data may appear slightly offset.
   - Data may NOT appear if 1) the original Header Records were modified or renamed, 2) there is a blank row at the top of the import file or 3) there is a blank row between the Header Row and the start of your import data. Users should cancel the import and fix their import file. See Import File Conventions.
   - If data is based on a sample import file and any columns or fields were manually deleted, users may receive a WARNING at the next screen indicating some expected fields are missing. Please review the screen carefully for instructions.

7. Select the Filer for the Import. By default the forms import to the currently selected Filer. Use the "Select a Filer" button to change as necessary.

8. At the View the Mapped Import Records screen scroll down to verify that data is correctly mapping. Use the "View Next" button to sort through actual records and see live data. If your data contains strange characters; see Import File Conventions. Users can also verify the Data Type, File Format, and Process Type before proceeding. Click "Next" to continue.

9. Specify Import Status and click "Next" to continue. Most users select Pending status; only records imported with a Pending status are available for edits or filing.
   - Pending—Default status allows users to edit, print, file or delete records.
   - Filed (Paper)—Indicates records have been filed on paper with the IRS/SSA, e.g., Copy A and associated 1096 / W-3 / 1042-T transmittal.
   - Uploaded—Indicates records have been uploaded to the 1099 Pro Service Bureau for filing.
   - E-Filed—Indicates records have been electronically filed (mag media) with the IRS/SSA.

10. At the Confirm, Test and/or Begin Import Process screen users can test their import file for potential errors or warnings. If errors or warnings are determined, users are encouraged to cancel the import and edit their import file as necessary. User cannot edit errors and save changes at this screen—this screen is a TEST MODE version of the Edit, Post and Abandon Records screen. Click "Finish" if satisfied with the import file and are ready to proceed to Step 2: Validate Data.

11. The Administrator prompts, "What do you want to do?".
• 1—Report: Select to review any errors or warnings in your import data and generate a report or correct them interactively.
• 2—Continue: Select to proceed directly to Import Wizard—Step 2: Validate Data.
• 3—STOP: Select to return to the Import Wizard at a later time.

Troubleshoot Import Issues
Microsoft Excel text files may create issues when assigning fields at the Specify Form Field Mapping screen. If 1099 Pro software generates "0" records in the Available Input Fields column, this is because the import file is "locked" in memory by Microsoft Excel—or similar application—across a network LAN or WAN. The user must force Microsoft Excel or similar application to release control over the text file to be imported. To solve this problem, follow the steps below:

• If working locally on an individual computer (not on a network): Close all instances of Microsoft Excel used to generate your text file for import. Rename the import file. Begin a new import process, starting with Step 1 above.
• If working on a network with your import file residing on another computer (such as a workstation or server): Close all instances of Microsoft Excel used to generate your text file for import. Copy the file from the server to a folder on your local hard drive. Rename the import file. Begin a new import process starting with Step 1 above. Verify with your Administrator you have the proper rights to carry out this task.

Step 2: Validate Data
Welcome to Step 2 of the Import Wizard! At this screen users validate and check their data for any potential errors or warnings.

Import Wizard—Step 2: Validate Data
The Edit, Post or Abandon Import Records screen allows users the opportunity to review individual import records PRIOR to posting them to the database. Users can edit or delete individual records OR abandon an entire import session. Eligible import records can also be edited—post import—at the Work With My Tax Forms screen. See TEST MODE below.

1. The Edit, Post or Abandon Import Records screen displays immediately after completing Import Wizard—Step 1: Import Data. The screen is also accessible via the Completed and In-Process Import Session screen for any import session with a "Loaded" or "Updated" status. Simply highlight the import session and click the "Continue with Session" button.

2. All import records in the selected import session are listed at this screen. Errors messages, if any, are detailed for each record. Review import column descriptors.

<table>
<thead>
<tr>
<th>Primary Identifier</th>
<th>TIN. If TIN is not present then Recipient Account Number, otherwise field is blank.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Identifier</td>
<td>Recipient Account Number. If Account Number is not present then the field is blank UNLESS the Primary Identifier field is blank, in which case this field contains Last Name/Company Name.</td>
</tr>
</tbody>
</table>
3. Double-click on any record to access the Update Records screen. Individual import record information is available here to view and edit.

<table>
<thead>
<tr>
<th>Data Field</th>
<th>The tax form specific fields; whether populated or not.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Value</td>
<td>Precise data values from the import file. For example, a raw value of &quot;750&quot; for a dollar amount box.</td>
</tr>
<tr>
<td>Import Value</td>
<td>Software imported data values. For example, an imported value of &quot;750.00&quot; for a dollar amount box—notice the dollar amount is auto-formatted during the import process.</td>
</tr>
<tr>
<td>Field Errors or Warnings</td>
<td>Lists any Reject errors including Missing Last/Company Name or non-allowed negative amounts. If the incorrect or missing data is corrected, the associated warning disappears after clicking the &quot;Save&quot; button.</td>
</tr>
</tbody>
</table>

4. Make edits in the corresponding Raw Value fields (double-click to open the field) and then "Save" to return to the main Edit, Post or Abandon Import Records screen. Notice that after data is corrected at the Update Records screen, the Status/Validation and Error Messages columns automatically update to reflect new values.
5. Users can continue to 1) "Change/Fix" selected records and/or 2) "Delete/Remove" selected records and then "Post the Session" to complete the import and bring eligible records into the software. Eligible records may contain either No Errors, Warnings and/or Errors; however records with Reject Errors are not eligible for import. Records imported and posted with errors have an asterisk (*) prefixed to their status at the Work With My Tax Forms screen. For example, *Pending or *Filed. Review Errors and Warning.

- Alternately users can opt to "Abandon This Session" and discard all records in the import, regardless of their Status/Validation.

6. A standard installation of most 1099 Pro software products allows up to 5,000 transactions. If the combined total of existing records in the database and imported records exceeds 5,000, the import may abort. To handle more than 5,000 transactions purchase a Bump Code via Sales at (888) 776-1099.

7. Proceed to Import Wizard—Step 3: Post Results.

TEST MODE—Edit, Post or Abandon Import
The Import Wizard—Step 1: Import Data contains a TEST MODE version of the Edit, Post or Abandon Import Records screens. In TEST MODE, users can select the "Test My Import for Problems" button to perform a test import on up to 250 records. The Test Import Result window displays any errors and warnings. Select any record and click "Change/Fix selected record" to view data. Changes to import records are not saved in TEST MODE. Use TEST MODE as an opportunity to quickly verify your data and determine if you want to continue or abandon with this import session.

Step 3: Post Results
Welcome to Step 3 of the Import Wizard! At this screen users post their data into the software. Users importing very large import files should consider optimizing the post process.

Import Wizard—Step 3: Post Results
1. Access the Post Import Wizard:
   - Continue directly from the Import Wizard—Step 2: Validate Data and select "Post This Session", OR
   - At the Preparing My Forms task panel select the "Import New Tax Forms" link. At the Completed and In-Process Import Session screen highlight any import session with a "Loaded" or "Partial" status and click the "Continue with Session" and then the "Post This Session" buttons.

2. At the Post Import Wizard click "Next" to continue, go "Back" at any time.

3. If any records in the session contain errors or warnings, the user must decide how to handle them. Options include:
   - Do not post records with errors: (Recommended!) Records without errors are posted and problem records are placed on "hold" to be fixed at a later time.
   - Post records with Warnings/Errors: Post all records now. Review individual records and manually update these fields at a later time at the Work With My Tax Forms screen.
4. Specify how to deal with existing Recipients in the 1099 Pro software database. Options include:
   - Match forms with existing Recipients, but do not update addresses
   - Ignore existing TINs, add every Recipient as new
   - Update the incoming tax form with my current Recipient information
   - Update my Recipient information with new information from the tax forms (default selection)

5. Specify the Import Form Source (Corporate Suite only).

6. Review settings and click "Finish" to post your import session. Your imported records are available to view and/or edit at the [Work With My Tax Forms screen.
   - See [Import Session Summary Report]
   - See [Print Wizard]

**Import Session Summary Report**
The Import Session Summary (or Amount Totals Report) details all records in the selected import session. See [Reset/Void Import Session]

**Run Report**

2. At the Completed and In-Process Import Sessions screen highlight an import session and select the "Amount/Totals Report" button.
   - The "Amount/Totals Report" button is ghosted and unavailable for any session with a status of Abandoned or Reset/Void.

3. The Report Options screen prompts to:
   - Select the Printer—Consider printing to PDF to save paper.
   - Select the Sort Order—By Last Name/First Name or by TIN.
   - Preview before printing.
   - Print Summary totals only.

4. Click "OK" to generate the report or "Cancel" to exit the report.

**Custom Import Maps**

**Delimited/Excel Custom Import Maps**
All 1099 Pro software products offer custom Import Wizards to simplify the process of creating Delimited/Excel. 1099 Pro's standard Import Wizard and [sample import files] are sufficient for most users; however some users require the ability to add additional fields or apply special formatting to TINs, dates or decimals. See [Import Map Report]

**Create Delimited/Excel Import Map**
Import files can be imported in a variety of formats including; delimited, .CSV, Tab-Delimited, Pipe-Delimited, Fixed Length, and Excel (XLS or XLSX).

2. At the Import Sessions screen click the "Import Records from Excel or a Delimited Text File" button.

3. In the Import Wizard continue to the Select the Type of Data and Format to Use screen. Click the "Add/Update Import Maps" button.

4. At the Manage Tax Form Import Maps screen click the "Add" or "Change" button and select Excel or Delimited as import format.
   - To delete an import map, highlight the map and click the "Delete" button.
   - If header records in an import file are changed, the user must either modify the existing map or create a new map that reflects those changes.
   - The following columns define an Import Map: Map Type, File Format, Status and Description. The description column gives details about the currently selected import map and the Map Notes window to the right provides additional information.

5. The Excel Import Wizard opens. Continue as prompted to the Map the Import Fields/Columns to Data Fields. Options include:
   - Map By Name—Use the "Map by Name" button to automatically map all fields with matching names. To cancel a Map by Name use the "Reset/Clear the Map" button. See Combined Address Mapping below.
   - Drag & Drop Fields—Manually match each field from the input file on the left to the corresponding tax form field on the right by dragging and dropping. Repeat process until all needed fields are assigned. To cancel a match, drag from right to left or double-click on it. See Combined Address Mapping below.
   - Assign Value—Assign a fixed value to the selected unmapped field. For example, for the "Rcp TIN Type" field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported recipients have an identical recipient TIN type.

6. Combined Address Mapping:
   - If your import file uses a Combined City/St/Zip import field instead of the individual City, State and ZIP fields, drag the import field to the Comb City/St/Zip input field—do NOT drag it to the individual City, State and Zip fields. If using the Address Delivery/St and Address Apt/Suite import fields, drag them to their respective input fields. Performed correctly, Address Delivery/St± appears at the Address Delivery/St input field only. The plus sign indicates Address Lines 1 and 2 have merged for a successful mapping. Drag or map by name all other fields as normal.

6. At the Default Field Size and Format Options screen select below options and click "Next" to continue:
   - Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount, e.g., "10000" = "100.00" in implied decimals. The use of the implied decimal format in delimited file formats is rare.
   - Select date field format options - Various options are available. Indicate if date uses four years, i.e., XXXX, and if date includes separators.

7. At the Set Recipient Matching Options screen choose how the software matches imported records with existing Recipients and/or tax forms. Options include:
Matching Recipients with a TIN
  o TIN plus Account Number
  o TIN plus Last Name (use only if account numbers are unavailable or inconsistent)

Matching Recipients When TIN is Missing/Blank
  o Account and then Last Name (default option)—Looks for account numbers first, then matches for Last Name for the Account.
  o Account plus a blank/missing TIN—Use when TIN/Account Number are the only identifying fields in the field (no name information is provided).
  o Last Name and then Account—Looks for the Last Name first, then matches for Account Number for the Recipients.
  o Last and First Name (use if account numbers are unavailable or inconsistent)—Account numbers are NOT used to match for Recipients.

8. At the Specify a Name and Usage Notes for the Import Map screen enter a descriptive title for this map. Users can also add usage notes for further clarification. Click "Next" to continue.

9. At the Set Options for Locating Your Import Files screen review options and click "Next" to continue.
   - Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
   - Users can optionally specify a default file name.

10. Specify the Type of Import: (Corporate Suite Only)

11. Review summary settings and click "Finish". The Administrator indicates if the import map was successfully created. Users may opt to import the data used to create this map by clicking the "Yes" button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.

Generate Account Numbers
Most 1099 Pro software products include a wizard to generate account numbers for eligible forms missing this information.

Per IRS. Pub. 1220: The account number is required if there are multiple accounts for a recipient for whom more than one information return of the same type is being filed. This number will identify the appropriate incorrect return if more than one return is filed for a particular payee. Do not enter a TIN in this field. A payer’s account number for the payee may be a checking account number, savings account number, serial number, or any other number assigned to the payee by the payer that will distinguish the specific account. This number must appear on the initial return and on the corrected return for the IRS to identify and process the correction properly.

Per IRS Pub. 1187: Financial institutions reporting amounts paid to direct account holders with respect to an account maintained by institution at a U.S. office or U.S. branch, must report the recipient(s) account number.
Why Generate Account Numbers?
The IRS requires account numbers in many instances and for all corrected forms. The Generate Account Number wizard creates unique Account Numbers for eligible tax forms to satisfy this requirement. It is a smart business practice to populate the account number field on ALL forms.

- Only forms with a status of Printed or Pending are updated.
- Any form with existing Account information is NEVER overwritten, regardless of status.
- Users can manually replace generated account numbers at any time before filing with the IRS/SSA.
- The Account Wizard algorithm is the first two letters of the Recipient’s last name, the IRS form code and a number unique to that form. For example, one might look like this SM-M-0001234.

Account Number Generation Wizard
This wizard is accessible via the menu bar > Utilities > Generate Account Numbers and is also available during many processes including importing, print, uploading and electronic filing. This wizard will create a unique account number for all Pending and Printed records without an account number—existing account numbers are never overwritten.

Generate Account Numbers
1. In the Account Number Generation Wizard review important onscreen information. Click "Next" to continue, go "Back" at any time.
2. Choose a method for selecting eligible tax forms. Options include:
   - ALL Forms for ALL Filers: This option automatically selects every eligible form for all Filers.
   - Selected Form Types for ALL Filers: This option prompts to manually select form types to include in this process. All Filers are processed.
   - Selected Form Types for Selected Filers: This option prompts to manually select the Filers and the form types to include in this process.
3. Review settings and click "Finish" to generate account numbers.
4. The Administrator indicates:
   - Total Forms Scanned
   - Total Forms Without Account Numbers
   - Number of Forms Updated with new Account Numbers

Check Error Status for Forms
Use the Error Scan Wizard to check current year tax forms for any errors or warnings. Based on the volume of records in your Corporate Suite installation and the Filer and form options selected, this process can be time consuming. This wizard generates a detailed Error Scan Report.

Error Scan Wizard
1. On the menu bar select Utilities > Check/Update Error Status for All Tax Forms.
2. In the Error Scan Process Wizard review onscreen information and click "Next" to continue, go "Back" at any time.
3. Choose how forms will be selected for error scan:
   - All Forms for ALL Filers (default)
   - Selected Form Types for ALL Filers
- Selected Form Types for SELECTED Filers

4. At the Ready to Begin the Error Scan Process screen click "Finish" to initiate the scan.

5. After the scan is completed the Select the Error Level window allows users to select the following options: Rejects, Errors, Warnings and OK.

6. Click "OK" to view the report.

Registration & Upgrades

Software Activation
To activate a "DEMO" version of software, users must enter their 14 character Authorization code. Activating a demo provides access to all software features and retains existing data. Purchase the software online or contact Sales to obtain your code.

Activate Software
1. On the menu bar select Utilities > Registration And Upgrades.
2. At the Product Registration/Demo Activation screen enter your Authorization Code and click the "Activate Now" button.
3. If your code does not work, please verify the correct version of the purchased software is installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation.

Purchase an Authorization Code

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Online</td>
<td>New customers can go to <a href="https://www.1099pro.com/products.asp">https://www.1099pro.com/products.asp</a> to purchase software. Renewal customers can go to <a href="https://www.1099pro.com/prodRenewals.asp">https://www.1099pro.com/prodRenewals.asp</a> to renew software.</td>
</tr>
<tr>
<td>Phone</td>
<td>Call Sales toll-free at (888) 776-1099, Monday to Friday, 7AM to 5PM PST. International customers can call Sales at (818) 876-0200.</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:Sales@1099pro.com">Sales@1099pro.com</a></td>
</tr>
</tbody>
</table>

Transaction Limits (Bump Codes)
Transactions are the number of actual tax forms that can be entered or imported—regardless of record status—into 1099 Pro, 1042-S Pro, W-2 Pro or 8966 Pro. A standard installation allows for 5,000 transactions. To enter additional transactions users must upgrade their software installation with a bump code. Bump codes can be purchased online at www.1099pro.com or by contacting Sales at (888) 776-1099.

In multi-user environments, the Bump Code must be entered at the Admin or Web Update workstation; this option may not be available at individual work stations (depending on access rights).

Upgrade Transactions
1. On the menu bar select Utilities > Registration And Upgrades.
2. Enter your Upgrade/Bump Code and click "Upgrade Now". Newly entered Bump Codes are immediately reflected in the Current Record Limit.
How Many Transactions Do I Have?

To track records or transactions, refer to the Product Registration/Demo Activation screen:
1. On the menu bar select Utilities > Software Registration/Demo Activation.
2. The Product Registration/Demo Activation screen displays both the Current Record Limit and Current Record Total.

In this example, 236 out of 5,000 transactions have been used.

Ch. 5 Task Panel Items

Select Filer

The currently selected Filer—including Name, TIN, PCode and Location Code—is always displayed at the top of the Select Filer box. Use the "Select Another Filer" button, located at the top left of the task panel, to quickly switch Filers.

Select a Filer

1. On the task panel click the "Select Another Filer" button.
2. At the Browse the Filers File screen highlight a Filer and click "Select".

Manage Filers

On the task panel click the "Manage" button to access the Filer Master List screen.

Preparing My Forms

Work With My Tax Forms

The Work With My Tax Forms screen serves as the primary place to view, edit and track your records. Users are encouraged to familiarize themselves with it now—prior to the onset of tax season.

Work With My Tax Forms Overview

Access the Work With My Tax Forms screen via the Preparing My Forms task panel > Work With My Tax Forms. The Work With My Tax Forms screen allows users to view ALL forms, sort them by
default options or create a custom query. From this screen users can Add, Change, Delete, Quick-Print and Email individual records plus initiate Group Actions.

**Viewing Options**

<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Sort/View Order</td>
<td>Users can sort forms by Last Name/Company, TIN, Account or by creating a custom view. See <a href="#">Current Sort/View Order</a> for further details. Scroll through results with the mouse or the keyboard UP/DOWN arrow keys.</td>
</tr>
<tr>
<td>Current Query/Filter</td>
<td>By default all forms are displayed. Users can display a subset of the current form type via the &quot;Current Query&quot; drop menu and select a prebuilt query, e.g. &quot;Filed Corrections Only&quot; or create their own custom query, e.g. &quot;Tax State = CA, Corrected Forms Only&quot;, etc.</td>
</tr>
<tr>
<td>Status Column</td>
<td>This column indicates an individual record's position in the filing cycle and is an invaluable reference tool. A record’s Status is directly tied to its position in the filing cycle. See <a href="#">Status Overview</a>.</td>
</tr>
<tr>
<td>ACA Custom Queries (CS Users Only)</td>
<td>Corporate Suite includes ACA (Forms 1095-B and 1095-C) specific queries to easily sort AIR records and search for dependent related information.</td>
</tr>
</tbody>
</table>

**Onscreen Buttons**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Add&quot;</td>
<td>Use to manually add individual records; most users prefer to import their records. All 1099 Pro software products allow records to be added (either manually or via import) up to the user's current transaction limit. Transactions can range from 5,000 in a standard purchase to an unlimited number of transactions. See <a href="#">Add a Record</a> and <a href="#">Registration &amp; Upgrades</a> for more information.</td>
</tr>
<tr>
<td>&quot;Change&quot;</td>
<td>Use to change or edit any record with a Pending status; records with any other status are &quot;protected&quot; (locked) and cannot be changed. See <a href="#">Protected Forms Options</a> screen and <a href="#">Correct a Record</a>. Cascading updates are changes made to a Filer and/or Recipient's information globally throughout all tax forms. See <a href="#">Change a Record</a> and Cascading Updates</td>
</tr>
<tr>
<td>&quot;Delete&quot;</td>
<td>Use to delete any individual record with a Pending status; records with any other status are locked and cannot be deleted. To delete records in batch see</td>
</tr>
<tr>
<td><strong>Group Actions</strong>&lt;sup&gt;86&lt;/sup&gt;</td>
<td>See [Delete a Record]&lt;sup&gt;83&lt;/sup&gt;</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>&quot;Browse by Form&quot;</strong></td>
<td>The &quot;Browse by Form&quot; button allows users to initiate browsing tax forms using the update form. This allows the user to quickly move from form to form while viewing all of the data for each form. When using Browse by Form, the current view and Query settings remain in effect, just as when using using the standard browse. For example, if when viewing the list of forms in Last Name/Company order, with a Query to only show forms that contain Notes, those settings remain in effect when switching to Browse by Form mode. See [Browse by Form]&lt;sup&gt;76&lt;/sup&gt; for further instructions.</td>
</tr>
<tr>
<td><strong>&quot;Group Actions&quot;</strong></td>
<td>Use to tag (or select) a number of records and perform a single action on them. In all cases, users are prompted to confirm their choice before the action is taken. For example, deleting a group of Pending forms allows you to manually select any number of Pending forms for removal. All associated notes for the forms are likewise deleted. See [Group Actions]&lt;sup&gt;86&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>&quot;Quick-Print&quot;</strong></td>
<td>Use to quickly print an individual tax form, regardless of print status. Simply highlight the form, select &quot;Quick-Print Form&quot; and choose your print options. See [Quick-Print]&lt;sup&gt;88&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>&quot;Email Tax Form&quot;</strong></td>
<td>Use to email individual tax forms to Recipients. Requires a default mailing client for your computer. See [Email Tax Forms]&lt;sup&gt;97&lt;/sup&gt;</td>
</tr>
<tr>
<td><strong>&quot;Print/View Report&quot;</strong></td>
<td>This report is based on the currently selected query (if the default query, All Records, is chosen, then the report is identical to the Control Totals report). See Print/View Report</td>
</tr>
<tr>
<td><strong>&quot;Custom Report&quot;</strong></td>
<td>Use to create and save Custom Query reports. Visibility to these reports can be limited by User by the Administrator.</td>
</tr>
</tbody>
</table>

**Browse By Form**

The Work With My Tax Forms screen allows users to browse through tax forms of the same form type and Filer. This allows the user to quickly move from form-to-form and view data.

**Browse By Form**

1. On the task panel select > Preparing My Forms > Work With My Tax Forms.
2. At the Enter, Update and View screen select the individual form to start browsing.
3. Click the "Browse By Form" button located at the bottom center of the screen.
   - Use the **PageUp** ("pgup") and **PageDown** ("pgdn") keys to move forwards/backwards through the forms.
• If a form has a protected status (Printed, SB Filed, MagMedia, etc.) users may only VIEW the form.

• Forms with a Pending status are available for EDITS. To continue browsing forms after making changes to a Pending form, simply press the PageUp/PageDown keys to continue.

4. To exit the Browse By Form feature use the Escape ("esc") key on your keyboard or click the "Cancel" button on the tax form.

Note: When using Browse by Form, the current View and Query settings remain in effect, just as when using the standard browse. For example, if viewing the list of forms in Last Name/Company order, and have a Query to only show forms that have Notes, you will still see only forms that have notes, in Last Name/Company order, when switching to Browse by Form mode.

Entry Form

Entry forms are used to add, edit or view individual Recipient records. All 1099 Pro software products allow up to 5,000 records (or "transactions") in a standard installation; additional transactions can be purchased via Bump Codes.

Tax Form Overview

<table>
<thead>
<tr>
<th>Function / Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigating Fields / Filling In Boxes</td>
<td>Use the &lt;TAB&gt; key to move forward through fields. Use the &lt;TAB&gt; + &lt;SHIFT&gt; keys to move backwards through fields. Select or deselect a checkbox via the spacebar, then &lt;TAB&gt; to the next field.</td>
</tr>
<tr>
<td>Edit Fields</td>
<td>Make necessary changes, additions or deletions to the form and click the &quot;Save&quot; button to exit and return to the Work With My Tax Forms screen. <strong>Edit TIN Type</strong> — To change an SSN to an EIN or an EIN to an SSN, highlight the entire TIN and select the &lt;DELETE&gt; key on your keyboard. Then enter the new TIN with the appropriately placed dashes.</td>
</tr>
<tr>
<td>Correct Fields</td>
<td>Only records with a Filed status are available to correct. Any changed values or amounts turn blue to distinguish between original and corrected information. <strong>Note:</strong> When generating a correction the IRS stipulates that the account number on the corrected form remain identical to the one on the original form. See <strong>Correct a record</strong></td>
</tr>
<tr>
<td>Data Lookups</td>
<td>All 1099 Pro software products allow users to select existing Recipients from the Recipients Master List (database) at any tax form. To access this information at any data entry screen place your cursor in the Recipient TIN field and select the &lt;F2&gt; key or right-click your mouse. The Select a Recipient screen appears with ALL Recipients for ALL Rilers available for selection.</td>
</tr>
<tr>
<td>Protected Forms</td>
<td>Forms with any status besides Pending are protected (or locked) to prevent any mismatch of data from the original record that has been printed and/or filed. Protected forms include records with a status of Printed, Filed, SB Print+Mail, SB Filing, Mag Filed, etc. <strong>Only forms with a Pending status can be changed or deleted.</strong> If a form was imported with a status other than Pending, it is protected until its associated import session is Reset (VOID).</td>
</tr>
<tr>
<td>Function / Button</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>&quot;Audit Trail&quot; Button</td>
<td>View all prior changes made to a form via the &quot;Audit Trails&quot; button. This screen tracks all manual changes made directly to a record.</td>
</tr>
<tr>
<td>&quot;Notes / Has Notes&quot; Button</td>
<td>View/add notes associated with this tax form or Recipient. See <a href="#">Browse Notes</a>.</td>
</tr>
<tr>
<td>&quot;Preferences&quot; Button</td>
<td>View/modify default data entry preferences for address formatting.</td>
</tr>
<tr>
<td>&quot;Check&quot; Form Button</td>
<td>Use to check form for common errors or warnings.</td>
</tr>
<tr>
<td>&quot;Save / Cancel&quot; Buttons</td>
<td>Use the &quot;Save&quot; button to immediately save form changes or use the &quot;Cancel&quot; button to abandon changes and exit the screen.</td>
</tr>
<tr>
<td>&quot;State&quot; Button</td>
<td>By default a Recipient's tax state is 1) their Tax Withholding State (if any), or 2) their mailing address State. Use this button to override the default Tax State with an alternate Tax Withholding State. <strong>IMPORTANT: You cannot override a field specific tax state (for example, Form 1099-MISC, Box 17).</strong></td>
</tr>
</tbody>
</table>
| "TIN Validation" Button (Requires active TINCheck.com account) | Use to validate your Recipient information against the following lists:  
- **TIN Validation:** This verification process, for both EIN and SSN numbers, ensures that payers file accurate payee TIN/Name combinations reducing or eliminating yearly IRS TIN/Name discrepancy penalties (B-Notices, CP2100(A)s, 972CGs).  
- **(DMF) Death Master File:** The DMF is a continually updated list of all known deceased individuals. It is used by the financial industry as well as government agencies to prevent identity fraud.  
- **(SDN/OFAC) Specially Designated Nationals (SDN/PLC) Office of Foreign Assets Control (OFAC):** Unlike IRS penalties for TIN/Name discrepancy, payers neglecting to verify the Office of Foreign Assets Control (OFAC) lists open themselves up to civil as well as criminal penalties. |
| "Transactions" Button (Corporate Suite Only) | Use to view all aggregated amounts included on this tax form. |
| Optional Grouping/Filtering Fields | Users can populate these optional fields at their discretion and then use the Custom Query wizard to sort records. Corporate Suite Only offers significantly enhanced features. |
| Groups of Forms | **Group Actions** allows users to select any number of Recipients, and then loop through the list creating new forms for them. The program automatically populates the Recipient information on each new form; only the specific dollar amount fields must then be entered. For additional flexibility, users can add the forms by name, TIN, State or ZIP sort order.  
1. On the Work With My Tax Forms screen select the "Group Actions" button.  
2. Select the Add tab, then click the "Proceed With This Action" button. |
### Function / Button | Description
---|---
3. | On the next screen, select (or tag) all of the Recipients you want to add blank forms.
4. | Next select the "Sort" order in how these form will be placed.
5. | Finish by filling out all information for each form and clicking "Save".

### Audit Trails
The Record History screen displays audit trail information for the selected tax form and is available to all Access Groups. A limited version of the Master Audit Trail Browser, this screen tracks all manual changes made directly to a record. Cascading updates are not reflected.

Use the spyglass icon in the upper-right corner to view any Notes associated with this record.

### Notes
Users can add notes to individual tax forms, Recipient records and Filer records. Notes can contain up to 512 characters and unlimited notes are allowed. Every time a note is created or updated, the note displays the date and time of the action and either the User ID of the person who made the change (assuming Security is enabled) or the network name/ID of the machine where the change was made.

Depending on the type of note, users can view and update them from multiple places within the software. At a tax form data entry screen, if there are any notes associated with the Recipient, Filer or the specific tax form the "Notes" button changes to "Has Notes".

### Global Notes
Global notes are visible everywhere within the program, these notes can be viewed and updated from every Notes browse. Users can also enter these notes directly from the main File menu via the 'Global Notes' option.

### Filer Notes
Filer notes are associated with a specific Filer, and are only available on the update form for that Filer. When entering notes for a Filer, you can also view/update all Global notes.

### Recipient Notes
Recipient notes are associated with the individual Recipient, and can be viewed and/or updated from both the Recipient update form and from every tax form associated with that Recipient. When entering notes for a Recipient, you can also view/update all Global notes.

### Tax Form Notes
This type of note is attached to one specific tax form for one Recipient. When entering notes for a tax form, you can also view/update the notes for the Recipient and Filer of the form, as well as view/update all Global notes.
Tax Reporting State
By default, a record’s tax state is either 1) identical to the state withholding (e.g., Box 17 on Form 1099-MISC), or 2) the Recipient’s state in the address field. On occasion Filers might need to override the default state. Use the "State" button on any tax form entry screen to view the default state and change it as necessary.

Data Entry Preferences
Users can set their own data entry preferences via the "Preferences" button.

Date entry options include:
- First Name, then Last Name/Company (default) OR Last Name/Company, then First Name.
- Delivery/Street, then Apt/Suite/Location OR Apt/Suite/Location, then Delivery/Suite. Please note that the USPS requests the Apt/Suite line in US addresses prints above the Street Address line. Accordingly, all US addresses are formatted to print in that order, regardless of the data entry option selected here.

Protected Forms Options
Use the Protected Forms Options screen to view a "protected" record, create corrections and display a history of record changes. Records with any status besides Pending are "protected" from edits. See Record Status Overview

Initiate Correction
Most records at the Work With My Tax Forms screen with an SB Filing, Mag Media or Filed 1096/W-3/1042-T status can be corrected. See About Corrections—An Overview

1. Highlight the record and click the "Change" button.
2. At the Protected Form Update Options screen click the "Create Correction" button. See Correct a Record
3. Return to the Protected Form Update Options screen after completing and saving the correction. Use the "Close" button to exit the screen and return to the Work With My Tax Forms screen where the Original, Corr/Pending and Zero/Pending (if applicable) records can be easily viewed and Quick-Printed.

Protected Form Update Options screen
Use this screen to access protected records for viewing, reprints or initiating corrections.

1. At the Work With My Tax Forms screen highlight any "protected record" (i.e., effectively any record except those with a Pending status).
2. Click the "Change" button to access the Protected Form Update Options screen.
   - Use the "Field Update History" button to view a record’s history of changes.

Select Departments
All tax form entry screens allow users to easily change the current Filer’s department phone number.
Select Department
In the Filer field on any displayed tax form, select the down arrow to display available contacts. Select a contact and "Save". The tax form displays the newly selected phone number and department ID. The tax form prints the department phone number only; the ID, name of the department and contact person do not print.

Modify Department Contacts
Contacts can be added or changed as described in Filer Record Details.

Select Recipient Account Number
If issuing multiple forms to the same Recipient it is common to have multiple account numbers associated with them. Recipient specific account number information is stored in the Recipient Master List database.

Select Recipient Account Number
In the Account Number field on any displayed tax form, use the <F2> key or right-click your mouse to display all account numbers associated with the Recipient. Highlight an account number and click "Use Selected Account" or double-click the account number.

Optional Field Filters
All 1099 Pro software products allow users the ability to query records by optional field filters. All sample import files and data entry screens include the optional Source, Category and Batch ID fields. Users can populate these fields at their discretion and then use the Custom Query wizard to sort records.

Current Sort/View
All 1099 Pro software products include built-in views that are tied directly to the "Search" field. To search for records by TIN the view must be set to "By TIN". Likewise, to search for records by name the view must be set to "By Last Name/Company" or "By Filer Name" as appropriate. Failure to properly set the view results in a failed search attempt. Views are available at select browse screens.

Search Field
1. Set view, for example, to "By TIN" and in the Search field enter at least the first digit of a TIN. Enter only the TIN digits, do NOT enter the TIN dashes.
2. Click the <TAB> key on your keyboard.
3. Scroll through results with your mouse or with the UP/DOWN arrow keys on your keyboard.

Custom Screen View
Users can create a customized view at the Work With My Tax Forms screen.

Define a Custom View
1. At the Work With My Tax Forms screen (AKA Enter, Edit & View) refer to the Current Sort/View drop menu and select "Custom View".
2. Select from the available fields on the left column and organize them in the column on the right. Available fields vary by software product and form type. Sophisticated users can click the "Advanced" button to rename column headers.

3. Move the position of these items in the order in which they appear by highlighting them individually via the UP/DOWN arrows to adjust it's position accordingly.

4. To save these changes click "Apply" or "Next" to define a sort order for the custom view. The software displays the "Select a sort order for the view" screen. At this point users can:
   - Use the default sort order.
   - Select a predefined sort order (fastest) which tells the software to use the built in predefined list; for example: Filer ID, Last Name/Company, First Names or by Filer ID, Recipient TIN, then Last Name/Company.
   - Define your own custom sort order (slowest) which allows the user to indicate what custom sort order the software should follow based on the custom field selections.

Add a Record

Most 1099 Pro software products allow up to 5,000 Recipient transactions (tax records); bump codes may be purchased at any time. Please watch our online How to Add a Form video tutorial.

Note: All 1099 Pro software products allow users to manually add individual records. Most users prefer to import data—including tax form and recipient information—thereby greatly reducing the need to manually add records. See Import Wizard [64]
2. At the Work With My Tax Forms screen select the "Add" button.
3. At the Adding a Form Record screen complete all fields and click "Save". The record is saved and a blank screen is presented for your next record. Click "Cancel" to exit the Adding a Form Record screen.

**Change a Record**

Only records with a Pending status are available for modification.

**Change a Record**

1. On the task panel select Preparing My Tax Forms > Work With My Tax Forms.
2. At the Work With My Tax Forms screen highlight the appropriate record and click "Change" (or double-click) to access the Changing a Form screen.
3. Make necessary changes and click "Save".

**Delete a Record**

Only records with a Pending can be deleted. Deleted tax records can be viewed at the Work With My Tax Form screen (see View Deleted Records below).

**Delete a Record**

1. On the task panel select Preparing My Forms > Work With My Tax Forms.
2. Highlight the record and click "Delete".
3. The Administrator prompts to confirm the deletion. Click "Yes" to delete the record or "No" to cancel.

**View Deleted Records**

Deleted tax records are available for audit trail purposes and can be viewed or reprinted. By default, the recipient copies of any deleted tax records that are reprinted have the phrase, "**DELETED FORM **" imprinted in the upper right corner of the document. Do NOT file deleted tax records with the IRS/SSA or state.

1. On the menu bar select File > Security and Administration.
2. At the Global Administrative Options screen select "Program Options" and "Preference, Update and Program Options" buttons.
3. At the Preferences screen, General tab, under Options for Manually DELETED Tax Forms check the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" box.
   - Corporate Suite Users: At the Preferences screen, Global tab, under Options for Manually DELETED Tax Forms select the "Allow Previously Deleted Forms to Be Visible on Tax Form Browses" checkbox.
4. Click "OK" to save changes.
5. Return to the Work With My Tax Forms screen to view deleted tax records.

**Correct a Record**

**Only forms that have been filed with the IRS/SSA are eligible to be corrected**, prior to filing with the IRS/SSA it is only necessary to change (or update) the form. All 1099 Pro software corrections must
typically be processed manually, one-by-one, at the Work With My Tax Forms screen. See About Corrections.

**As of Tax Year 2016**—De minimis corrections do not need to be printed or filed UNLESS the Recipient specifically requests it. Filers are no longer required to create corrections if the amount difference is $100 or less and $25 or less for any tax withheld box. See the IRS General Instructions for Certain Information Returns for specific details.

**Correct a Form**

1. On the task panel select Preparing My Forms > Work With My Tax Forms.

2. At the Work With My Tax Forms screen highlight the record and click the "Change" button. *Only records with an SB Filed, Filed Mag or 1096 Filed status are eligible for corrections.*

3. At the Protected Form Update Options screen click the "Create Correction" button.

4. Users are presented with an unadjusted version of the record to correct. Click on any field to adjust and enter the revised value.
   - To change the TYPE of TIN delete the ENTIRE number and then enter it with the dashes placed as appropriate for an SSN or EIN.
   - Recipient mailing address changes can be processed as a correction for printing purposes; however, these types of corrections are only eligible for filing with the IRS if there is a change of STATE in the mailing address field. Records with a corrected CITY or STREET ADDRESS are automatically excluded from Corrected IRS files.
   - All fields with revised information values turn **BLUE**.
   - The bottom of the form includes a brief summary of any changes in the "Correction Type" box.
   - The Payer/Filer/Employer field is not available to correct at this screen. To correct this field please contact the Service Bureau for support.

5. When done with corrections click the "Save Form" button. The Protected Form Update Options screen displays with the ability to view the original form or the corrected form and to view its audit trail. Click "Close" to exit the Protected Form Update Options screen and return to the Work With My Tax Forms screen.
   - Depending on the type of correction made, records will have a "Corr/Pending" or "Zero/Pending" status.
   - Mail a copy of the corrected form to the Recipient (see Quick-Print), AND
   - File the correction with the IRS/SSA as soon as possible.

**Correct a CORRECTED Form (1099 Pro, 1042-S Pro and W-2 Pro Users)**

Use this process to correct an already filed corrected form.

1. First create a NEW record with the same information as the FIRST corrected return.

2. Update the record status to FILED. *This can be forced by creating a dummy Electronic Filing for it—make sure to select Manual Transfer at Step 3 (see image). Paperwork will print out after you click "Upload My File".* **Discard the paperwork and DO NOT POST the file to the Service Bureau FTP site** (or else your data will be double-filed with the IRS!).
3. Return to the Work With My Tax Forms screen and create a correction of the record as outlined above.

Correct a PRIOR YEAR Form
Corrections to prior year forms must be handled in the appropriate program year version. For example, a 2016 1099-INT correction must be created in 1099 Pro 2016. Users can send that correction to the Service Bureau for filing for a fee or contact the IRS at 1-800-TAX-FORM and request a Copy A and 1096 Transmittal for the appropriate tax year and form type. To electronically submit a prior year file directly to the IRS/SSA FIRE site, users must first manually edit the record. For information on manually editing a prior year correction please contact Technical Support at 888-776-1099.

Corrections—Special Circumstances
- **10 Day Window**—If an IRS file was submitted within the last 10 calendar days and an error is discovered in it, the Service Bureau may be able to contact the IRS and request the file be marked as "BAD". Based on the User's individual circumstances, the Service Bureau will instruct the User to either 1) submit a new Original file to the Service Bureau, or 2) submit a Replacement file to the Service Bureau. The Service Bureau charges $85 to take this action on behalf of the customer in addition to any Service Bureau processing fees.
- **Type 1 Only Corrections**—If corrections are Type 1 only (dollar field amount changes only—NO Name or TIN changes) the user can import a file and the Service Bureau may be able to manually edit the Original file and code it as a Corrected file. Contact the Service Bureau for specific guidelines, limitations and fees regarding this process.
8966 Pro handles three types of corrections:

- Amended—Process filed forms that were subsequently amended.
- Voided—Send voided forms that you individually marked as void.
- Corrected—Corrected Data is used for records being re-transmitted after the IRS has notified the sender of a problem with the file or underlying data. Only select Corrected Data if responding to an IRS request to correct the data (do not use for Decryption, XML or other file-level errors).

Effective TY 2016, corrections require reference to a unique RFID.

Change Data On a Previously Filed Form:
1. At the Work With My Tax Forms screen double-click on the appropriate recipient to access the Protected Form Update Options screen.
2. Click the “Correct/Amend/Void” button.
3. The Changing a Form 8966 Correction screen displays. Change record as necessary:
   - If this record should never have been sent in, click the VOID box and save the form. Then go to Create XML and generate a VOIDED XML file.
   - To change the values on a record, click the AMENDED box. Make changes and save the form. Then go to Create XML and generate an AMENDED XML file.
   - To re-transmit a file to the IRS because the IRS instructed you to do so, click on the CORRECTED box. Make changes and save the form. Then go to Create XML and generate a CORRECTED XML file.

Remember to use the IDES Packager and then transmit the corrected XML file(s) to IDES.

Group Actions
The "Group Actions" button is located at the bottom center of the Work With My Tax Forms screen and provides direct access to the following options:

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print PENDING Forms</td>
<td>Tag records with a Pending status and print them via the Quick-Print option. To print IRS Copy A forms and update the status of the forms from Pending to Printing, use the Print Tax Forms Wizard. Quick-Printing does not allow for the updating of a record’s status.</td>
</tr>
<tr>
<td>Reprint PRINTED or FILED Forms</td>
<td>Tag batches of PRINTED or FILED records and reprint them. To reprint individual records, regardless of status, use the Quick-Print option located at the Work With My Tax Forms screen.</td>
</tr>
<tr>
<td>ADD New Forms for Selected Recipients</td>
<td>Tag Recipients, and then loop through the list creating new forms for them. The program auto-populates the Recipient information on each new form, only the specific box information for the form must be entered. For additional flexibility, users may add the forms by the following sort orders: Name, TIN, State or ZIP.</td>
</tr>
<tr>
<td>Delete Pending Tax Forms</td>
<td>Tag Pending tax forms and delete them with one operation. All notes associated with the form(s) are also deleted.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RESET Printed Tax Forms Back to Pending</td>
<td>Tag forms with a Printed status and reset their status to Pending to make forms available for edits or deletions. The selected forms can belong to any print session.</td>
</tr>
<tr>
<td>VOID Printed Tax Forms</td>
<td>Tag forms with a Printed status and change their status to Void to prevent them from being filed. The selected forms can belong to any print session.</td>
</tr>
<tr>
<td>UN-VOID Tax Forms</td>
<td>Tag forms with a Void status, and reset their status Pending to make forms available for edits or deletions.</td>
</tr>
</tbody>
</table>

See [Tag Records](#) and [Record Status Overview](#)

### Tagging Records

All 1099 Pro software products include "tag" buttons to select individual records or ALL records. The "tag" buttons are available at various screens. An item is tagged or selected when a green check appears to the left of the item as illustrated below.

![Select specific files for the Bulk TIN Matching Upload process](#)

### Tag Key Functions

<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag</td>
<td>&lt;ALT&gt; + T</td>
<td>Select individual records.</td>
</tr>
<tr>
<td>Tag All</td>
<td>&lt;ALT&gt; + A</td>
<td>Select ALL records.</td>
</tr>
<tr>
<td>Untag</td>
<td>&lt;ALT&gt; + U</td>
<td>Deselect individual records.</td>
</tr>
<tr>
<td>Untag All</td>
<td>---</td>
<td>Deselect ALL records.</td>
</tr>
<tr>
<td>Flip</td>
<td>&lt;ALT&gt; + F</td>
<td>Reverse the selection of individual records.</td>
</tr>
<tr>
<td>Flip All</td>
<td>&lt;ALT&gt; + L</td>
<td>Reverse the selection of ALL records.</td>
</tr>
<tr>
<td>Prev Tag</td>
<td>&lt;ALT&gt; + P</td>
<td>Scroll backwards through selected records.</td>
</tr>
<tr>
<td>Next Tag</td>
<td>&lt;ALT&gt; + N</td>
<td>Scroll forwards through selected records.</td>
</tr>
</tbody>
</table>
Quick-Print

All 1099 Pro software products include a Quick-Print feature to quickly print individual records regardless of print status. Please visit https://www.1099pro.com/videos.asp and watch the "Using Quick-Print" video for a brief tutorial on this process.

To reprint a group of forms, regardless of print status or session, see Group Actions.
To reprint an entire print session, see Reprint Session.

Quick-Print
1. At the Work With My Tax Forms screen highlight any record and select the "Quick-Print Form" button to access the Print Options screen.
2. Select printer and click "Next" to continue.
   - PDF File Generation—Select a PDF driver such as Adobe PDF to quickly create a digital PDF copy of your tax forms. To protect sensitive data users are encouraged to password protect PDF files and save them to a location on their hard drive or network. See PDF Files
3. Select the paper type:
   - Blank Stock—Select this option to print the physical form and tax data directly to blank paper. Most users select Blank Stock and Combined Recipient Copies. Review Blank Paper options.
   - Preprinted Plain Paper Forms—Adjust margin alignment as necessary.
   - Pressure Seal/ACL—Some form types offer unique print layouts.
4. Select the copies to print. Available options are determined by type of paper selected in previous step.
   - Combined Recipient Copies is a smart choice to print all required Recipient copies and instructions on a single page. Must select Blank Stock as paper type.
5. Indicate your preview preference:
   - Ask me before processing each copy (default)
   - Yes, preview each selected copy type without asking me
   - No, send the forms directly to the printer without previewing them
6. Select the sort order to print forms (this field is unavailable in Quick-Print mode):
   - By Last Name/Company Name (default)
   - By TIN
   - By Zip Code (use to pre-sort mailings for the post office)
   - By State Abbreviation
   - By Account/Name
7. Advanced Options are only available for Recipient copies. Settings apply to this print run only. Options include:
   - Include a brief, standardized message on all forms
   - Force an "X" in the Corrected box on all forms. IMPORTANT: Forcing an "X" does not create a valid correction.
- Force an "X" in the Void box. Most forms do NOT have a Void box. **IMPORTANT:** Forcing an "X" does not void a form.
- Force "0.00" instead of blanks for all zero amounts
- Modify TIN Masking settings

8. Select the "Print Now" button or "Cancel" to exit the screen.

**Status Overview**

Every record at the [Work With My Tax Forms](#) screen is assigned a status reflecting its position in the filing cycle. This status assumes that YOU, the user, have successfully completed the associated filing process. For example, if you create a Service Bureau Upload File for Print+Mail, the record reflects an "SB Print+Mail" status at the Work With My Tax Forms screen **EVEN IF** the actual upload file is still in a "Pending" status at the Service Bureau Upload Sessions screen! It is your responsibility to ensure that you successfully complete all upload and/or filing tasks. Please see Filing Status—Am I Done?

<table>
<thead>
<tr>
<th>Record Status</th>
<th>Record Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pending</td>
<td>All records start with a Pending status. These forms are ready to be printed and/or filed. Users can view, change or delete the form. Print the form and/or file the form either to paper* on IRS/SSA Copy A, electronically or via the Service Bureau.</td>
</tr>
<tr>
<td>Printed</td>
<td>Records receive a Printed status after selecting &quot;I have printed and verified my red Copy A forms...&quot; at the last step of the Print Wizard. These records are ready to be filed either to paper* on IRS/SSA Copy A, electronically or via the Service Bureau. To modify a Printed record first reset its status to Pending.</td>
</tr>
<tr>
<td></td>
<td>- To reset the status for an individual record go to the Work With My Tax Forms screen, highlight the record, and click the &quot;Change&quot; button. At the Protected Form Update Options screen select &quot;Reset to Pending&quot;.</td>
</tr>
<tr>
<td></td>
<td>- To reset the status for a print session, go to the menu bar &gt; Reports &gt; Tax Form Print Sessions &gt; highlight the print session and click the &quot;Reset (VOID) Session&quot; button.</td>
</tr>
<tr>
<td></td>
<td>Records imported with a Printed status cannot be void, reset or delete; the entire import session must be reset.</td>
</tr>
<tr>
<td>Voided</td>
<td>Records have been voided. Users can view the form, unvoid the form or reprint the form. Void a record to retain data for possible future reference. Only records with a Printed status can be voided.</td>
</tr>
<tr>
<td>Deleted</td>
<td>Records have been deleted and cannot be un-deleted. Users can view the form. Only records with a Pending status can be deleted. Deleted records are visible at the Work With My Tax Forms screen only if that setting has been enabled at the <a href="#">Preferences</a> screen. See <a href="#">Delete a Record</a>.</td>
</tr>
<tr>
<td>Filed 1096/W-3/1042-T</td>
<td>Users can view the form, reprint the form or create corrections. See <a href="#">Delete a Record</a>.</td>
</tr>
</tbody>
</table>

*This status is not applicable to 8966 Pro users.*
<table>
<thead>
<tr>
<th>Record Status</th>
<th>Record Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To reset the status go to the menu bar &gt; Reports &gt; Form 1096 Filing Session &gt; highlight the print session and click the &quot;Reset (Void) 1096&quot; button.</td>
</tr>
<tr>
<td>Filed Mag</td>
<td>Records have been printed and filed electronically. Users can view the form, reprint the form or create corrections. To reset the status go to menu bar go to IRS &gt; Create IRS Electronic Files &gt; highlight the magnetic media session and click the &quot;Reset (Void) Session&quot; button.</td>
</tr>
<tr>
<td>SB Filing</td>
<td>Records have been submitted to the Service Bureau for IRS Filing. Users can view the form, reprint the form or generate corrections. To modify a record with this status reset the entire upload session to its original pre-upload status. Go to the task panel &gt; Filing My Forms &gt; Via the Service Bureau and at the Service Bureau Upload Sessions screen highlight the session and click the &quot;Reset (VOID) Session&quot; button. <strong>CAUTION</strong>—Do not reset any Service Bureau upload session with a &quot;Done&quot; status without first contacting the 1099 Pro Service Bureau! Resetting a completed upload in the software does NOT automatically cancel the upload file submitted to the Service Bureau.</td>
</tr>
<tr>
<td>SB Print+Mail</td>
<td>Records have been submitted to the Service Bureau for Print+Mail. Users can view the form, file the form either to paper* on IRS/SSA Copy A, electronically or via the Service Bureau, reprint the form or reset the entire upload session to Pending for edits. To reset the status for a Service Bureau Upload Session go to the task panel &gt; Printing My Forms &gt; Via the Service Bureau. At the Service Bureau Upload Sessions screen highlight the session and click the &quot;Reset (VOID) Session&quot; button. <strong>CAUTION</strong>—Do not reset any Service Bureau upload session with a &quot;Done&quot; status without first contacting the 1099 Pro Service Bureau! Resetting a completed upload in the software does NOT automatically cancel the upload file submitted to the Service Bureau.</td>
</tr>
<tr>
<td>Corr/Pending</td>
<td>Records have been corrected and are ready to be filed either to paper* on IRS/SSA Copy A, electronically or via the Service Bureau. Users can view the original or corrected form, reprint the original form and change or delete the corrected record.</td>
</tr>
<tr>
<td>Corr/Printed</td>
<td>Records have been corrected and are ready to be filed either to paper* on IRS/SSA Copy A, electronically or via the Service Bureau. Users can view the original or corrected form, reprint the original form. To edit the corrected records reset its status to Corr/Pending.</td>
</tr>
<tr>
<td>Corr/SB Filing</td>
<td>Records have been corrected and submitted to the Service Bureau for electronic filing. Users can view the original or corrected form, reprint the original or corrected form.</td>
</tr>
<tr>
<td>Corr/Mag</td>
<td>An asterisk indicates the record has errors and/or warnings associated with it.</td>
</tr>
</tbody>
</table>
Email Tax Forms

1099 Pro software products allow users to email a password protected, PDF version of a "Combined for Recipient" or "Pressure Seal/Alternate Combined Layout" version of the tax form.

Email Guidelines

- 1099 Pro software uses the default mailing client for your computer. Users without a default mailing client setup cannot send encrypted PDF documents directly through the 1099 Pro software. See No Email Client Detected below.

Email Tax Forms

Tax forms are emailed individually to recipients.

1. On the task panel select Preparing My Forms > Work With My Tax Forms.

2. At the Work With My Tax Forms screen highlight a Recipient and select the "Email Tax Form" button.

3. At the E-Mail an Encrypted Tax Form screen complete all fields.
   - **Step 1: Set the E-Mail Address** — This field is auto-populated if the Recipient's email address was included in your import file (using the "Rcp Email" column header). Otherwise the field is blank and the email address must be manually entered.
   - **Step 2: Encryption and Password Settings**
     - Encryption is by default set at AES 128-bit; a more secure setting requiring Adobe Acrobat 7 or higher. The encryption is how a complex file is transformed using an algorithm (called a cipher) to make it unreadable to anyone except those possessing special knowledge, usually referred to as a key. The higher the level of encryption used, the more difficult it will be for the wrong person to open should they attain the document. However, high levels of encryption also require more sophisticated software to open. Choosing too high a level of encryption may prevent your Recipient from being able to open the document.
     - The default password is based on the first five digits of the Recipient's TIN, a hyphen and the first five digits of their ZIP code, e.g., 12322-99999. The Recipient must enter this password before the tax form can be viewed. The following is automatically included in the body of the Recipient's email, "The password is the first 5 digits of your Taxpayer Identification Number (SSN or EIN), followed by a dash, followed by the first 5 digits of your mailing address zip code". The mailing address zip code is always the one on the Recipient's tax form. Users can alternately enter a password of their own selection.
   - **Step 3: Choose PDF Format**
     - Standard Combined (default)
     - Select a PS/ACL Layout — Allows for the selection of an Alternate Combined Layout or Pressure Seal formats.
   - **Step 4: Advanced Print Options**
     - Force an X in the "Corrected" box.
     - Force an X in the "Void" box (not available on all forms).
     - Print 0.00 instead of blanks for all zero amount fields.
4. Extra Options (for advanced users only)
   • Print Driver: Use to select a different printer/driver.
   • File Folder: By default the encrypted PDF is placed in a PDF directory in the installation folder for the software. To choose an alternate location use this button.
   • Preview PDF: Check to preview the encrypted PDF before it is sent. The user password is required.

5. Create PDF and email message: Click button to generate the encrypted PDF and attach it to an email using your default email client.

Email: No Email Client Detected
Users without a default email client, e.g., Microsoft Outlook, Mozilla Thunderbird, Gmail, may receive a warning that the email cannot be sent. The warning indicates where the PDF file will be saved, the email address and the email subject line. Users can open their existing email client and manually enter the information to email the form to the Recipient.

Set Outlook as Default Mail Client
1. On the Microsoft Outlook menu bar go to File > Options.
2. Under "Startup options" select the "Make Outlook the default program for Email" box and then click the "Default Programs" button.
3. At the next screen verify that the "MAILTO: URL" box is checked; if not click on the "Select All" box. Click on “Save” then “OK”
4. Go to your Windows Start button and type "Default App Settings". Set Outlook as your default email program.
5. Return to 1099 Pro software and email form to Recipient.

Custom Reports
The "Custom Reports" button is located at the bottom center of the Work With My Tax Forms screen for select 1099 Pro software products. Use this feature to generate customized reports with end of report options to tally totals. The report can be applied to one Filer or multiple Filers. Check the "Show Owner Items Only" box to make this report private and available only to its author.
Import New Tax Forms

The Import Sessions screen provides direct access to the Import Wizard. All 1099 Pro software products feature a powerful, intuitive wizard to simplify the process of importing your data. If you can access your data in Excel (or a similar product), you can import it into our software! Additionally, users can view upload sessions, reset/void uploads, complete pending uploads and view reports. Access this screen via the task panel > Preparing My Forms > Import New Tax Forms.

- See Sample Import Files and Import File Conventions—Review prior to creating your import file or using the Import Wizard.
- See Import Wizard

Import Session Considerations

- Import sessions are Filer specific. If an import session is not displayed, verify the correct Filer is selected.
- The "Imported" column indicates the number of records successfully imported into the 1099 Pro software database.
- The "Import Source File" column details the name of the import file.
- All import sessions are assigned a "Status" as detailed below.

Import Session Statuses

Every import session is assigned a status indicating its position in the import process. The import session status is different from the tax form status as assigned during the Import Wizard. The tax form status (e.g., Pending, Filed, Uploaded or eFiled) reflects the record's status and its availability for certain tasks at the Work With My Tax Forms screen.

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Imported*</td>
<td>All records in import file have been posted and processing is complete.</td>
</tr>
<tr>
<td></td>
<td>Records are available at the Work With My Tax Forms screen to print/view,</td>
</tr>
<tr>
<td></td>
<td>edit, file or delete.</td>
</tr>
<tr>
<td>Loaded</td>
<td>The import file has been loaded, but not fully imported into the software.</td>
</tr>
<tr>
<td></td>
<td>To complete the import process highlight the session and click the &quot;Continue with&quot;</td>
</tr>
</tbody>
</table>

See Sample Import Files | Import File Conventions — Review prior to creating your import file or using the Import Wizard.
### Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated</td>
<td>This import file has been imported and at least one of the records has been opened and saved (edits to the form). Re-applying validation, etc., also triggers this status.</td>
</tr>
<tr>
<td>Partial</td>
<td>Some records in the import file have been imported and some are still in a loaded status.</td>
</tr>
<tr>
<td>Imp/Disc</td>
<td>Some records in the import file have been Imported, others were deleted during the Post.</td>
</tr>
<tr>
<td>Abandoned</td>
<td>All records for the log were abandoned, none imported.</td>
</tr>
<tr>
<td>Reset/Void</td>
<td>A completed import was reset, removing the posted records from the database. Records only removed if their status has not changed since they were posted. Records that have had their status upgraded (e.g., Pending to Printed or Filed) are NOT removed.</td>
</tr>
</tbody>
</table>

### Reset (Void) Session

Highlight the import session to void. Only import sessions with an "Imported" status can be reset. A voided session cannot be un-voided. See [Reset/Void Import Session](#).

### Continue With Session

Highlight the session to import and select the "Continue with Session" button. To complete a pending import the user must validate and post their data. If import data contains errors and/or warnings, the user has the option to include or exclude those records in the post process. After successfully uploading the file, the "Status" column updates to "Imported" or "Partial" if only some of the records were imported. If some records in the import session are posted and other are abandoned, the "Status" column updates to "Imp/Disc" to indicate some records imported and some records discarded.

### Amount/Totals Report

Also referred to as the Import Session Summary, this report generates a log specific detail of an import file. The last page of this report includes Total Form Count, Number of Forms with Missing TINs, Box-By-Box Totals and a State Withholding Breakdown.

### Run Report

1. Click the "Amount/Totals Report" button.
2. User is prompted to select a printer; consider printing to PDF to save paper.
3. Select the Sort Order; by Last Name/First Name or By TIN
4. Other Report Options include:
   - Preview before printing
   - Print Summary totals only
   - Errors and Warnings only
Import Wizard Overview

All 1099 Pro software products include an Import Wizard to streamline the import process. The Import Wizard consists of three simple steps that can be quickly completed at one time or, complete the import at your leisure. Your data is not imported into the software until all three steps are successfully completed.

- See Sample Import Files — Review prior to initiating the Import Wizard.
- See Import Session Summary Report — Error and Validation Checking is automatically performed on all imports; thereby allowing users the opportunity to find and fix any problem records before importing into the software.

Import Wizard Overview

**Step 1: Import Data** — Begin the import process.
**Step 2: Validate Data** — Review your data for errors and warnings.
**Step 3: Post Results** — Post your imported data into the software, for access at the Work With My Tax Forms screen and other areas.

Step 1: Import Data, Filers or Recipients

*Welcome to Step 1 of the Import Wizard!* Users can import Data, Filers Only or Recipients Only (Corporate Suite feature) into the program. Imports eliminate the need to manually enter data, reduce data entry errors and save valuable time.

Import Guidelines

- All programs include sample import files.
- Prior to starting your import review Import File Conventions.
- Save your Excel data file in Text Tab Delimited .TXT format to preserve formatting.

Import Wizard—Step 1: Import Data

Please watch our online video, Importing Using Standard Maps, for a brief tutorial on this process.

1. On the task panel go to Preparing My Forms > Import New Tax Forms.

2. At the Start a New Import Process screen select the "Import Records From Excel or a Delimited Text File" button.

3. At the Import LOAD Wizard screen click "Next" to proceed. Use the "Back" button at any time.

4. Select the type of tax form or "FILERS" for a Filer only import. If working in a multi-user or network environment see Troubleshooting Import Issues below.
   - Indicate the Import File Format: Excel or Delimited
   - If your import file does NOT include Header Records, use the "Add/Update Import Maps" button to create a custom mapping. See Manage Import Maps and the Delimited Import Map Wizard.
5. The Tax Forms Revisions Notice appears for any form type with new tax year changes. Check the "I understand and agree" box to cancel the reminder for future imports to this form type. Click "Next" to continue.

6. At the Select the File To Import screen browse for your import file and click "Next" to continue.
   - Your selected import file should appear in the display box; the data may appear slightly offset.
   - **Data may NOT appear if** 1) the original Header Records were modified or renamed, 2) there is a blank row at the top of the import file or 3) there is a blank row between the Header Row and the start of your import data. Users should cancel the import and fix their import file. See [Import File Conventions](#)
   - If data is based on a sample import file and any columns or fields were manually deleted, users may receive a WARNING at the next screen indicating some expected fields are missing. Please review the screen carefully for instructions.

7. Select the Filer for the Import. By default the forms import to the currently selected Filer. Use the "Select a Filer" button to change as necessary.

8. At the View the Mapped Import Records screen scroll down to verify that data is correctly mapping. Use the "View Next" button to sort through actual records and see live data. If your data contains strange characters; see [Import File Conventions](#). Users can also verify the Data Type, File Format, and Process Type before proceeding. Click "Next" to continue.

9. Specify Import Status and click "Next" to continue. Most users select Pending status; only records imported with a Pending status are available for edits or filing.
   - **Pending** — Default status allows users to edit, print, file or delete records.
   - **Filed (Paper)** — Indicates records have been filed on paper with the IRS/SSA, e.g., Copy A and associated 1096 / W-3 / 1042-T transmittal.
   - **Uploaded** — Indicates records have been uploaded to the 1099 Pro Service Bureau for filing.
   - **E-Filed** — Indicates records have been electronically filed (mag media) with the IRS/SSA.

10. At the Confirm, Test and/or Begin Import Process screen users can test their import file for potential errors or warnings. If errors or warnings are determined, users are encouraged to cancel the import and edit their import file as necessary. User cannot edit errors and save changes at this screen—this screen is a TEST MODE version of the Edit, Post and Abandon Records screen. Click "Finish" if satisfied with the import file and are ready to proceed to Step 2: Validate Data.

11. The Administrator prompts, "What do you want to do?".
   - **1—Report**: Select to review any errors or warnings in your import data and generate a report or correct them interactively.
   - **2—Continue**: Select to proceed directly to **Import Wizard—Step 2: Validate Data**
   - **3—STOP**: Select to return to the Import Wizard at a later time.

**Troubleshoot Import Issues**
Microsoft Excel text files may create issues when assigning fields at the Specify Form Field Mapping screen. If 1099 Pro software generates "0" records in the Available Input Fields column, this is because the import file is "locked" in memory by Microsoft Excel—or similar application—across a
network LAN or WAN. The user must force Microsoft Excel or similar application to release control over the text file to be imported. To solve this problem, follow the steps below:

- If working locally on an individual computer (not on a network): Close all instances of Microsoft Excel used to generate your text file for import. Rename the import file. Begin a new import process, starting with Step 1 above.
- If working on a network with your import file residing on another computer (such as a workstation or server): Close all instances of Microsoft Excel used to generate your text file for import. Copy the file from the server to a folder on your local hard drive. Rename the import file. Begin a new import process starting with Step 1 above. Verify with your Administrator you have the proper rights to carry out this task.

**Step 2: Validate Data**

Welcome to Step 2 of the Import Wizard! At this screen users validate and check their data for any potential errors or warnings.

**Import Wizard—Step 2: Validate Data**

The Edit, Post or Abandon Import Records screen allows users the opportunity to review individual import records PRIOR to posting them to the database. Users can edit or delete individual records OR abandon an entire import session. Eligible import records can also be edited—*post import*—at the Work With My Tax Forms screen. See [*TEST MODE*](#) below.

1. The Edit, Post or Abandon Import Records screen displays immediately after completing Import Wizard—Step 1: Import Data. The screen is also accessible via the Completed and In-Process Import Session screen for any import session with a "Loaded" or "Updated" status. Simply highlight the import session and click the "Continue with Session" button.

2. All import records in the selected import session are listed at this screen. Errors messages, if any, are detailed for each record. Review import column descriptors.

<table>
<thead>
<tr>
<th>Primary Identifier</th>
<th>TIN. If TIN is not present then Recipient Account Number, otherwise field is blank.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Identifier</td>
<td>Recipient Account Number. If Account Number is not present then the field is blank UNLESS the Primary Identifier field is blank, in which case this field contains Last Name/Company Name.</td>
</tr>
<tr>
<td>Status/Validation</td>
<td>OK—Record complies with business rule validations (no obvious problems).</td>
</tr>
<tr>
<td></td>
<td>Errors—Record is imported BUT contains serious data flaws that may result in the record being rejected by the IRS/SSA.</td>
</tr>
<tr>
<td></td>
<td>Err+Warn—Record is imported BUT contains possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA.</td>
</tr>
<tr>
<td></td>
<td><em>Reject</em>—Record is not imported unless corrected. Triggered by Missing Last/Company Name or non-allowed negative amounts.</td>
</tr>
</tbody>
</table>
3. Double-click on any record to access the Update Records screen. Individual import record information is available here to view and edit.

<table>
<thead>
<tr>
<th>Data Field</th>
<th>The tax form specific fields; whether populated or not.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Raw Value</td>
<td>Precise data values from the import file. For example, a raw value of &quot;750&quot; for a dollar amount box.</td>
</tr>
<tr>
<td>Import Value</td>
<td>Software imported data values. For example, an imported value of &quot;750.00&quot; for a dollar amount box—notice the dollar amount is auto-formatted during the import process.</td>
</tr>
<tr>
<td>Field Errors or Warnings</td>
<td>Lists any Reject errors including Missing Last/Company Name or non-allowed negative amounts. If the incorrect or missing data is corrected, the associated warning disappears after clicking the &quot;Save&quot; button.</td>
</tr>
</tbody>
</table>

4. Make edits in the corresponding Raw Value fields (double-click to open the field) and then "Save" to return to the main Edit, Post or Abandon Import Records screen. Notice that after data is corrected at the Update Records screen, the Status/Validation and Error Messages columns automatically update to reflect new values.

5. Users can continue to 1) "Change/Fix" selected records and/or 2) "Delete/Remove" selected records and then "Post the Session" to complete the import and bring eligible records into the software. Eligible records may contain either No Errors, Warnings and/or Errors; however records with Reject Errors are not eligible for import. Records imported and posted with errors have an asterisk (*) prefixed to their status at the Work With My Tax Forms screen. For example, *Pending or *Filed. Review Errors and Warning screen.

- Alternately users can opt to "Abandon This Session" and discard all records in the import, regardless of their Status/Validation.
6. A standard installation of most 1099 Pro software products allows up to 5,000 transactions. If the combined total of existing records in the database and imported records exceeds 5,000, the import may abort. To handle more than 5,000 transactions purchase a Bump Code via Sales at (888) 776-1099.

7. Proceed to Import Wizard—Step 3: Post Results.

**TEST MODE—Edit, Post or Abandon Import**

The Import Wizard—Step 1: Import Data contains a TEST MODE version of the Edit, Post or Abandon Import Records screens. In TEST MODE, users can select the "Test My Import for Problems" button to perform a test import on up to 250 records. The Test Import Result window displays any errors and warnings. Select any record and click "Change/Fix selected record" to view data. Changes to import records are not saved in TEST MODE. Use TEST MODE as an opportunity to quickly verify your data and determine if you want to continue or abandon with this import session.

During the import process users can view loaded records and individually edit them prior to posting them into the 1099 Pro software database. Posted records are available in the software for viewing, printing and filing. Loaded records are in a suspended state and can be edited prior to posting or deleted. It is ideal to edit errors/warnings now, prior to posting an import file; however records can also be edited at the Work With My Tax Forms screen while in a Pending status.

**Update Loaded Import Record**

1. At the Edit, Post or Abandon Imported Records screen highlight any record with an error and click the "Change/Fix Selected Record" button.

2. At the Update Records screen data is displayed as follows:
   - Raw Value—The exact data from your import file.
   - Import Value—The data as it has been imported and will display in your records. For example, a dollar amount raw value of "700" has an import value of "700.00".
   - Field Errors or Warnings—Flags some critical errors such as Missing TIN. Review Warnings & Errors.
   - The Overall Tax Form Validation Errors and/or Warnings box lists ALL items with errors or warnings.

3. Click on any field in the Raw Value column, make changes and click "Save" to save all changes and exit the screen.
   - To enter or change a TIN make certain to correctly place hyphens.
   - To mark a check box use "1, x, X or Y"; otherwise leave the box blank.

**Step 3: Post Results**

Welcome to Step 3 of the Import Wizard! At this screen users post their data into the software. Users importing very large import files should consider optimizing the post process.

**Import Wizard—Step 3: Post Results**

1. Access the Post Import Wizard:
Continue directly from the Import Wizard—Step 2: Validate Data and select "Post This Session", OR
At the Preparing My Forms task panel select the "Import New Tax Forms" link. At the Completed and In-Process Import Session screen highlight any import session with a "Loaded" or "Partial" status and click the "Continue with Session" and then the "Post This Session" buttons.

2. At the Post Import Wizard click "Next" to continue, go "Back" at any time.

3. If any records in the session contain errors or warnings, the user must decide how to handle them. Options include:
- Do not post records with errors: (Recommended!) Records without errors are posted and problem records are placed on "hold" to be fixed at a later time.
- Post records with Warnings/Errors: Post all records now. Review individual records and manually update these fields at a later time at the Work With My Tax Forms screen.

4. Specify how to deal with existing Recipients in the 1099 Pro software database. Options include:
- Match forms with existing Recipients, but do not update addresses
- Ignore existing TINs, add every Recipient as new
- Update the incoming tax form with my current Recipient information
- Update my Recipient information with new information from the tax forms (default selection)

5. Specify the Import Form Source (Corporate Suite only).

6. Review settings and click "Finish" to post your import session. Your imported records are available to view and/or edit at the Work With My Tax Forms screen.
- See Import Session Summary Report
- See Print Wizard

**Optimize Post**
When posting very large import files, your 1099 Pro software may run out of RAM and terminate before the Post is complete. Users can modify their INI file to optimize the Post process according to the amount of RAM in the machine running the Post. By default, the Post pauses every 2,000 records to commit new records. Users can increase (or decrease) the number of records processed between commits to speed up the process. Only users importing large amounts of records should consider modifying the default value of 2,000 records.

**Optimize Posting**
1. Close your 1099 Pro software product.

2. In File Explorer go to the Admin folder for your software product, e.g., for 1099 Pro software go to C:\1099 Pro\Pro99T18 and open the Pro99T18.INI file. See Data Files for exact data paths and INI file names.
3. In the [System] section modify the Post Commit entry (do not enter a comma in the numeric value). This sample entry has the Post set to pause every 2,000 records. Users should experiment with their own numeric values. The entry should look similar to this:

```
[System]
PostCommit=2000
```

4. Save changes and exit the INI file.

5. Open your 1099 Pro software product and post your import.

**Import Files**

**Sample Import Files**

All 1099 Pro software installations include sample import files by form type and for Filers and Recipients (Corporate Suite Only). Successful users review our sample import files and incorporate our Header Records into their import files. This ensures an easy, map-by-name import. Please review our [Import File Conventions](#) and [Filer Specific Import File Conventions](#).

**Sample Import File Locations**

<table>
<thead>
<tr>
<th>Software Product</th>
<th>Default Import File Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1099 Pro Professional/Enterprise:</td>
<td>C:\1099 Pro\Pro99T18\Import\Sample XLS Files</td>
</tr>
<tr>
<td>Corporate Suite Only</td>
<td>Corporate Suite does not include sample import files; however these files can be easily accessed on the <a href="#">1099 Pro WIKI</a>.</td>
</tr>
<tr>
<td>1042-S Pro</td>
<td>C:\1099 Pro\Pr42ST18\Import\Sample XLS Files</td>
</tr>
<tr>
<td>W-2 Pro</td>
<td>C:\1099 Pro\ProW2T18\Import\Sample XLS Files</td>
</tr>
<tr>
<td>8966 Pro</td>
<td>C:\1099 Pro\Pro66T18\Import\Sample XLS Files</td>
</tr>
<tr>
<td>* All Software Products *</td>
<td>Import files for ALL 1099 Pro software products are available online via the <a href="#">1099 Pro WIKI</a> which also includes field specific details for all tax forms.</td>
</tr>
</tbody>
</table>

For customers not interested in using our Header Records or for information on importing other file types, see [Delimited or Excel Import Maps](#).

**Instructions for an Easy Import**

Review our sample import files PRIOR to creating yours and include our exact Header Records. Watch our [Importing Using Standard Maps](#) online video tutorial.

1. Open the Import\Sample XLS Files folder to view all available sample import files. Select and open the appropriate sample file, for example, "1099-MISC.xls" or "1042-S Sample Excel Import.xls".

2. Review the sample data and notice the formatting of the TINs, First and Last Names, Foreign Addresses, etc. Review our [Import File Conventions](#) thoroughly before continuing.
• All Excel files contain a second worksheet with form specific guidance on the various fields and data requirements.

3. Copy the "Header Records"—the top row of data containing the respective field names—onto a new Excel sheet. Then enter your live data into the appropriate fields.
   • Do not place a blank row between the Header Records and the start of your data.
   • Do not edit the Header Record descriptions.
   • Do not freeze the top row in Excel.
   • It is okay to delete columns; however this triggers a "missing field" warning during the import process.
   • Only the first worksheet in an Excel document is imported.

4. Save this excel sheet as a Text (Tab Delimited).TXT file to preserve formatting. Your file is ready to import into the software. Continue to Step 1: Import Data, Filers or Recipients.

General Import File Conventions

Please review these conventions PRIOR to creating your import file. We strongly encourage users to review our sample import files and include our Header Records to ensure success!

- Review Tax Form Specific Import File Conventions on the 1099 Pro Wiki site.
- See Filer Specific Import File Conventions.

Import Tips

• Save your Excel data file in Text Tab Delimited .TXT format to preserve formatting during import.
• Do not place a blank row between the Header Records and the start of your data.
• Do not edit the Header Record descriptions.
• Do not freeze the top row in Excel.
• It is okay to delete columns; however this triggers a "missing field" warning during the import process.
• Only the first worksheet in an Excel document is imported.

Fields in RED are required.

<table>
<thead>
<tr>
<th>Field (Header Record)</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rcp TIN</strong></td>
<td>Enter dashes in TINs to differentiate SSNs and EINS. Leave blank if TIN is missing or unknown.</td>
<td>11</td>
</tr>
<tr>
<td><strong>Rcp TIN Type</strong></td>
<td>This is a software specific internal code used to format TINs entered in the RCP TIN field without dashes. Definitions include: EIN=1, SSN=2, Unknown type=0 or blank</td>
<td>1</td>
</tr>
<tr>
<td><strong>Last Name / Company</strong></td>
<td>Enter Company if Recipient TIN is an EIN. Enter Last Name if Recipient TIN is an SSN.</td>
<td>40</td>
</tr>
<tr>
<td><strong>First Name</strong></td>
<td>Enter First Name only if Recipient TIN is an SSN. If Recipient TIN is an EIN, leave this field blank.</td>
<td>40</td>
</tr>
<tr>
<td><strong>Name Line 2</strong></td>
<td>Name line 2.</td>
<td>40</td>
</tr>
<tr>
<td>Field (Header Record)</td>
<td>Description</td>
<td>Max. Characters</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Name Line 3</td>
<td>Name line 3. <em>Corporate Suite Only field.</em></td>
<td>40</td>
</tr>
<tr>
<td>Name Line 4</td>
<td>Name line 4. <em>Corporate Suite Only field.</em></td>
<td>40</td>
</tr>
<tr>
<td><strong>Address Type</strong></td>
<td>Leave blank for US addresses. Enter &quot;C&quot; for Canada or &quot;O&quot; (not zero) for Other foreign countries. See Country Codes Table for more information. Please see Address Type Error below.</td>
<td>1</td>
</tr>
<tr>
<td><strong>Address Deliv / Street</strong></td>
<td>Recipient address line 1.</td>
<td>40</td>
</tr>
<tr>
<td>Address Apt / Suite</td>
<td>Recipient address line 2.</td>
<td>40</td>
</tr>
<tr>
<td>City</td>
<td>Recipient city or province.</td>
<td>40</td>
</tr>
<tr>
<td>State</td>
<td>US State or Canadian Province. <em>If Address Type is &quot;O&quot; (Other), this field is not applicable.</em></td>
<td>2</td>
</tr>
<tr>
<td>ZIP</td>
<td>Recipient ZIP or postal code. <em>For Canada the required format is letter-number-letter, a space, then number-letter-number. For example, &quot;C3H 4W9&quot; is a valid Canadian postal code.</em></td>
<td></td>
</tr>
<tr>
<td>Comb City/State/Zip</td>
<td>Recipient city, state and zip as one field. This field cannot be used in tandem with the standalone City, State and Zip fields. <em>This is an alternative format field and users must manually insert the header record into their import file.</em></td>
<td>40</td>
</tr>
<tr>
<td>Country</td>
<td>Recipient Country, enter only if Address Type is “O”. Please see Country Field below.</td>
<td>25</td>
</tr>
<tr>
<td>Rcp Account</td>
<td>Recipient Account Number. The Generate Account Wizard can auto-populate field if required.</td>
<td>20</td>
</tr>
<tr>
<td>Rcp Email</td>
<td>Useful if you want the ability to email forms (individually) to your Recipients. See Email Tax Forms.</td>
<td></td>
</tr>
<tr>
<td><strong>Additional Fields</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Checkboxes</td>
<td>Use X / Y / T / 1 to mark a checkbox. Leave field blank or use N / F / 0 (zero) to NOT mark checkbox. Values are not case sensitive.</td>
<td>1</td>
</tr>
<tr>
<td>Dates</td>
<td>Use MM/DD/YYYY format only. Unacceptable formats include Jan 3, 2018 and January 3, 2018.</td>
<td></td>
</tr>
<tr>
<td>Dollar Amounts</td>
<td><em>Do not use commas or dollar signs</em>, e.g., use 1250.00, not $1,250. Decimals are not assumed if none are contained in the amounts. For example, 1250 imports as $1,250.00. An import of 1250.0000 (Access or double precision databases) imports as $1,250.</td>
<td>12</td>
</tr>
<tr>
<td>Optional Filter/Query Fields (not displayed when printed or filed)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Form Source</td>
<td>Optional form category.</td>
<td>12</td>
</tr>
</tbody>
</table>
Field (Header Record) | Description | Max. Characters
---|---|---
Form Category | Optional form category. | 12
Batch ID | Optional batch ID for import or manual entry. | 12
Tax State | Optional override for state reporting/filing. | 2

*Corporate Suite Only Fields*

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
</table>
| Alt Rcp Account | Alternate Recipient account. | 60
| Rcp IMB | Optional USPS IMB code. | 31
| Accounting Date | Optional accounting date. | 6
| Print Code 1, 2, 3 | Optional print code 1, 2 or 3. | 1 per
| Do Not File | Optional user do not file box. | 1
| Do Not Merge | Optional user do not merge box. | 1
| Do Not Print | Optional user do not print box. | 1
| Filter: RecType | Ignore records that do not match this value. | 12

**COUNTRY FIELD**—Acceptable formats for this field:

- **A Country Name:** This is matched against the country file, and if a match is found, it assigns the proper country code to the form (e.g., Japan).
- **An Alias for a Country Name:** If a match is found for an alias, it is converted to the proper country name. For example, setup "FR" as an alias for France. See [Country Alias](#).
- **A Country Code:** and optionally, one of the internal country key values for cases where there are multiple names associated with one code (e.g., 'UK' can be 'United Kingdom', 'England', 'Scotland', 'Wales', etc.). The format is a two character country code, a slash and then the country key (if any). The country file is arranged so that if there is no key being imported, it will use the most inclusive/generic country name. Examples: 'UK' translates to 'United Kingdom', as would 'UK/0' or 'UK/1' 'UK/2' = 'Great Britain' 'UK/3' = 'Northern Ireland' ... and so on. The country name may also be spelled out however the spelling must match what is displayed in the list of acceptable country names in the 1042-S Instructions listed on the IRS’s website. For more information, refer to the Instructions for 1042-S from the IRS Website at [http://www.irs.gov](http://www.irs.gov). The last few pages of the 1042-S form instructions have both the country name & country codes in the section entitled "Country Codes"

**ADDRESS TYPE ERROR**—Users may receive an error during import if there is a discrepancy between the Address Type and Country fields; for example, if an Address Type of "C" for Canada is entered with a Country Code of "JA" for Japan. Users should abandon their import and edit their data file to reflect the proper Address Type for the Country to resolve the error. There is also the option to manually correct the error upon importing and posting your data at the [Work With My Tax Forms](#) screen.

**Filer Specific Import File Conventions**

Please review these conventions PRIOR to creating your Filer specific import file. We strongly encourage users to review our [sample import files](#) and include our Header Records to ensure success!
Review Tax Form Specific Import File Conventions on the 1099 Pro Wiki site.
See General Import File Conventions.
See Add a Filer.

Import Tips
- Save your Excel data file in Text Tab Delimited .TXT format to preserve formatting during import.
- Do not place a blank row between the Header Records and the start of your data.
- Do not edit the Header Record descriptions.
- Do not freeze the top row in Excel.
- It is okay to delete columns; however this triggers a "missing field" warning during the import process.
- Only the first worksheet in an Excel document is imported.

Fields in RED are required.

<table>
<thead>
<tr>
<th>Field (HEADER RECORDS)</th>
<th>Description</th>
<th>Max. Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIN</td>
<td>Enter dashes in TIN to differentiate SSN/EIN (e.g., 12-1234567, 123-45-6789). Leave blank if TIN is applied for or unknown.</td>
<td>11</td>
</tr>
<tr>
<td>TIN Type</td>
<td>An internal code used to format TINs entered in the TIN field without dashes. 1 = EIN, 2 = SSN, and 0 (or blank) = Unknown</td>
<td>1</td>
</tr>
<tr>
<td>TIN is Applied For</td>
<td>1 = 'Applied For', otherwise leave this field blank.</td>
<td>1</td>
</tr>
<tr>
<td>TIN Masking</td>
<td>Use TIN Masking when printing recipient forms. 1 = Yes, 0 or blank = No. It is not allowed to mask a Filer's TIN when printing forms.</td>
<td>1</td>
</tr>
<tr>
<td>Filer Payer Code</td>
<td>PCode. Must be unique alphanumeric code.</td>
<td>15</td>
</tr>
<tr>
<td>Location Code</td>
<td>The first four characters display on IRS Penalty Notices. If this field is blank the Filer Payer Code is used.</td>
<td></td>
</tr>
<tr>
<td>Name Line 1</td>
<td>Name of the filing entity.</td>
<td>40</td>
</tr>
<tr>
<td>Name Line 2</td>
<td>Filing name line 2 of the filing entity.</td>
<td>40</td>
</tr>
<tr>
<td>Address Type</td>
<td>Leave blank for US addresses. Enter &quot;C&quot; for Canadian addresses or &quot;O&quot; (not zero) for Other foreign countries. See Country Codes Table for more information. Please see Address Type Error below.</td>
<td>1</td>
</tr>
<tr>
<td>Address Line 1</td>
<td>Filer address line 1 (street, etc.)</td>
<td>40</td>
</tr>
<tr>
<td>Address Line 2</td>
<td>Filer address line 2 (suite, dept., etc.)</td>
<td>40</td>
</tr>
<tr>
<td>City</td>
<td>US/Canada enter City. Foreign addresses ONLY enter City, Country and Postal Codes.</td>
<td>40</td>
</tr>
<tr>
<td>State</td>
<td>State or Province, Locale if 'Other' country.</td>
<td>2 or 23</td>
</tr>
<tr>
<td>ZIP</td>
<td>US/Canada enter postal codes. For Canada the required format is letter-number-letter, a space, then number-letter-number.</td>
<td>15</td>
</tr>
<tr>
<td>Field (HEADER RECORDS)</td>
<td>Description</td>
<td>Max. Characters</td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-----------------</td>
</tr>
<tr>
<td></td>
<td><em>For example, &quot;C3H 4W9&quot; is a valid Canadian postal code. Foreign addresses enter postal codes in City field.</em></td>
<td></td>
</tr>
<tr>
<td>Country Name</td>
<td>Enter if Address Type is “O”. Please see Country Field below.</td>
<td>25</td>
</tr>
<tr>
<td>Email</td>
<td>Email address for Filer.</td>
<td>25</td>
</tr>
<tr>
<td>Fax</td>
<td>Fax number for Filer.</td>
<td>15</td>
</tr>
<tr>
<td>State Abbr for ID</td>
<td>See Multiple States/State ID Numbers below.</td>
<td>2</td>
</tr>
<tr>
<td>State ID Number</td>
<td>See Multiple States/State ID Numbers below.</td>
<td>15</td>
</tr>
<tr>
<td><strong>Contact Dept</strong></td>
<td>Contact department abbreviation, for example &quot;AP&quot;, &quot;HR&quot;, etc.</td>
<td>15</td>
</tr>
<tr>
<td><strong>Contact Dept Full</strong></td>
<td>Full contact department name</td>
<td>40</td>
</tr>
<tr>
<td>Contact is Default</td>
<td>Contact if filer default when adding forms. 1 = Yes, 0 or blank = No.</td>
<td>1</td>
</tr>
<tr>
<td><strong>Contact Name</strong></td>
<td>Contact name for department.</td>
<td>40</td>
</tr>
<tr>
<td><strong>Contact Phone</strong></td>
<td>Contact phone for department (prints on Recipient copies of tax forms).</td>
<td>15</td>
</tr>
<tr>
<td>Contact Ext</td>
<td>Contact phone extension for department.</td>
<td>7</td>
</tr>
<tr>
<td>Combined Filer</td>
<td>Participates in Combined Federal State Filing Program (CFSF). 1 = Yes, 0 or blank = No.</td>
<td>1</td>
</tr>
<tr>
<td>1099-INT RTN</td>
<td>Filer Routing Transfer Number (RTN), if applicable.</td>
<td>9</td>
</tr>
<tr>
<td>1099-K Filer Type</td>
<td>PSE/EPF/TPP indicator field. 0 or Blank = Not Applicable, 1 = PST (Payment Settlement Entity, EPF = Electronic Payment Facilitator and TPP = Third Party Payer)</td>
<td>3</td>
</tr>
<tr>
<td>1099-K PSE Name</td>
<td>PSE Name</td>
<td>40</td>
</tr>
<tr>
<td>1099-K PSE Phone</td>
<td>PSE Phone</td>
<td>20</td>
</tr>
<tr>
<td>Other</td>
<td>Use X / Y / T / 1 to check a box. Leave field blank or use N / F / 0 (zero) to NOT check a box. Values are not case sensitive.</td>
<td>1</td>
</tr>
</tbody>
</table>

**COUNTRY FIELD**—Acceptable formats for this field:

- **A Country Name**: This is matched against the country file, and if a match is found, it assigns the proper country code to the form. (e.g., Japan)
- **An Alias for a Country Name**: If a match is found for an alias, it is converted to the proper country name. For example, setup "FR" as an alias for France. See [Country Alias](#).
- **A Country Code**: and optionally, one of the internal country key values for cases where there are multiple names associated with one code (e.g., 'UK' can be 'United Kingdom', 'England', 'Scotland', 'Wales', etc.). The format is a two character country code, a slash and then the country key (if any). The country file is arranged so that if there is no key being imported, it will use the most
inclusive/generic country name. Examples: 'UK' translates to 'United Kingdom', as would 'UK/0' or
'UK/1' 'UK/2' = 'Great Britain' 'UK/3' = 'Northern Ireland' ... and so on. The country name may also
be spelled out however the spelling must match what is displayed in the list of acceptable country
names in the 1042-S Instructions listed on the IRS’s website. For more information, refer to the
Instructions for 1042-S from the IRS Website at http://www.irs.gov. The last few pages of the
1042-S form instructions have both the country name & country codes in the section entitled
"Country Codes"

ADDRESS TYPE ERROR—Users may receive an error during import if there is a discrepancy between
the Address Type and Country fields; for example, if an Address Type of "C" for Canada is entered with
a Country Code of "JA" for Japan. Users should abandon their import and edit their data file to reflect
the proper Address Type for the Country to resolve the error. There is also the option to manually
correct the error upon importing and posting your data at the Enter, Update & View screen.

Error & Validation Checks

All 1099 Pro software products perform validation checks on your data. This helps users find and fix
potential tax form errors (see Disclaimer) prior to submission to Recipients or the IRS. Error and
validation checks occur whether data is manually entered or imported. It also occurs when printing a
form, generating a paper file (e.g., 1096/W-3/1042-T Transmittal), an electronic file or Service Bureau
upload. If a problem is detected, the software flags the record with a Warning, Error or Reject Error.
Users are encouraged—but not required—to fix warnings and errors prior to submitting their records
to Recipients or the IRS.

Quick Error Scan

Use to quickly scan all records in the 109 Pro software database; on the menu bar select Utilities >
Check/Update Error Status For All Forms.

Warnings & Errors Defined

Whether importing or manually entering data, all 1099 Pro software products flag any records with
Warnings, Errors or Reject Errors. Any record containing a warning or error has an asterisk (*) prefixed
to its status at the Work with My Tax Forms screen (e.g., *Pending or *Filed).

<table>
<thead>
<tr>
<th>Type</th>
<th>Defined</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Warnings      | Possible inconsistency or omission in the data that may result in the record being rejected by the IRS/SSA | • City &/or State do not match USPS ZIP list  
• Invalid Country (see Country Alias)  
• Missing TIN  
• Missing State  
• Invalid Checkbox Code            |
| Errors        | Serious flaws in the data which will most likely result in an IRS/SSA reject. | • Missing Last Name/Company Name  
• Invalid State abbreviation  
• Missing ZIP/Postal Code          |
| Reject Errors | Data has not been entered correctly and will result in automatic IRS/SSA rejection. | • Missing Last Name + TIN  
• Field contains non-allowed negative amounts |
Find Problem Records
All 1099 Pro software products offer multiple means to locate problem records including:

- **Form Counts Report**: View a concise listing of all Filers and form types including number of warnings and/or errors per form type.
- **Control Totals Report**: View errors and/or warnings in detail by Recipient. Users must select the "Extended Version—Errors and Warnings Messages" to access this information.
- **Review Import Records**: Prior to posting import data into the software, users can edit or delete individual records, or abandon an entire import session, during the **Import Wizard—Step 2: Validate Data**.
- **Error Queries**: Sort records by "Errors Only" or "Errors & Warnings Only" at the Work With My Tax Forms screen.

Run Error Queries
1. On the task panel select Preparing My Forms > Work With My Tax Forms.
2. At the Enter, Update and View screen use the Current Query drop menu to select "Errors and Warnings Only" or "Errors Only".
3. The Enter, Update and View screen immediately displays any records that match the query criteria.
   - If NO records display then there are no problem records for the selected Filer and form type.
   - Any record containing an error or warning can be fixed provided it has a Pending status.
   - After fixing a problem record it immediately disappears from this list.
   - After fixing all problem records reset the Current Query to "All Records".

Business Rules/Validation Changes
All 1099 Pro software products include standard business rules—based on IRS/SSA specifications—for detecting errors and/or warnings on tax forms. At their discretion, Administrators can change default validation rules. **Caution: Disabling a business rule does not guarantee IRS/SSA acceptance of your records.** See [Custom Tax Form Validation Rules](#)

DISCLAIMER
1099 Pro software identifies many, but not all, of the most common format errors in information compliance submissions. The likelihood of submission rejection, though not eliminated, is greatly reduced when utilizing this software. Even if no errors are identified by this software, your submission could be returned or you could be penalized because of other errors.

Feedback
Users who encounter a situation that should possibly generate an Error or Warning in the software are encourage to discuss the situation with 1099 Pro, Inc. at compliance@1099pro.com. Please indicate the form type, data set and IRS regulations in your correspondence.
Manage Maps
A map defines the data fields and parameters of an import or export file. All 1099 Pro software products include sample import files with corresponding default maps to allow for easy, map-by-name imports. Users can also create their own, custom maps for the importing and/or exporting of tax form, Filer and Recipient (Corporate Suite Only) data.

Map Naming Convention
Both import and export maps are saved as TPS data files.

Import Maps
The Manage Import Maps screen allows users to view both default, built-in import maps and custom maps. This screen lists the type of mapping and the file format used for each map. Additional information includes Map Notes and Formatting Details. See Import Map Report

Access the Manage Import Maps screen via the Import Wizard > "Add/Update Import Maps" button.

Add a New Map
1. In the Import Wizard click the "Add/Update Import Maps" button.
2. To add a new map click the "Add" button. Select Excel/Delimited as the map type and follow the steps in the Import Map Wizard.

Change Existing Map
Users can highlight an existing import map and click "Change". Default, built-in maps cannot be modified; however users can copy them and then modify the copied map. Follow the onscreen steps as the wizard guides you through the process of changing an existing map. Any changes made overwrite the current mappings.

Delete Existing Map
1. Highlight the existing map to delete. The user is prompted to confirm their choice, click "OK".
2. An existing mapping cannot be deleted if it is tied to a current import/in-process import session. Any such imports must be completed or abandoned first and then the map can be deleted. Once deleted a map cannot be recovered.

Export Maps
An export map is identical to its corresponding import file. For example, the fields contained in a 1099-MISC sample import file are automatically included in a default, built-in 1099-MISC export file.

Export a Map
1. At the Manage Import Maps screen click the "Export Map" button.
2. At the Map Export screen select an export location, confirm onscreen settings and click "Finish" to generate the file.

Delimited or Excel Import Map
All 1099 Pro software products offer custom Import Wizards to simplify the process of creating Delimited/Excel. 1099 Pro's standard Import Wizard and sample import files are sufficient for most
users; however some users require the ability to add additional fields or apply special formatting to 
TINs, dates or decimals. See Import Map Report.

Create Delimited/Excel Import Map
Import files can be imported in a variety of formats including; delimited, .CSV, Tab-Delimited, Pipe-
Delimited, Fixed Length, and Excel (XLS or XLSX).


2. At the Import Sessions screen click the "Import Records from Excel or a Delimited Text File" 
   button.

3. In the Import Wizard continue to the Select the Type of Data and Format to Use screen. Click the
   "Add/Update Import Maps" button.

4. At the Manage Tax Form Import Maps screen click the "Add" or "Change" button and select Excel 
   or Delimited as import format.
   - To delete an import map, highlight the map and click the "Delete" button.
   - If header records in an import file are changed, the user must either modify the existing map or 
     create a new map that reflects those changes.
   - The following columns define an Import Map: Map Type, File Format, Status and Description. 
     The description column gives details about the currently selected import map and the Map 
     Notes window to the right provides additional information.

5. The Excel Import Wizard opens. Continue as prompted to the Map the Import Fields/Columns to 
   Data Fields. Options include:
   - Map By Name—Use the "Map by Name" button to automatically map all fields with 
     matching names. To cancel a Map by Name use the "Reset/Clear the Map" button. See 
     Combined Address Mapping below.
   - Drag & Drop Fields—Manually match each field from the input file on the left to the 
     corresponding tax form field on the right by dragging and dropping. Repeat process until all 
     needed fields are assigned. To cancel a match, drag from right to left or double-click on it. See 
     Combined Address Mapping below.
   - Assign Value—Assign a fixed value to the selected unmapped field. For example, for the "Rcp 
     TIN Type" field enter EIN=1, SSN=2 or Unknown=3 (or blank) if all imported recipients have an 
     identical recipient TIN type.
     - Combined Address Mapping: If your import file uses a Combined City/St/Zip import 
       field instead of the individual City, State and ZIP fields, drag the import field to the Comb 
       City/St/Zip input field—do NOT drag it to the individual City, State and Zip fields. If using 
       the Address Delivery/St and Address Apt/Suite import fields, drag them to their respective 
       input fields. Performed correctly, Address Delivery/St+ appears at the Address Delivery/St 
       input field only. The plus sign indicates Address Lines 1 and 2 have merged for a successful 
       mapping. Drag or map by name all other fields as normal.

6. At the Default Field Size and Format Options screen select below options and click "Next" to 
   continue:
• Check if "Amounts Use Implied Decimal Formatting". An implied decimal means that the dollar amounts being imported do not have an explicit period between the dollars and cents portions of the amount, e.g., "10000" = "100.00" in implied decimals. The use of the implied decimal format in delimited file formats is rare.
• Select date field format options - Various options are available. Indicate if date uses four years, i.e., XXXX, and if date includes separators.

7. At the Set Recipient Matching Options screen choose how the software matches imported records with existing Recipients and/or tax forms. Options include:
   • Matching Recipients with a TIN
     o TIN plus Account Number
     o TIN plus Last Name (use only if account numbers are unavailable or inconsistent)
   • Matching Recipients When TIN is Missing/Blank
     o Account and then Last Name (default option)—Looks for account numbers first, then matches for Last Name for the Account.
     o Account plus a blank/missing TIN—Use when TIN/Account Number are the only identifying fields in the field (no name information is provided).
     o Last Name and then Account—Looks for the Last Name first, then matches for Account Number for the Recipients.
     o Last and First Name (use if account numbers are unavailable or inconsistent)—Account numbers are NOT used to match for Recipients.

8. At the Specify a Name and Usage Notes for the Import Map screen enter a descriptive title for this map. Users can also add usage notes for further clarification. Click "Next" to continue.

9. At the Set Options for Locating Your Import Files screen review options and click "Next" to continue.
   • Specify the default folder where this type of import file will be located. If left blank, the software prompts to locate the import file.
   • Users can optionally specify a default file name.

10. Specify the Type of Import: (Corporate Suite Only)

11. Review summary settings and click "Finish". The Administrator indicates if the import map was successfully created. Users may opt to import the data used to create this map by clicking the "Yes" button. Users are automatically returned to the Import Wizard, Select the Type of Data and Format To Use screen and the newly created Import Map is available for selection.

Maps: Import/Export

Users can import and export customized import maps. Those users NOT running 1099 Pro software in a multi-user environment—but requiring standardized import maps for multiple single-user installs—will benefit from the ability to share maps. Import maps are saved in a .TPS format and cannot be edited or viewed in applications outside of the Manage Import Maps utility in this software.

Note: Prior year import maps can be "rolled forward" during the software installation process; however if the 2018 tax form has changed, the 2017 map is thus outdated and will not roll forward.
Export Map
1. At the Manage Import Maps screen highlight any map and click the "Export Map" button.
2. At the Map Export screen select an export location, confirm onscreen settings and click "Finish" to generate the file.
   - By default, maps are exported to the Maps folder in the MAP IMPORT FFF (Form Type) IDnnn MM-DD-YY HH-MMxM.TPS format, e.g., "MAP IMPORT 1099-R ID364 7-20-2018 8-09AM.TPS".

Import Map
1. At the Manage Import Maps screen click the "Import Map" button.
2. At the Import Map screen browse for the .TPS import map and click "Finish".
   - By default, maps are saved to the Maps folder. Maps are automatically associated with the corresponding form type and immediately available for selection at the Select the Type of Tax Form screen in the Import Wizard.

Import Map Report
The Import Map Report is an invaluable tool for reviewing import map specific data including:
- Form type
- Creation Date and Time of the Import Map
- Recipient's First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record print status and date of last update
- Creation Date and Time of the Report including the Network Station ID
- Field Name, Field Type and Field Description...

Run Import Map Report
1. On the menu bar select Utilities > Run the Import Wizard.
2. Select the "Import Records from Excel or a Delimited Text File" button to initiate the Import Wizard.
3. At the Select the Type of Data screen in the Wizard, click the "Add/Update (form type) Import Maps" button.
4. Highlight any import map and click the "View/Print Map" button
5. The user is prompted to preview the report.

Import Session Summary Report
The Import Session Summary (or Amount Totals Report) details all records in the selected import session. See Reset/Void Import Session

Run Report
2. At the Completed and In-Process Import Sessions screen highlight an import session and select the "Amount/Totals Report" button.
   - The "Amount/Totals Report" button is ghosted and unavailable for any session with a status of Abandoned or Reset/Void.
3. The Report Options screen prompts to:
   - Select the Printer—Consider printing to PDF to save paper.
   - Select the Sort Order—By Last Name/First Name or by TIN.
   - Preview before printing.
   - Print Summary totals only.

4. Click "OK" to generate the report or "Cancel" to exit the report.

**Reset/Void Import Session**

When an import session is reset (voided), all tax forms associated with the import session are deleted UNLESS their status has been changed since the original import. For example, if records are imported as Pending and then some are updated to Printed or Filed Mag status, only the Pending records are deleted.

If this was a partial import and records have a Loaded status, users must use the “Continue with Session” button and then “Abandon the Session” to remove the session.

**What Does NOT Happen When an Import Session Is Reset**

Recipient records added or changed during the import session are NOT deleted or rolled back. To remove those recipient records refer to the [Recipient Master List](#) screen.

**Reset/Void Import Session**

Once an import session is reset/void it cannot be reversed.


2. At the Completed and In-Process Import Session screen highlight any session with a status of "Imported" or "Partial" and click the "Reset (Void) Session" button.

3. The Confirm Reset/Void screen prompts the user to Proceed with Reset/Void or Cancel. The Completed and In-Process Import Session screen immediately updates the session status to "Reset/Void".

**Form Totals Report**

The Form Control Totals report is an invaluable tool for reviewing Recipient records and pinpointing errors and warnings. This report is tax form and Filer specific and includes:

- Filer’s Name and TIN
- Recipient’s First Name, Last Name, TIN, Account Number and optionally, their Address
- Individual record status and date of last update
- Box-by-box totals
- Errors and Warnings
- Number of missing TINs and more....

**Control Totals Report**

1. Select the form type and Filer.
2. On the menu bar select Reports > Control Totals for Current Filer & Form Type OR on the task panel select Preparing My Forms > Forms Totals Report.

3. At the View/Print Control Totals Report screen select a printer. Consider printing to PDF to save paper.

4. Report Filter and Form Selection Options—Choose a method for selecting records:
   - All Pending Originals for this Filer
   - All Original Forms for this Filer
   - Use Query Wizard to choose or create a query
   - Manually select records (tagging)

5. Error and Warning Messages—Determine how to print warnings and/or errors. **This option is only available if "Extended Version" is selected under Report Format Options, below.**
   - Don't print error and warning details
   - Print error and warning details
   - Print ONLY forms with errors and warnings
   - Print ONLY forms with errors

6. Report Record Ordering Options—Choose how to sort the records:
   - By Last Name
   - By TIN
   - By Account Number, then Last Name

7. Report Format Options—Choose a report format:
   - Summary Version (amounts only, no address, text or error/warning detail).
   - Extended Version (all form details including address and errors/warnings)

8. Additional options include:
   - Add custom notes for this report run
   - Print totals only (suppress individual form details)

9. To generate report click "Print Now".

10. At the preview screen go to the last page to view box-by-box summary totals.

**Print Preview Toolbar**
The Preview screen allows users to view a form or a report and check it for accuracy before printing.

**Print Preview Icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Page" /></td>
<td>Print THIS page only.</td>
</tr>
<tr>
<td><img src="image" alt="Previous" /></td>
<td>View the PREVIOUS page.</td>
</tr>
</tbody>
</table>
Task Panel Items

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>View the NEXT page.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>Toggle STAY after printing.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Search for characters within a report.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>Access the &quot;Print Setup&quot; screen to print the entire report.</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Exit the preview report WITHOUT printing.</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>View the preview report in full WIDTH view.</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>View the preview report in full HEIGHT view.</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>Save report in PDF format.</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>Set zoom percentage; range is 25 to 250%.</td>
</tr>
</tbody>
</table>

**Duplex Printing**
All 1099 Pro software products support duplex printing. Not all printers or print drivers offer this feature; review the printer manual for specifications.

**Duplex Print**
1. At the Print Preview screen initiate a print session via the "Printer" icon.
2. At the Select Printer Screen, click the "Properties" button for your printer.
3. Click the Finishing tab, then locate the area "Document Options" on this screen.
4. Place a check in the box to "Print on both sides".
5. Click "OK" and proceed to print the job.

**Printing & Mailing**

**Print/Mail Forms Myself**
All 1099 Pro software products allow users to print forms directly to blank paper or preprinted forms. Many of our users prefer to outsource the printing and mailing of their forms to the 1099 Pro Service Bureau—it is SOC 1 Type 2 secure, cost-effective and efficient.

The Tax Form Print Sessions screen simplifies the in-house printing process. At this screen users can generate Original and Corrected print runs, reprint and reset/void print sessions and more. Access this screen via the task panel > Printing & Mailing > Print/Mail Forms Myself.

**Print Wizard**
All 1099 Pro software products allow users to print most forms in-house, directly to blank paper; the exception is IRS Copy A forms which require a preprinted form with a special red ink. Most IRS approved, preprinted tax forms are compatible with our software. See Print Wizard for
instructions on printing Original and Corrected forms. To quickly print an individual form see Quick-Print.

Print Session Considerations
- Print sessions are Filer and Tax Form specific. If a print session is not visible, verify that the correct Filer and tax form are selected.
- The "Session Type" column indicates the type of forms printed including Originals or Corrected.
- Additional columns detail the total number of forms and forms with errors or warnings.
- The "Date Filed" column populates automatically, AFTER an IRS filing is generated for this print session. Options include "Filed 1096", "MagMedia" or "Upload (Service Bureau)". If the "Date Filed" column is empty, an IRS filing (or IRS paper transmittal or SB IRS Upload) has NOT been generated for this print session. If this field is populated, it is the USER's responsibility to ensure that the generated IRS filing was successfully submitted to the IRS.

Reset (Void) Print Session
Highlight any print session that have not been filed to void it. If a print session has been filed (refer to the "Date Filed" column) it cannot be voided until its associated "MagMedia", "1096" or "Upload" (Service Bureau) file has been reset. A voided session cannot be un-voided.

Print Session Summary
This report generates a per record detail of a print session. The last page of this report includes Total Form Count, Number of Forms with Missing TINs, Box-By-Box Totals and a State Withholding Breakdown.

Run Report
1. Click the "View/Print Session Summary" button.
2. Other Report Options include:
   - Preview before printing
   - Print Summary totals only
   - Errors and Warnings only
3. Click "OK" to continue.

Reprint Print Session
Use to reprint an entire print session.

Print Wizard
The Print Wizard simplifies the process of printing tax forms via high-speed PCL printing. Any form with a Pending print status (or Corr/Pending for corrected forms) is available for selection in this wizard. Forms with any other print status can be printed individually via Quick-Print or in batch via Group Actions.

Did you know? The 1099 Pro Service Bureau offers highly competitive and secure Print+Mail and IRS filing services.
Print Wizard
1. On the task panel select Printing & Mailing > Print/Mail Forms Myself. Corporate Suite users select the appropriate tax year and form type.

2. At the Print Forms for Recipients and the IRS screen refer to the Begin Printing IRS Approved Tax Forms area and pick a method for selecting the Pending forms to print.
   - All Pending forms for the CURRENT Filer (default)
   - All Pending forms for ALL Filers
   - ALL Pending forms for SELECTED Filers
   - Manually select forms for the CURRENT filer

3. Set Form Selection Limits. Check the "Show Me the Optional Extra Filters" box to limit the number of records that will be selected. Records can be filtered by Address Type, Amount Thresholds, Maximum Record Limit and 1099-MISC Box 7/NEC handling for specific print runs. See Form Limits

4. Corrections: Check the "Process and Print Corrected Forms Instead of Originals" box. This box displays only if there are eligible corrected forms for the currently selected form type. Corrected and Original forms must be printed in separate sessions. See About Corrections

5. Click the "Begin a New Print Process" button to access the Print Wizard.

6. Confirm Processing: This screen is only triggered if any records in the print run have errors or warnings. Filing records with missing or invalid data can result in the record being rejected by the IRS. This screen displays only if your data contains errors or warnings. Options include:
   - Yes—Print the Forms Anyway
   - No—Skip These Forms For Now
   - Cancel the Print Job

7. The Print Wizard displays the number of Recipients selected for printing. To verify Recipients, amounts, or other information users are encouraged to first run a Control Totals report. To proceed with the Print Wizard click "Next". Use the "Back" button at any time.

8. Select printer and click "Next" to continue.
   - PDF File Generation—Select a PDF driver such as Adobe PDF to quickly create a digital PDF copy of your tax forms. This is a great way to create a digital master file of these Recipient forms. To protect sensitive data users are encouraged to password protect PDF files and save them to a location on their hard drive or network. See PDF Files
9. Select paper type including:
   - **Preprinted Laser Forms**—Including IRS red Copy A forms. This paper type triggers the Verify Print Alignment screen later.
   - **Blank** Stock Forms—Select to use the Combined Print option (at the next screen) and print all Recipient copies and instructions directly to blank paper.
   - **Pressure Seal/Alternate Combined Layout (ACL)**—Some form types offer unique print layouts. See Pressure Seal/ACL for specific instructions.

10. Select copies to print. Multiple copies can be selected. The user is prompted to load preprinted forms into the printer as required.

11. Verify Print Alignment (preprinted forms only): Users are encouraged to print a test alignment to BLANK paper prior to using their preprinted forms to minimize waste. After printing a test alignment page to blank paper, hold it up to the light behind the preprinted form. Adjust margins in the software as necessary. When satisfied, click "Next" to continue. See Troubleshooting Margin Alignments:
   - Adjustments—Are measured in hundredths of an inch, e.g. "0.25" shifts the margin by 1/4-inch.
   - Top Margin—Positive numbers move the data down, negative numbers move the data up.
   - Left Margin—Positive numbers move the data right, negative numbers move the data left.

12. Select a sort order to print forms:
   - By Last Name/Company Name (default)
   - By TIN
   - By Zip Code (use to pre-sort mailings for the post office)
   - By State Abbreviation
   - By Account Number, then Last Name
   - Additionally, check the "Within Each Selected Copy, Keep All Forms For Each Filer Grouped" box as appropriate.


14. Indicate preview preference:
   - Ask me before processing each copy (default)
   - Yes, preview each selected copy type without asking me
   - No, send the forms directly to the printer without previewing them

15. Review print summary. To mask/unmask recipient TINs or force an X in the corrected box use the Advanced Print Options. When ready to proceed click "Print". The Print Wizard pauses before printing each copy and prompts the user to load the appropriate form(s) into the printer.
   - **FALSE PRINT**—To update print status from Pending to Printed WITHOUT printing any forms select NO COPIES to print. The Administrator prompts to press the "Print" button.
   - **Note:** 1099 Pro software prints to most Windows compatible printers, subject to the printer's margin limitations. Printers with a bottom margin greater than 1/3-inch may be unable to print data at the bottom of the page or may require printing two forms to a page. Check your
16. Indicate if forms are ready to send to the IRS/SSA:

- **NO**—I have NOT printed my finalized or red Copy A yet. These forms maintain their Pending status and are available for further edits at the Work With My Tax Forms screen.
- **YES**—I have verified and/or printed my finalized Copies or red Copy A forms. These forms are assigned a Printed status and are no longer available for edits. These forms are ready to transmit to the IRS via a Service Bureau IRS File upload, electronic filing (mag media) or on a 1096 paper transmittal.

17. Click "Finish" to exit the Print Wizard.

**Account Number Generation Wizard**

Most 1099 Pro software products include a wizard to generate account numbers for eligible forms missing this information.

Per IRS. Pub. 1220: *The account number is required if there are multiple accounts for a recipient for whom more than one information return of the same type is being filed. This number will identify the appropriate incorrect return if more than one return is filed for a particular payee. Do not enter a TIN in this field. A payer’s account number for the payee may be a checking account number, savings account number, serial number, or any other number assigned to the payee by the payer that will distinguish the specific account. This number must appear on the initial return and on the corrected return for the IRS to identify and process the correction properly.*

Per IRS Pub. 1187: *Financial institutions reporting amounts paid to direct account holders with respect to an account maintained by institution at a U.S. office or U.S. branch, must report the recipient(s) account number.*

**Why Generate Account Numbers?**

The IRS requires account numbers in many instances and for all corrected forms. The Generate Account Number wizard creates unique Account Numbers for eligible tax forms to satisfy this requirement. *It is a smart business practice to populate the account number field on ALL forms.*

- Only forms with a status of Printed or Pending are updated.
- Any form with existing Account information is NEVER overwritten, regardless of status.
- Users can manually replace generated account numbers at any time before filing with the IRS/SSA.
- The Account Wizard algorithm is the first two letters of the Recipient’s last name, the IRS form code and a number unique to that form. For example, one might look like this SM-M-0001234.

**Account Number Generation Wizard**

This wizard is accessible via the menu bar > Utilities > Generate Account Numbers and is also available during many processes including importing, print, uploading and electronic filing. This wizard will create a unique account number for all Pending and Printed records without an account number—existing account numbers are never overwritten.
Generate Account Numbers
1. In the Account Number Generation Wizard review important onscreen information. Click "Next" to continue, go "Back" at any time.
2. Choose a method for selecting eligible tax forms. Options include:
   - ALL Forms for ALL Filers: This option automatically selects every eligible form for all Filers.
   - Selected Form Types for ALL Filers: This option prompts to manually select form types to include in this process. All Filers are processed.
   - Selected Form Types for Selected Filers: This option prompts to manually select the Filers and the form types to include in this process.
3. Review settings and click "Finish" to generate account numbers.
4. The Administrator indicates:
   - Total Forms Scanned
   - Total Forms Without Account Numbers
   - Number of Forms Updated with new Account Numbers

Advanced Print Options
All 1099 Pro software products include Advanced Print Options offering enhanced print functionality for Recipient copies. Selections made at this screen are temporary and unique to the individual print run; options must be reset for subsequent print runs.

Advanced Print Options
- A brief, standardized message to be printed on all forms in this print run. Select from the available list or enter your own message of up to 30 characters.
- Force an "X" in the Corrected* box.
- Force an "X" in the Void* box (the Void box is available only on select forms).
- Print "0.00" instead of blanks for all zero amounts.
- TIN Masking On/Off
- Address/Envelope Offsets—Use to shift the position of the Filer and/or Recipient addresses up/down and left/right. Address adjustments are measured in hundredths of an inch from the DEFAULT placement. For example, a change of ".25" shifts the address down or to the right 1/4-inch. Likewise, a change of ".25" shifts the address up or to the left 1/4-inch. As adjustments are made, the adjustment title turns RED if the value entered is too large. When finished click "OK" to save changes and return to the Print Wizard.

* Forcing an X does not generate a valid correction or void a record. See Forcing an X below.
Forcing an "X"

**Why Force an 'X' in the Corrected Box?** Some users regard these revised, re-issued forms as a correction, and want the Corrected box checked to indicate to the Recipient that the new form has updated information on it. Use Advanced Options to force an "X" and help avoid confusion for the recipient. **What's important to understand is that forcing an "X" in the Corrected or Void box is NOT considered a valid/legal correction by the the IRS.** If the original data has not yet been filed with the IRS, there is nothing to legally correct or void. In such instances, forcing an X is strictly for the benefit of the Recipient.

Please note, if your data has been filed with the IRS, a formal IRS correction must be generated and filed. The IRS has specific guidelines about the processing of Corrected and/or Voided forms. That is why Advanced Options are only available for Recipient copies. If you send the IRS an original form with the Corrected box checked, it will most likely get rejected. See [About Corrections—An Overview](#).

**Force an "X"**

1. The Advanced Print Options screen is available at the SB Print+Mail Wizard, Print Wizard and **Quick-Print** screen.
2. At the Special Options for This Run Only tab select the box to be marked on all Recipient copies for this print run. Options include:
   - Force an 'X' in the Corrected Box
   - Force an 'X' in the Void Box (available only on select form types)

**Custom Print Messages**

This is an optional feature allowing Filers to provide a brief, custom message to Recipients such as "Revised & Re-Issued" or "Corrected and Re-Issued" on the form. This provides additional information to the Recipient, for example, confirmation of an address change. A maximum of 30 characters are allowed—there is no additional cost to insert a custom message.

*Did you know?* The Service Bureau can insert a one page, standardized document, with your tax forms—contact the Service Bureau to discuss specifications and pricing.
Enter Custom Message
1. The Advanced Print Options screen is available at the SB Print+Mail Wizard, Print Wizard and Quick-Print screen.
2. At the Special Options for This Run Only tab specify an optional message to be printed on all Recipient copies for this print run. All 1099 Pro software products include the following standard messages:
   - * Re-issued Form *
   - * Revised and Re-Issued *
   - * Corrected and Re-issued *
   - * Replacement Copy *
   - * Duplicate Copy per Request *
3. Or enter a custom message of up to 30 characters.

Margin Alignments
All 1099 Pro software products allow users to adjust margin alignment when printing to preprinted forms.

Preprinted Forms Address Alignment
The Print Wizard offers the opportunity to print a test alignment, and adjust margins accordingly, prior to printing your forms. A test alignment to a blank sheet of paper is a smart way to minimize form waste. Test alignments print the characters "X" and "9" instead of your actual data. Your data will print (assuming the software is registered) at the last step of the Print Wizard.

Run Test Alignment
1. Initiate the Print Wizard; it automatically prompts to print a test alignment prior to printing your forms.
2. Select preprinted laser as the paper type, the user is prompted to test alignment after selecting the copies to print.
3. For the first test print do NOT modify the default Top and Left margin settings.
4. Print the test to blank paper and then hold it and a preprinted form to the light to determine if data fits into the appropriate boxes. If data does not align refer to "Alignment Adjustments" below.

Alignment Adjustments
Alignment adjustments are measured in hundredths of an inch from the default margin. For example, "0.25" would effect an adjustment of ¼-inch. Once a margin is adjusted, it becomes a default setting for that form type until the margin is adjusted again.

Top Margin
Positive numbers (e.g., "0.25") move the data lower on the page. Negative numbers (e.g., "-0.25") raise the data higher on the page.

Left Margin
Positive numbers (e.g., "0.25") move the data to the right. Negative numbers (e.g., "-0.25") move the data to the left.
Export Forms for Print/Mail

Export ASCII Forms

All 1099 Pro software products feature an intuitive Export Wizard for the exporting of tax form data in a Mapped ASCII (Fixed/Delimited/Excel) format that is accessible in spreadsheet applications such as Microsoft Excel or Access. If using Notepad to view files, data will appear out of alignment as the export files are Tab delimited. All export files are "Map by Name" compatible and can be imported directly into another Filer.

See Import Wizard

Export ASCII Data

1. On the menu bar select Utilities > Export Tax Forms to ASCII File(s).

2. In the Export Wizard review onscreen information and click "Next" to continue, go "Back" at any time.

3. At the "Select the type of data and format to use" screen use the drop menu to select the appropriate form type and click "Next".
   - To customize the delimiters and data exported use an export map, accessed via the "Add or Update Export Map" button. See Export Maps Wizard for important field descriptions.

4. Choose a method for selecting eligible tax forms. Options include:
   - Export tax forms for ALL Filers: This option automatically selects every eligible form for all Filers.
   - Export tax forms for up to 25 selected Filers: This option prompts to manually select (tag) the filers to include in the export file. All form types for the selected Filers are processed.
   - Split export records into separate files for each Filer?: Mark the check box to export Filers' records into individual files. Leave the check box unmarked for a single, larger file containing data for all Filers and form types.
   - (CS Only) Group export records by Address Type: Forms are grouped by US, Canadian, Other within each export file.

5. (CS Only) Select the type of forms to export:
   - Originals: Defined as forms that do not have a Corrected status in the IRS Status column, i.e., forms with any other status, Pending, Printed, Filed, excluding forms with a Void or Deleted status. **Note:** If a record has been filed, and subsequently had a correction made, only the Originally filed form will be exported (the Corrected form will not).
   - Corrections: Defined as forms that correct or replace forms that have been filed with the IRS/SSA, i.e., forms with a Corr/Filed status.

6. (CS Only) Select Extra Filters Options

7. (CS Only) Select Special Processing Flags

8. Select the destination folder and click "Next" to continue.

Create XML

XML Files
The Electronic Filing Session window contains the FATCA XML functionality and NIL reporting available in 8966 Pro software. Access this screen via the task panel > Create XML > XML V2.0 File.

Electronic File Formats
<table>
<thead>
<tr>
<th>eFile Format</th>
<th>Accessed Via</th>
</tr>
</thead>
<tbody>
<tr>
<td>FATCA XML File</td>
<td>&quot;Create an 8966 FATCA XML File&quot; button.</td>
</tr>
<tr>
<td>NIL Report</td>
<td>&quot;Create a NIL Report&quot; button.</td>
</tr>
</tbody>
</table>

Completed eFile Sessions List
This screen is composed of logs detailing all electronic (XML) files generated via the XML wizard.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log ID</td>
<td>A unique number assigned to each file generated by the XML Wizard.</td>
</tr>
<tr>
<td>Session</td>
<td>A number assigned to any group of files generated together by the XML Wizard. One session can include multiple logs.</td>
</tr>
<tr>
<td># Forms</td>
<td>The number of forms generated for a specific log.</td>
</tr>
<tr>
<td>Session Type</td>
<td>The type of transaction for a particular log including &quot;Originals&quot;, &quot;VOID: Amended&quot;, &quot;Void&quot;, etc.</td>
</tr>
<tr>
<td>Format</td>
<td>Electronic (XML) only</td>
</tr>
<tr>
<td>Session Date</td>
<td>The date the session file was created.</td>
</tr>
<tr>
<td>Session Time</td>
<td>The time the session was created.</td>
</tr>
<tr>
<td>Date Reset</td>
<td>Indicates the date/time a session was voided or reset.</td>
</tr>
<tr>
<td>File Name</td>
<td>Details the file name and location saved.</td>
</tr>
</tbody>
</table>

Onscreen Options
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;View/Print Session Report&quot;</td>
<td>Generate a totals report on the currently selected session.</td>
</tr>
<tr>
<td>&quot;Reset (Void) Session&quot;</td>
<td>Use to Void/Reset the highlighted electronic (XML) filing session including all log IDs associated with that session. See Reset eFile Session</td>
</tr>
<tr>
<td>&quot;Package XML File&quot;</td>
<td>Quick link to the IDES Packager where users can package an 8966 XML file into an IDES compatible data archive.</td>
</tr>
<tr>
<td>&quot;Visit IDES Site&quot;</td>
<td>Direct access to the International Data Exchange Service (IDES) portal, a delivery point for the electronic exchange of FATCA data with the United States.</td>
</tr>
</tbody>
</table>
XML Filing Overview
The Electronic Filing Session window contains the FATCA XML functionality available in 8966 Pro software. Access the Electronic Filing Session window via the task panel > Create XML > XML File.

Electronic Filing Wizard
The eFile Wizard is designed to simplify the process of generating electronic (XML) files. Users are encouraged to generate their electronic files towards the end of the filing window. This allows users the maximum amount of time to correct any errors before filing with the IRS/SSA or other agency. Learn about the Electronic (XML) Filing Sessions screen.

Account Number Generation—Are Account Numbers Required?
8966 Pro offers a utility to generate account numbers for any forms that do not have account numbers. See Generate Account Number Wizard.

Reset eFile Session
When an electronic filing session is reset, all records in that session revert to their pre-filing status. For example, a record that prior to electronic filing had a Pending status returns to Pending status and is thus available for edits and/or inclusion in a new electronic file session.

Reset Session
1. On the task panel select Create XML > XML File.

2. At the Completed File Generation Sessions List screen highlight a session and click the "Reset (Void) Session" button.

3. The Administrator prompts, "Are you sure that you want to RESET/VOID this session?" Click "Yes" to proceed or "No" to cancel.

   • The "Date Reset" column indicates the date the session was voided.

XML File Wizard
The XML Wizard allows users to quickly generate Form 8966 into Original, Corrected, Amended and Void FATCA XML files.

Effective January 2018, the FATCA XML Schema v2.0 replaces v1.1 and the FATCA Notification XML Schema v2.3 replaces v2.2. All International Data Exchange Service (IDES) users are required to submit FATCA Reports using v2.0 as v1.1 will no longer be supported. 8966 Pro 2017 fully supports these changes.

NOTE: Special characters are prohibited in XML file generation. The apostrophe (’), double dash (--), quotation mark ("), and hash (#) symbols are prohibited as they can be used in a security threat and will cause the transmission to be rejected with a failed threat detection error notification. Replacing the characters with an entity reference will still cause a rejection.

Generate XML Files
Prior to running the XML File Wizard users must enter their Transmitter Information.
1. On the task panel select Create XML > XML File.

2. At the Filing Tax Forms via Electronic Filing screen click the "Create an 8966 FATCA XML File" button.

3. In the XML File Wizard review onscreen information and click "Next" to continue, go "Back" at any time.

4. Check for software updates. Although not required to continue with this process, it is strongly recommended.

5. Create Account Numbers as necessary via the Generate Account Numbers Wizard and then click "Next" to proceed.
   - The IRS uses a 20 character Account Number, as assigned by the withholding agent, to help identify all corrections. 8966 Pro strongly suggests that all forms have unique account numbers assigned to them.
   - The Generate Account Numbers Wizard does NOT overwrite any existing account numbers.

6. Select Specific Filers—Use the "Tag" buttons or manually select the Filers to include in this XML file.

7. Specify the File Type and Transmission Medium:
   - Original 8966 Forms
   - Amended 8966 Forms
   - Corrected 8966 Forms
   - Void 8966 Forms
   - TEST File—Send only test data (not production data) under a dummy test filer. Test data is marked as 'filed'; IDES prohibits the transmission of live data for testing.

8. Select the destination folder. Default location is C:\1099 Pro\Pro66T18\MagFiles.
   - Files are automatically named in the "8966Tax-NNNNNN" format where NNNNNN is a unique sequence number, followed by the Type, Tax Year and Date and Time of Creation. For example, "8966Tax-000012 (Orig) 2015 3-12-16 9-27AM.txt".

9. Verify Contact and Company Information. Changes made here are temporary and apply to this session only. To make permanent changes exit the eFile Wizard and go to the Browse the Filers screen.

10. Set Reporting Period—The default USA/IRS period is the last day of the tax year being reported. Model 1 countries may have different reporting periods; set them via the the ellipses button to the right of the Reporting Period window. Click "Next" to continue.

11. At the Ready to Generate 8966 File(s) screen review settings and if satisfied click "Finish" to start the XML file generation.

12. The Progress screen tracks your Electronic File Generation Process and indicates total files created. Click "OK" to exit this screen.
13. At the Completed Electronic File Session List click the "Visit the IDES Site" button for direct access to the IDES Gateway to post your XML file(s).
   - The IDES Gateway requires users to have a unique User ID and Password. Please see International Data Exchange Service (IDES) at https://www.idNewLinkes-support.com/Ides/Index for details.

Cayman Islands AEOI Portal

When generating XML for the Cayman Islands, users are encouraged to first review the Cayman Islands Automatic Exchange of Information (AEOI) Portal V3.2.1 User Guide. Per page 37 of the User Guide, users may be required to populate the SendingCompanyIN field with "000000.00000.TA.136".

This can be done by opening your XML file in a text editor application (e.g., Notepad or Textpad) and manually editing the SendingCompanyIN field as highlighted below:

```xml
<ftc:MessageSpec>
   <sfa:SendingCompanyIN>000000.00000.TA.136</sfa:SendingCompanyIN>
</ftc:MessageSpec>
```

Invalid GIIN?

To validate a GIIN, 1099 Pro, Inc. offers www.TINCheck.com, a separate service that validates TIN/Name combinations, GIIN numbers, the Office of Foreign Asset Control (OFAC) for the US, and other lists for a fee.

IDES Packager

8966 Pro includes an IDES Packager to quickly package data or decrypt an IDES notification package. IDES Packager 2018 requires Windows 7, 8 or higher with MS .NET Framework 4.0.

- To package data allows a user to take a plain text 8966 XML file and compile it into an IDES compatible data archive. This utility will sign, compress and encrypt data and save it to the chosen output directory.
- To unpackage data allows a user to decrypt their IDES notification package for review.

See IDES Overview
Digital Certificates
The IDES Packager requires a Digital Certificate and a Key for all files going to the IRS. However, some users only generate XML files as their country might not require IDES encryption; thus no certificate is necessary (see Cayman Islands and Other Countries, below).

A digital certificate binds digital information to physical identities and provides non-repudiation and data integrity. Before beginning the IDES enrollment process, each entity should obtain one valid digital certificate issued by an approved certificate authority (CA). IDES stores your public key and related digital certificate. IDES only recognizes and accepts digital certificates issued by IRS approved certificate authorities.


Key
Most digital certificates include an embedded key. Some digital certificates include a separate key that must be placed in the same folder as the certificate and share the same naming convention, e.g., XYZ123.certificate and XYZ123.key.

Package XML File
Users must create an XML file prior to this step, see 8966 XML File Wizard.

1. On the task panel select Create XML > IDES Packager.
2. At the top of the IDES Packager screen select the "Package/Encrypt" radio button.
3. **Step 1:** Browse for the 8966 XML File. In a default installation the file is located at C:\1099 Pro\Pro66T18\MagFiles.
4. **Step 2:** Browse for your Digital Certificate or private key, regardless of which is selected the other is chosen as well, provided the associated file has the same naming convention and is located in the same folder. For example, selecting XYZ123.crt prompts the software to look for XYZ123.key. Enter the digital certificate passphrase if required.
5. **Step 3:** Select a recipient certificate. A recipient certificate is provided from the host tax country authority; e.g., the Philippines receives their recipient certificate from the Philippines government tax authority.
6. **Step 4:** Select an output directory (optional).
7. **Step 5:** Click the "Create" button to create the package. The digital certificate is verified. If a passphrase is required it is validated.
8. This process combines your XML and certificate information into a .ZIP file which is then signed by the key. Upload this file to the IDES site at https://www.ides-support.com/.

Unpackage/Decrypt XML File

1. On the task panel select Create XML > IDES Packager.
2. At the top of the IDES Packager screen select the "Unpackage/Decrypt" radio button.
3. **Step 1:** Browse for the IDES notification package.
4. **Step 2:** Browse for your Digital Certificate. Enter your digital certificate passphrase if required.
5. **Step 3:** Select a certificate for the sender of the IDES notification package.
6. **Step 4:** Select an output directory (optional).
7. **Step 5:** Click the "Extract" button to unpack and decrypt the archive. The digital certificate is verified. If a passphrase is required it is validated.

**Cayman Islands and Other Countries**
This software officially supports Model 2 IGA (IRS) filings which require IDES encryption. Model 1 IGA countries, such as the Cayman Islands, should contact their host country tax authority (e.g., the Cayman Islands government) for specifications since they are submitting files to them and not the IRS. **Not all countries require IDES encryption.** See [Cayman Islands AEOI Portal](#).

**IDES Overview**

**International Data Exchange Service (IDES) Overview**
All FATCA electronic filings are processed through the Production IDES Gateway: [https://www.idesgateway.com/](https://www.idesgateway.com/). To get started please visit the IRS for an overview on how to enroll and obtain a User ID/Password to begin transmissions at [https://www.irs.gov/businesses/corporations/international-data-exchange-service](https://www.irs.gov/businesses/corporations/international-data-exchange-service).

The FATCA reporting specification for e-filing and communication with the IDES Gateway is in XML format. Moving forward as the form changes and compliance changes, the XML also is updated. For the latest specifications and compliance, please visit their website at [https://www.irs.gov/businesses/corporations/fatca-xml-schemas-and-business-rules-for-form-8966](https://www.irs.gov/businesses/corporations/fatca-xml-schemas-and-business-rules-for-form-8966).

**IDES Testing**
Users can optionally create test XML e-files within 8966 Pro. Please note that any production files submitted to the test environment are not processed. Do not submit production files to the test environment or test files to the production environment. Please visit the IRS website for the next IDES testing window: [https://www.irs.gov/businesses/corporations/ides-testing-schedule](https://www.irs.gov/businesses/corporations/ides-testing-schedule).

**IDES Help and FAQs**
The IRS posts common responses to frequently asked questions regarding FATCA compliance and e-filing issues at [https://www.irs.gov/businesses/corporations/fatca-ides-technical-faqs](https://www.irs.gov/businesses/corporations/fatca-ides-technical-faqs). For questions not addressed in this help file or in the IDES FAQ, contact the IDES Help Desk via email at support@ides.desk-mail.com.

See [IDES Packager](#).

**NIL Reports**

**Who Must File NIL Reports? What Is The Submission Procedure?**
Only Direct Reporting Non-Financial Foreign Entities (NFFEs) are required to submit nil reports. For all other entities, submission of nil reports is not mandatory and submission of these reports is optional. While nil reporting might not be required by the IRS, it might be required by the local jurisdiction. Please check with your local tax administration. Nil reports that are submitted must provide Reporting FI information. The report contains Reporting Group, but it does not contain any account reports or pooled reports. Reporting group can be empty or can contain Sponsor or Intermediary information.

UK financial institutions (FIs) that have no US-reportable accounts will not be required to submit annual 'nil returns' in order to ensure compliance with new rules designed to prevent tax evasion by US citizens, HM Revenue and Customs (HMRC) has confirmed. The change comes after the US Internal Revenue Service (IRS) updated its own Foreign Accounts Tax Compliance Act (FATCA) information to clarify that it itself does not require nil returns but that they might be required by the FI's local tax authority.


Generate NIL Report
Prior to generating a NIL Report please view https://www.1099pro.com/videos.asp “How to Create a NIL Report with 8966 Professional. 8966 Pro only allows a NIL Filer to create a NIL Report; please see To Create a NIL Filer below.

1. On the task panel select Create XML > XML V2.0 File.
2. At the Filing Tax Forms via eFiling screen click the "Create a NIL Report" button.
3. In the NIL Report Wizard review important onscreen information. Click "Next" to continue or "Back" at any time to go back a step.
4. Check for software updates and click "Next" to proceed. Although not required to continue with this process, it is always smart to update to the most recent version of the software.
5. Tag Filers to include in the report. Click "Next".
6. Select the Type of File to create. Click "Next".
7. Review the default destination folder for the NIL report; in a standard installation this is C:\1099 Pro\Pro66T18\MagFiles. Click "Next" to continue.
8. Review Contact and Company information and update as necessary. The default Reporting Period for the NIL Report is year-end, i.e., 12/31/XXXX, but may be edited as needed. Click "Next".
9. Review onscreen settings then click "Finish" to generate the report.

Create a NIL Filer
8966 Pro only allows a NIL Filer to create a NIL Report.

1. On the task panel select Reporting F1 > My Filers List.
2. At the Filer Master List screen add a new filer or edit an existing filer.
   - The "Filer Is Used ONLY for NIL Reporting" box must be marked. This box is not available if editing a Filer with existing data.
   - A Payer Code (PCODE) is required, but the Filer/Agent EIN is not.
3. Click "Save".

Help & Extras
Correcting Filed Forms
For a fee the Service Bureau can Print+Mail and/or IRS File your corrections. Most users print the corrections themselves, in-house, and send only an IRS File to the Service Bureau. The cost to IRS File
corrections is a flat $45 per upload. The minimum cost to Print+Mail+IRS File is $85 per upload for Original or Corrected records.

**About Corrections—An Overview**
The About Corrections screen displays all form types that contain corrected records. To begin the process of making a correction(s), see [Correct a Record](#).

**View About Corrections Screen**
On the task panel select Help & Extras > Correcting Filed Forms. A red check displays to the left of any form type containing corrected records.

**When do I need to create a correction?**
If a return is filed with the IRS/SSA and an error is discovered it must be corrected *as soon as possible*. Some corrections require one return, others require two. All 1099 Pro software products intuitively create the appropriate corrected return(s) based on the type of correction created. Additionally, users must provide corrected returns to Recipients as soon as possible. Filers may be subject to penalties for failure to file correct information returns or furnish a correct payee statement. See [Types of Corrections](#).

**Corrections Deadlines**
Corrections are due within 30 days of the original filing deadline. After 30 days of the original filing deadline, Filers have until August 1st to submit corrections before the next potential penalty tier. For further information reference the [IRS General Instructions for Certain Information Returns](#), Failure To File Correct Information Returns by the Due Date (Section 6721) and Penalties: "If you do not file corrections and you do not meet any of the exceptions to the penalty, the penalty is $270 per information return". *It is never too late to file corrections—including prior year corrections, too!*

**Do I need to file corrections with the IRS?**
Filers only need to file a correction with the IRS/SSA if incorrect data was sent to the IRS. For example, if Recipient copies were mailed in January and errors were changed prior to sending data to the IRS/SSA, then no correction is necessary.

**Do I need to issue corrections to my Recipients?**
Yes, the IRS requires Filers to issue a "correct payee statement" to Recipients.

- If forms were sent with incorrect data to Recipients, but not to the IRS, consider sending Recipients a revised statement reflecting the accurate data. These forms will have a "Pending" or "Printed" status in the software. The corrected box is not marked; however, some Filers manually check the box with a pen to aid the Recipient in distinguishing the revised (good) form from the original issue form.
  - Filers can also force an "X" in the corrected box using the [Advanced Print Options](#). **Forcing an "X" does not qualify as a valid IRS correction.**

- If forms were sent with incorrect data to Recipients AND filed with the IRS, a formal correction is required and corrected copies must be both sent to the Recipient and filed with the IRS. After
generating the corrections these forms have a "Corr/Pend" status and the corrected box on the Recipient copy is automatically marked with an "X" when printed. See Correct a Record

Special Circumstances (10 Day Window)
If an IRS file was submitted within the last 10 calendar days and an error is discovered in it, the Service Bureau may be able to contact the IRS and request the file be marked as "BAD". Based on the User's individual circumstances, the Service Bureau will instruct the User to either 1) submit a new Original file to the Service Bureau, or 2) submit a Replacement file to the Service Bureau. The Service Bureau charges $85 to take this action on behalf of the customer in addition to any Service Bureau processing fees. Email sb@1099pro.com for assistance as soon as the error is discovered.

For More Information ...
Tax year 2018 form specific IRS/SSA instructions are available within this software installation and are accessible via the task panel > Help & Extras > IRS Pubs & Links. Double-click on any form or instruction to open, view or print it.

Correct a Record
Only forms that have been filed with the IRS/SSA are eligible to be corrected; prior to filing with the IRS/SSA it is only necessary to change (or update) the form. All 1099 Pro software corrections must typically be processed manually, one-by-one, at the Work With My Tax Forms screen. See About Corrections

As of Tax Year 2016 — De minimis corrections do not need to be printed or filed UNLESS the Recipient specifically requests it. Filers are no longer required to create corrections if the amount difference is $100 or less and $25 or less for any tax withheld box. See the IRS General Instructions for Certain Information Returns for specific details.

Correct a Form
1. On the task panel select Preparing My Forms > Work With My Tax Forms.

2. At the Work With My Tax Forms screen highlight the record and click the "Change" button. Only records with an SB Filed, Filed Mag or 1096 Filed status are eligible for corrections.

3. At the Protected Form Update Options screen click the "Create Correction" button.

4. Users are presented with an unadjusted version of the record to correct. Click on any field to adjust and enter the revised value.
   • To change the TYPE of TIN delete the ENTIRE number and then enter it with the dashes placed as appropriate for an SSN or EIN.
   • Recipient mailing address changes can be processed as a correction for printing purposes; however, these types of corrections are only eligible for filing with the IRS if there is a change of STATE in the mailing address field. Records with a corrected CITY or STREET ADDRESS are automatically excluded from Corrected IRS files.
   • All fields with revised information values turn BLUE.
   • The bottom of the form includes a brief summary of any changes in the "Correction Type" box.
   • The Payer/Filer/Employer field is not available to correct at this screen. To correct this field please contact the Service Bureau for support.
5. When done with corrections click the "Save Form" button. The Protected Form Update Options screen displays with the ability to view the original form or the corrected form and to view its audit trail. Click "Close" to exit the Protected Form Update Options screen.
   - Depending on the type of correction made, records will have a "Corr/Pending" or "Zero/Pending" status.
   - Mail a copy of the corrected form to the Recipient (see Quick-Print), AND
   - File the correction with the IRS/SSA as soon as possible.

**Correct a CORRECTED Form (1099 Pro, 1042-S Pro and W-2 Pro Users)**
Use this process to correct an already filed corrected form.

1. First create a NEW record with the same information as the FIRST corrected return.

2. Update the record status to FILED. This can be forced by creating a dummy Electronic Filing for it — make sure to select Manual Transfer at Step 3 (see image). Paperwork will print out after you click "Upload My File". **Discard the paperwork and DO NOT POST the file to the Service Bureau FTP site** (or else your data will be double-filed with the IRS!).

3. Return to the Work With My Tax Forms screen and create a correction of the record as outlined above.

**Correct a PRIOR YEAR Form**
Corrections to prior year forms must be handled in the appropriate program year version. For example, a 2016 1099-INT correction must be created in 1099 Pro 2016. Users can send that correction to the Service Bureau for filing for a fee or contact the IRS at 1-800-TAX-FORM and request
a Copy A and 1096 Transmittal for the appropriate tax year and form type. To electronically submit a prior year file directly to the IRS/SSA FIRE site, users must first manually edit the record. For information on manually editing a prior year correction please contact Technical Support at 888-776-1099.

**Corrections—Special Circumstances**

- **10 Day Window**—If an IRS file was submitted within the last 10 calendar days and an error is discovered in it, the Service Bureau may be able to contact the IRS and request the file be marked as "BAD". Based on the User's individual circumstances, the Service Bureau will instruct the User to either 1) submit a new Original file to the Service Bureau, or 2) submit a Replacement file to the Service Bureau. The Service Bureau charges $85 to take this action on behalf of the customer in addition to any Service Bureau processing fees.

- **Type 1 Only Corrections**—If corrections are Type 1 only (dollar field amount changes only—NO Name or TIN changes) the user can import a file and the Service Bureau may be able to manually edit the Original file and code it as a Corrected file. Contact the Service Bureau for specific guidelines, limitations and fees regarding this process.

See [Types of Corrections](#) for specific guidelines.

**8966 Corrections - An Overview**

**8966 Pro handles three types of corrections:**

- Amended—Process filed forms that were subsequently amended.
- Voided—Send voided forms that you individually marked as void.
- Corrected—Corrected Data is used for records being re-transmitted after the IRS has notified the sender of a problem with the file or underlying data. Only select Corrected Data if responding to an IRS request to correct the data (do not use for Decryption, XML or other file-level errors).

Effective TY 2016, corrections require reference to a unique RFID.

**Change Data On a Previously Filed Form:**

1. At the Work With My Tax Forms screen double-click on the appropriate recipient to access the Protected Form Update Options screen.

2. Click the “Correct/Amend/Void” button.

3. The Changing a Form 8966 Correction screen displays. Change record as necessary:
   - If this record should never have been sent in, click the VOID box and save the form. Then go to Create XML and generate a VOIDED XML file.
   - To change the values on a record, click the AMENDED box. Make changes and save the form. Then go to Create XML and generate an AMENDED XML file.
   - To re-transmit a file to the IRS because the IRS instructed you to do so, click on the CORRECTED box. Make changes and save the form. Then go to Create XML and generate a CORRECTED XML file.

Remember to use the IDES Packager and then transmit the corrected XML file(s) to IDES.
Protected Forms Options
Use the Protected Forms Options screen to view a "protected" record, create corrections and display a history of record changes. Records with any status besides Pending are "protected" from edits. See Record Status Overview

Initiate Correction
Most records at the Work With My Tax Forms screen with an SB Filing, Mag Media or Filed 1096/W-3/1042-T status can be corrected. See About Corrections—An Overview

1. Highlight the record and click the "Change" button.
2. At the Protected Form Update Options screen click the "Create Correction" button. See Correct a Record
3. Return to the Protected Form Update Options screen after completing and saving the correction. Use the "Close" button to exit the screen and return to the Work With My Tax Forms screen where the Original, Corr/Pending and Zero/Pending (if applicable) records can be easily viewed and Quick-Printed.

Protected Form Update Options screen
Use this screen to access protected records for viewing, reprints or initiating corrections.

1. At the Work With My Tax Forms screen highlight any "protected record" (i.e., effectively any record except those with a Pending status).
2. Click the "Change" button to access the Protected Form Update Options screen.
   • Use the "Field Update History" button to view a record's history of changes.

Types of Corrections
All 1099 Pro software products handle corrections. Service Bureau customers can file corrections for a nominal fee. See About Corrections and IRS Pub.1220, Section 11 Corrected Returns (online), for detailed information on corrections.

One-Transaction Corrections
Sometimes referred to as "Error Type 1", applies to Original returns filed with one or more of the below errors. These errors require only one return to make the correction and the corrected record will have a "Corr/Pending" status.

a) Incorrect payment amount codes in the Payer "A" Record
b) Incorrect payment amounts in the Payee "B" Record
c) Incorrect code in the distribution code field in the Payee "B" Record
d) Incorrect payee indicator
e) Return should not have been filed.

Create One-Transaction Correction
A. Form 1098, 1099, 5498, or W-2G
   1. Prepare a new information return.
   2. Enter an "X" in the "CORRECTED" box (and date optional) at the top of the form.
3. Correct any recipient information such as money amounts and address. Report other information as per original return.

B. Form 1096
   1. Prepare a new transmittal Form 1096.
   2. Provide all requested information on the form as it applies to Part A, 1 and 2.
   3. File form 1096 and Copy A of the return with the appropriate service center.

NOTE: Do not include a copy of the original return that was filed incorrectly.

Two-Transaction Corrections
Sometimes referred to as "Error Type 2", applies to Original returns filed with one or more of the below errors. These errors require two separate returns to make the correction; the corrected records will include a "Zero/Pending" and "Corr/Pending" status. Do not use this process to correct money amounts.

a) No payee TIN (SSN, EIN, ITIN QI-EIN or ATIN)
b) Incorrect payee TIN
c) Incorrect payee name and address
d) Wrong type of return indicator. For example, a Form 1099-DIV was filed when a Form 1099-INT should have been filed.

Create Two-Transaction Correction
Step 1. Identify incorrect return submitted.
   1. Prepare a new information return
   2. Enter an "X" in the "CORRECTED" box (and date (optional) at the top of the form
   3. Enter the payer, recipient, and account number information exactly as it appeared on the original incorrect return; however, enter 0 (zero) for all money amounts.

Step 2. Report correct information.
   A. Form 1098, 1099, 5498, or W-2G
      1. Prepare a new transmittal Form 1096.
      2. Do not enter an "X" in the "CORRECTED" box at the top of the form. Prepare the new return as though it is an original.
      3. Include all the correct information on the form including the correct TIN, name, and address.

   B. Form 1096
      1. Prepare a new transmittal Form 1096.
      2. Enter the words "Filed To Correct TIN", "Filed to Correct Name and Address", or "Filed to Correct Return" in the bottom margin of the form.
      3. Provide all requested information on the form as it applies to those returns prepared in Steps 1 and 2.
      4. File Form 1096 and Copy A of the return with the appropriate service center.

NOTE: Do not include a copy of the original return that was incorrectly filed.
IRS Pubs/Links
This software installation includes many helpful IRS/SSA forms and instructions. Additionally, users with an active Internet connection can access current versions of these and other files directly from the IRS/SSA websites. All documents are in PDF format and require Acrobat Reader to be viewed or printed. Download Acrobat Reader for free at www.adobe.com.

Print IRS Forms & Instructions
View Local Files
1. On the task panel select Help & Extras > IRS Pubs & Links.
2. At the View or Print Blank Forms and Instructions screen set the Current View to "Local files installed on my machine".
3. Highlight a PDF document and click "View the Selected Form". The selected file opens automatically in Acrobat Reader.

View Files on Internet
1. User must have an active Internet connection.
2. Follow the appropriate links provided at the Browse IRS Tax Forms help topic.

CAUTION: Copy A Forms and 1096 / W-3 Transmittals
The IRS requires most Copy A* forms and all 1096 and W-3 Transmittal sheets to be preprinted with a special red ink that is invisible to their scanners. Do NOT send a black and white printout of those forms as they will be rejected.

* Copy A for Forms W-2 and 1042-S can be printed directly to blank paper; the special preprinted red ink is not required for these forms.

Browse IRS Tax Forms
Various IRS/SSA instructions are included in all 1099 Pro software installations via the task panel > Help & Extras > IRS Pubs & Links. Some items can be viewed online with an active Internet connection. All documents are in PDF format and require Acrobat Reader to be viewed or printed. Download Acrobat Reader for free at www.adobe.com.

Users with an active Internet connection can access many other files directly from the IRS/SSA websites.

IRS Telephone Assistance: Information Reporting Customer Service Site
For questions about reporting on Forms 1096, 1098, 1099, 5498, W-2, W-2G, and W-3 call toll-free (866) 455-7438 or (304) 263-8700 or E-mail mccirp@irs.gov. For TTY/TDD equipment, call 304-267-3367 (not toll free).

The hours of operation for the call site are Monday through Friday from 8:30 a.m. to 4:30 p.m., Eastern time.

Other tax-related matters
For other tax information related to business returns or accounts, call (800) 829-4933.
Ch. 6 Troubleshooting

Error Messages

Error messages appear as pop-ups within the software due to user error or a software bug. Many of these errors have simple solutions that can be easily applied by the user, the user's IT department or 1099 Pro Tech Support. Prior to applying any solution backup data to avoid any possible data loss.

Most error messages result from one or more of the following issues:
- Inadequate user rights to read/write/modify data files and/or folders; please contact your internal IT support to verify your user rights.
- Incorrectly mapped data file.
- Third party AV programs (anti-virus) removing critical software files.
- Incomplete software updates.
- Minimum TLS 1.1 browser requirement not met.

Common Error Messages & Solutions
- Error Code 0002:0005
- Invalid Record Declaration Error 47
- ERROR: Uploaded Data Size Mismatch
- Unable to Open Required File (ProTips): 2 — File Not Found
- Unable to Open Required File (ProTips): 3 — Path Not Found
- Unable to Open SystemID: 2 — File Not Found
- Unable to Open SystemID: 3 — Path Not Found
- Unable to Open SystemID: 5 — Access Denied
- Unable to Open SystemID: 53 — Invalid Clarion File
- Clarion Trappable Runtime Errors
- EC002—Unable to Open Files
- Error Code #0008—Can’t Find Stub Loader
- Could Not Load DLL Library \USER32.DLL
- Single User Version Error
- File Not Found: Information Request
- Software Not Responding

Authorization Code Error

If an Authorization Code does not work it is almost always because an incorrect version of the software was installed. For example, a 1099 Pro Enterprise Authorization Code is incompatible with a 1099 Pro Professional installation; likewise a W-2 Pro 2017 Authorization Code is incompatible with a W-2 Pro 2018 installation. Users should verify that the version installed matches the version purchased.

Antivirus Exceptions

1099 Pro software requires full rights to certain folders and subfolders plus a carve-out from any antivirus programs (e.g., Norton, McAfee, Sophos, Kaspersky, Webroot, etc.). This includes full rights and permissions to where the software is installed—which is typically C:\1099Pro—and all
subfolders. In the case that your data folder is on a network, users will also need full rights to the Data folder where the .TPS files reside.

Antivirus (AV) programs often prevent installations, software updates and corrupt data files. The following assumes that the software is installed in the default installation locations. Be sure to create exceptions which correspond to where the software is launched from and where your data (.TPS) files reside.

For detailed instructions on setting up a carve-out for 1099 Pro software products please refer to the 1099 Pro WIKI at https://wiki.1099pro.com/display/PDWA/Antivirus+Exceptions.

**Error Code 0002:0005**

**Issue**

Error Code#: 0002:0005

**Solution**

Perform a fresh download and install with AV programs disabled.

The first part of the error code (0002) tells us that the LoadLibraryA Windows API call to load the "unpacked" high-performance decompression library (located in the temporary Windows folder) failed. The return value is NULL. The second part of the error code (0005) is the return value from the GetLastError Windows API. It returns a typical ERROR_ACCESS_DENIED = 5 (0x5) = Access is denied error.

This most likely means that the system "blocks" your setup (anti-virus system, anti-spyware system, Windows Defender, etc.) and is caused by a bug in the protection system.

**Invalid Record Declaration (47)**

**Issue**

File Access Error: Invalid Record Declaration (47)

**Solution:**

This error can occur when either system latency or anti-virus software interrupts the record-numbering process. Please contact 1099 Pro Technical Support to further assist in renumbering records.

**Uploaded Data Size Mismatch**

**Issue**

User is unable to upload SB Print + Mail, SB Filing or SB Bulk TIN files to the Service Bureau.

**Solution**

This error occurs when users generate an upload file to transmit to the Service Bureau and select a **non-local destination drive** during the wizard; user is typically changing the Destination folder to a network drive. The upload file must be saved to a LOCAL COMPUTER DRIVE.
Unable to Open Required File (ProTips): 2—File Not Found

Issue
Unable to Open Required File (ProTips): 2 – File Not Found

Solution
This error most often occurs if there was an error during installation or an error when mapping the file path to your data folder. First, verify the software is not running from a network location; the software must be run locally, or from a client installation linked to a hosted data file.

The software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Unable to Open Required File (ProTips): 3—Path Not Found

Issue
Unable to Open Required File (ProTips): 3 – Path Not Found

Solution
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Txx\Admin.
- Open the file Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Txx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Unable to Open SystemID: 2—File Not Found

Issue
Unable to Open SystemID: 2 – File Not Found

Solution
This error most often occurs if there was an error during installation, or if a third party virus protection software removed 1099 Pro program files. Verify the file "Systemid.TPS" exists; located in
file path C:\1099 Pro\Pro99Tx\Resource. If this file has been removed, or was blocked from installation, you may need to backup your data, then uninstall and reinstall the software. Be sure to list 1099 Pro as trusted software in your anti-virus software to avoid having files removed.

If "Systemid.TPS" is present, it's possible that the file path to your data contains unacceptable characters. This can be changed by editing your .INI file:

- Navigate to C:\1099 Pro\Pro99Tx\Admin.
- Open the file Pro99Tx.INI.
- Locate the file path associated with "SAV:GlobalDataPath".
- Make sure the data file path does not contain a backslash at the end of the path, or any periods if using a UNC. For example: \stationx.1099pro.com\c\xxx\.
- Save and run the software again.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Tx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Please contact 1099 Pro Technical Support to further assist in renumbering your records.

Unable to Open SystemID: 3—Path Not Found

Issue
Unable to Open SystemID: 3 – Path Not Found

Solution
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternatively, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Tx\Admin.
- Open the file Pro99Tx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Tx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Unable to Open SystemID: 5—Access Denied

Issue
Unable to Open SystemID: 5 – Access Denied

Solution
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. First contact your IT department to verify that the rights are correct in both the
shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for further guidance.

Unable to Open SystemID: 53—Invalid Clarion File

Issue
Unable to Open SystemID: 53 – Invalid Clarion File, Driver Type Topspeed

Solution
This error most often occurs when the software is not linked to the correct data file. This can be fixed by reinstalling and directing the workstation to the proper data folder. Alternately, the software may be redirected to the correct data file by editing the .INI file:

- Navigate to C:\1099 Pro\Pro99Tx\Admin.
- Open the file Pro99Txx.INI.
- Edit the file path associated with "SAV:GlobalDataPath" to point to your data file.
- Save and run the software.

Please note that the default location for a single-user install saves the data file in C:\1099 Pro\Pro99Tx\Data. If setting up a multi-user workstation, the data folder is most likely in a custom location specified during the server installation.

Clarion Trappable Runtime Errors
The following errors can be trapped in code with the ERRORCODE and ERROR procedures. Each error has a code number (returned by the ERRORCODE procedure) and an associated text message (returned by the ERROR procedure) indicates the issue.

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2—File Not Found</td>
<td>The requested file does not exist in the specified directory.</td>
</tr>
<tr>
<td>3—Path Not Found</td>
<td>The directory name specified as part of the path does not exist.</td>
</tr>
<tr>
<td>4—Too Many Open Files</td>
<td>The total number of file handles available has been used. Check the FILES= setting in the CONFIG.SYS file, or the user’s or network’s simultaneous open files setting in a network environment.</td>
</tr>
<tr>
<td>5 —Access Denied</td>
<td>The file has already been opened by another user for exclusive access, has been left in a locked state, or you do not have network rights to open the file. This error can also occur when no disk space is available.</td>
</tr>
<tr>
<td>7—Memory Corrupted</td>
<td>Some unknown memory corruption has occurred.</td>
</tr>
<tr>
<td>8—Insufficient Memory</td>
<td>There is not enough unallocated memory left to perform the operation. Closing other applications may free up enough memory.</td>
</tr>
<tr>
<td>15—Invalid Drive</td>
<td>An attempt to read a non-existent disk drive has failed.</td>
</tr>
<tr>
<td>27—Invalid Table Declaration</td>
<td>An attempt to open a table that has an invalid table structure has failed. This is normally found when a Dynamic File has been created incorrectly. Also seen in IP Driver based applications.</td>
</tr>
<tr>
<td>30—Entry Not Found</td>
<td>A GET to QUEUE has failed. For GET(Q,key), the matching key value was not found, and for GET(Q,pointer), the pointer is out of range.</td>
</tr>
<tr>
<td>32—File Is Already Locked</td>
<td>An attempt to LOCK a file has failed because another user has already locked it.</td>
</tr>
<tr>
<td>Error</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>33—Record Not Available</td>
<td>Usually an attempt to read past the end or beginning of file with NEXT or PREVIOUS. May also be posted by PUT or DELETE when no record was read before the attempted PUT or DELETE.</td>
</tr>
<tr>
<td>35—Record Not Found</td>
<td>For a GET(File,key), the matching key field value was not found.</td>
</tr>
<tr>
<td>36—Invalid Data File</td>
<td>Some unknown data file corruption has occurred, or the OWNER attribute does not match the password used to encrypt the file.</td>
</tr>
<tr>
<td>37—File Not Open</td>
<td>An attempt to perform some operation that requires the file be already open has failed because the file is not open.</td>
</tr>
<tr>
<td>38—Invalid Key File</td>
<td>Some unknown key file corruption has occurred.</td>
</tr>
<tr>
<td>40—Creates Duplicate Key</td>
<td>An attempt to ADD or PUT a record with key field values that duplicate another existing record in the file has been made to a file with a key that does not allow duplicate entries.</td>
</tr>
<tr>
<td>43—Record Is Already Held</td>
<td>An attempt to HOLD a record has failed because another user has already held it.</td>
</tr>
<tr>
<td>45—Invalid Filename</td>
<td>The filename does not meet the definition of a valid DOS filename.</td>
</tr>
<tr>
<td>46—Key File Must Be Rebuilt</td>
<td>Some unknown key corruption has occurred that requires the BUILD statement to re-build the key.</td>
</tr>
<tr>
<td>47—Invalid Record Declaration</td>
<td>The data file on disk does not match the file's declaration in the .EXE, usually because you have changed the file's definition in the Data Dictionary and have not yet converted the existing data file to the new format. See Error 47.</td>
</tr>
<tr>
<td>48—Unable to Log Transaction</td>
<td>A transaction logout or pre-image file cannot be written to disk. This usually occurs because no disk space is available, or the user does not have the proper network rights.</td>
</tr>
<tr>
<td>52—File Already Open</td>
<td>An attempt to OPEN a file that has already been opened by this user.</td>
</tr>
<tr>
<td>54—No Create Attribute</td>
<td>An attempt to execute the CREATE procedure on a file whose declaration does not include the CREATE attribute.</td>
</tr>
<tr>
<td>55—File Must Be Shared</td>
<td>An attempt to open a file for exclusive access that must be shared. (Legacy error, no longer used)</td>
</tr>
<tr>
<td>56—LOGOUT Already Active</td>
<td>An attempt to issue a second LOGOUT statement while a transaction is already in progress.</td>
</tr>
<tr>
<td>57—Invalid Memo File</td>
<td>Some unknown memo file corruption has occurred. For Clarion data files, this could come from a corrupt .MEM file &quot;signature&quot; or pointers to the memo file in the data file that are &quot;out of sync&quot; (usually due to copying files from one location to another and copying the wrong .MEM file).</td>
</tr>
<tr>
<td>63—Exclusive Access Required</td>
<td>An attempt to perform a BUILD(file), BUILD(key), EMPTY(file) or PACK(file) was made when the file had not been opened with exclusive access.</td>
</tr>
<tr>
<td>64—Sharing Violation</td>
<td>An attempt to perform some action on a file which requires that the file be opened for shared access.</td>
</tr>
<tr>
<td>65—Unable to ROLLBACK Transaction</td>
<td>An attempt to ROLLBACK a transaction has failed for some unknown reason.</td>
</tr>
<tr>
<td>73—Memo File Missing</td>
<td>An attempt to OPEN a file that has been declared with a MEMO field and the file containing that memo data does not exist.</td>
</tr>
<tr>
<td>75—Invalid Field Type Descriptor</td>
<td>Either the type descriptor is corrupt, you have used a name that does not exist in GET(Q,name), or the file definition is not valid for the file driver. For example, trying to define a LONG field in an xBase file without a matching MEMO field.</td>
</tr>
<tr>
<td>76—Invalid Index String</td>
<td>The index string passed to BUILD(DynIndex,string) was invalid.</td>
</tr>
<tr>
<td>Error</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>77—Unable To Access Index</td>
<td>An attempt to retrieve records using a dynamic index failed because the dynamic index could not be found.</td>
</tr>
<tr>
<td>78—Invalid Number Of Parameters</td>
<td>You did not pass the correct number of parameters to a procedure called in an EVALUATE statement. Note: As of Clarion Version 6.2 (9047), the SQL Drivers now add more information to the trace log file, explaining why the ERRORCODE 78 was generated.</td>
</tr>
<tr>
<td>79—Unsupported Data Type In File</td>
<td>The file driver has detected a field in the file declared with a data type that is not supported by the file system the driver is designed to access.</td>
</tr>
<tr>
<td>80—Unsupported File Driver Function</td>
<td>The file driver has detected a file access statement that is not supported. This is frequently an unsupported form (different parameters) of a statement that is supported.</td>
</tr>
<tr>
<td>81—Unknown Error Posted</td>
<td>The file driver has detected some error from the backend file system that it cannot get further information about.</td>
</tr>
<tr>
<td>88—Invalid Key Length</td>
<td>An attempt to CREATE a Clarion file driver KEY or INDEX with more than 245 characters. Other file drivers can also return this error when their file system key length limits are exceeded.</td>
</tr>
<tr>
<td>89—Record Changed By Another Station</td>
<td>The WATCH statement has detected a record on disk that does not match the original version of the record about to be updated in a network situation.</td>
</tr>
<tr>
<td>90—File Driver Error</td>
<td>The file driver has detected some other error reported by the file system. You can use the FILEERRORCODE and FILEERROR procedures to determine exactly what native error the file system is reporting.</td>
</tr>
<tr>
<td>91—No Logout Active</td>
<td>The COMMIT or ROLLBACK statement has been issued outside of a transaction frame (no LOGOUT statement has been executed).</td>
</tr>
<tr>
<td>92—BUILD in Progress</td>
<td>A BUILD statement has been issued and PROP:ProgressEvents has been set to generate events. The statement generating this error is not appropriate to execute during a BUILD process.</td>
</tr>
<tr>
<td>93—BUILD Cancelled</td>
<td>The user cancelled the BUILD. This error is set when EVENT:BuildDone is posted.</td>
</tr>
<tr>
<td>94—Record Limit Exceeded</td>
<td>The target file has exceeded the record limit. This value is file driver dependent, and can be returned during any attempt to modify a file where the record limit is exceeded.</td>
</tr>
<tr>
<td>97—Stream Error</td>
<td>Used during RTF processing.</td>
</tr>
<tr>
<td>100—Trigger Error</td>
<td>This error is set whenever a registered file callback method returns FALSE. See CALLBACK.</td>
</tr>
<tr>
<td>1010—Ilegal Expression</td>
<td>The EVALUATE procedure has detected an error in the syntax of the expression it is attempting to evaluate.</td>
</tr>
<tr>
<td>1011—Variable Not Found</td>
<td>The EVALUATE procedure has not found a variable used in the expression it is attempting to evaluate. You must first BIND all variables used in the expression for them to be visible to EVALUATE.</td>
</tr>
</tbody>
</table>

**EC002 - Unable to Open Files**

**Issue**
EC002 – Unable to Open Files!

**Solution**
This error most often occurs when attempting to restore data from the wrong year (e.g., data from 2017 into 2018 software). Users cannot restore data into a different year's software. This is a security measure to ensure that users do not accidentally file the wrong data.

Recipient and Filer information may be rolled forward during or immediately after installing. For more information, see Roll Forward Data.
Error Code 0008—Can't Find Stub Loader

Issue
Error Code #0008 - Can't Find Stub Loader / Uninstall Error
This error has been noted when software is uninstalled and then re-installed in Windows 7/8 for those users running Customer Experience Improvement Program (CEIP).

Solution
To Modify Windows CEIP Settings on Windows 7:
1. Click Start, select Control Panel, and click the Action Center.
2. In the left pane, click Change Action Center settings.
4. To turn off the Windows CEIP, select "No, I don't want to participate in the program", and then "Save Changes".

Error Could Not Load DLL Library

Issue
Could not load the DLL library C:\Windows\USER32.DLL.
The specified module could not be found.

Solution
This error occurs when a user does not have full read/write/edit privileges to the location where the data folder is hosted. Contact your internal IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are set properly, contact 1099 Pro Technical Support for guidance.

Single User Version Error

Issue
Single User Version Error

Solution
This error occurs when a user does not have full read/write/edit privileges to the location where the software is installed. Contact your internal IT department to verify the rights are proper in both the shared location and the folder’s security settings. If your IT department has confirmed that your security settings are properly set, contact 1099 Pro Technical Support for guidance.

File Not Found: Information Request

Issue
File Not Found: Information Request

Solution
This error may occur when performing a Roll Forward procedure if some of the user selected items such as "Prior Year Security Settings" or "Prior Year Import Maps" do not contain data. For example, in the 2017 software security was not used or custom import maps were not created.

The user can click "OK" and continue with the installation.
Software Not Responding

Issue
User attempts to open 1099 Pro software and it is non-responsive after user restarts both 1099 Pro software and computer. Issue is most likely due to the software attempting—unsuccessfully—to launch the web update during start up.

Solution
In the user's Pro99T18.INI file, typically located at C:\1099 Pro\Pro99T18\Admin, edit the LS=1 line to LS=0 and add LSX=0. These lines must be edited in both the [System] and [Preferences] sections of theINI file. Save changes and re-open 1099 Pro software.

User should periodically perform a manual check for software updates via the 1099 Pro menu bar > Help > Check for Updates to 1099 Pro.

Printer Issues
All 1099 Pro software products are designed to print the physical form and data directly to blank paper.

Margin Limitations
Most Windows compatible printers work with 1099 Pro software products, subject to the printer’s margin limitations. If your bottom margin is greater than 1/3-inch you may not be able to print data at the bottom of the page or you may have to print 2 forms to a page. Check your printer's manual and/or Maximum Printable Area for your BubbleJet, Deskjet, Inkjet or Laserjet with have questions.

- Preprinted forms accepting up to a 1/2-inch bottom margin: 1099-MISC, 1099-R
- Preprinted forms requiring 1/3-inch or less bottom margin: 1098, 1098-T, 1099-DIV, 1099-INT, 1099-PATR, 1099-S, 5498, 1099-B (Needs 1/36-inch additional room at the bottom margin.)

Data Truncation
1099 Pro recommends a 1/5-inch (0.20) bottom margin when printing to blank paper. Data truncation occurs if bottom margin is greater than 1/3-inch. Suggested workaround is to print 2 forms to a page instead of 3 forms per page.

Postscript Drivers
1099 Pro software prints to almost all Windows compatible printers. When opting to print to blank paper, the forms and/or fonts may print too large or otherwise print strangely. This is typically due to printing with a postscript driver. To resolve this situation try printing to a PCL 5, PCL 6, EMF or any other non-postscript driver.

Default Printer
1099 Pro software may default to a specific printer. Always review the selected printer while choosing your paper type in the Print Wizard. To switch printers use the "Select a Different Printer or Port" button to access the "Print Setup" screen.
Random Print Errors
Occasionally AV programs (e.g., Norton, McAfee) can corrupt your software installation and cause random, inexplicable errors. If this occurs, backup your data files, perform a custom install and then reinstall the software with the virus checker disabled.

12 CPI (characters per inch)
Our software prints at 12 CPI to allow the maximum number of characters per field (e.g., 40 characters in a name field). Accordingly, your printer must be set at 12 CPI. To set your printer either:

- Adjust the front panel of the printer manually by setting the CPI to 12 and selecting a font like Courier. Do not select a proportional font or the IRS may penalize you per form, or
- In your Windows Control panel set your printer to 12 CPI. For example, in the case of many Epson printers hit the <ESC> key, type an uppercase M, and <ESC>M then displays in the box. This may differ for your printer.

Generic Print Driver
If 1099 Pro software indicates your driver is obsolete then consider installing an additional print driver.

Ch. 7 Tax Supplies
1099 Pro, Inc. sells IRS approved forms and envelopes compatible with our software products. Due to recent price increases in paper products and seasonal shipping issues we encourage customers to consider the Service Bureau for their Print+Mail and IRS Filing needs.

* Policies *
A 50% discount is available to all tax forms and envelopes orders placed by October 31st. Please note:

- The 50% discount applies ONLY late summer through October—no exceptions will be made.
- Large orders > $200 receive an additional 10% off in October, 5% off in November/December.
- During Busy Season (January through March) we cannot guarantee delivery turnaround times.
- There is a strict NO RETURN policy. Please double-check items before placing your order.
- All tax forms and supplies are subject to availability. Prices subject to change without notice.

Online Ordering
Customers can order laser forms and envelopes online for the current tax year only. In addition to placing orders, customers can view tax forms and a brief item description. Try it at https://www.1099pro.com/taxforms.asp. Learn more about Blank Laser Perforated Paper and Preprinted Forms and Pressure Seal/ACL printing.

Online Customer Account Access
Customers who've purchased items in the past year may go online to view prior orders and Authorization Codes. Order tracking is available to determine if your order has shipped. Log into your account at https://www.1099pro.com/acctLogin.asp and follow the prompts.
Phone Orders
Customers can place orders with our Sales team at (888) 776-1099.

Save Time—Go Green!
Use our Service Bureau to Print+Mail and/or IRS File your forms electronically—it's faster, easier, efficient and green. The Service Bureau provides users with email confirmation of all steps including file receipt, print date, and eFile date with IRS Confirmation number. Included at no additional cost:
- Optional submission to the IRS's (CF/SF) Program for participating forms and states.
- Automatic notification of the number of Name/TIN mismatches in your 1099 file.
- Four year data archival (retrievable for a fee).
- YouTube support videos and 7-day support in January.

Pricing for Print+Mail+IRS Filing is $1.15 per record (includes First-Class postage) with volume discounts available. See the Service Bureau Pricing Calculator or email sb@1099pro.com.

* Pricing and terms are effective July 2018 and are subject to change without notice.*

Blank Stock
All 1099 Pro software products are designed to print BOTH the tax form and Recipient data directly to blank paper. If printing in-house, there is no need to purchase preprinted tax forms for your Recipient copies. Most of our users prefer to outsource their printing to the 1099 Pro Service Bureau; our SOC I TYPE II facility is secure, fast and economical.

In-House Printing—Paper Options
1099 Pro, Inc. sells paper supplies and offers financial incentives to order paper products PRIOR to tax season. See Tax Supplies.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank Laser Perforated Stock</td>
<td>Print Copies B &amp;/or C plus instructions directly onto blank laser perforated stock. Easier to fold than blank copy paper because of the perforations and since it is blank...it won’t go out of date!</td>
</tr>
<tr>
<td>Blank Copier Paper</td>
<td>Print Copies B &amp;/or C directly onto blank copier paper. Good in case of an emergency when Blank Laser paper is unavailable (might require special folding and/or cutting to fit in standard IRS approved envelopes).</td>
</tr>
<tr>
<td>Preprinted Tax Forms</td>
<td>Print all copies to most IRS approved tax forms.</td>
</tr>
<tr>
<td>Pressure Seals Supplies</td>
<td>See Pressure Seal/ACL Overview</td>
</tr>
<tr>
<td>Envelopes, D/W, imprinted with &quot;Important Tax Information Enclosed&quot;</td>
<td>1099 Pro, Inc. sells a variety of envelopes to fit multiple blank stocks and preprinted forms.</td>
</tr>
</tbody>
</table>

Blank Stock Printing
Please watch our online video tutorial, Quick Tips: Print to Blank Paper.

Combined Print Option
When using blank stock the user selects the copies to print. The Print Wizard features a *Combined Print* option to print all required copies for the Recipient on one sheet (e.g., 1099-MISC Combined includes copies B, 2 and instructions). Users can select the individual copies for the Recipient, but then must manually collate the copies.

**Instructions**
The IRS requires Filers to send both tax forms and instructions to Recipients. Users can print instructions to blank paper either:
- As part of the Combined Print Option, outlined above.
- As part of a normal print run with one copy per Recipient and then collate instructions with the Recipient copies, OR
- Print instructions to one sheet now and photocopy it as many times as needed. Then use the reverse side of the photocopied sheets to print your Recipient forms.

**Preprinted Form Printing**
With preprinted laser forms the user selects the copies to print; for example, Copies A, B, C and/or the 1096/W-3 Transmittal. Preprinted forms are perforated, with each required copy containing the required information in an IRS/SSA approved ink (Copy A in red drop-out ink, Copy B in black, etc.). The special red ink is invisible to the IRS/SSA scanners. The Print Wizard pauses before printing each copy and the user is prompted to load the appropriate preprinted form into the printer.
Index

- 1 -
10 Day Window 62, 130
1042-S NQI Lookup 38
1042-S Pressure Seal 116
1042-S Print Options 116
1095-B Queries 55, 74
1095-C Queries 55, 74
1099 Pro Website Security 6
1099-MISC Optional Fields 81
12 CPI, Printing 146

- 4 -
4419 37

- 8 -
8966 IDES Reporting 26
8966 Pro 127
8966 Sponsored Entity Intermediary Lookup 38
8966 XML (FATCA Identification No.) 28
8966, Deadlines 18

- A -
Abandon Import Session 113
Abandoned Import 93
About Corrections 62, 130
Access Group 42
Access Groups, Assign Rights 43
Account Numbers Generation Wizard 71, 119
ACL Print 1042-S 116
Activate Software 5, 73
Activation Code 5, 73
Add a Filer 21
Add a Transmitter 37
Add a User 46
Add or Create Records 55, 74
Add Recipients 34
Adding a Filer 21
Address / Envelope Print Offsets 120

- Address Type 102
Advanced Print Options 120
Algorithm, Account Wizard 71, 119
Alias, Country 38
Align Margins, Preprinted Forms 122
Alignment Preprinted Forms 116
Alternate Combined Print 1042-S 116
Amount/Totals Report 69, 112
Antivirus Exceptions 138
ASCII Files Export 123
Assign User Profiles 44
Asterisk, Defined 107
Attachments, CS Only 36, 79
Audit Trail Report Filters 50
Audit Trails 79
Audit Trails Activity Report 48
Audit, SOC I Type II 6
Authorization Code 5, 73
Authorization Code Error 138
Auto Capitalize 50
Auto-Correction Import Types, CS Only 69, 109
AV Error, Invalid Record Declaration (47) 139
AV Errors 138
AVS Compliance Scans 6

- B -
Backup Data 15
Backup Settings 50
BackupXX.exe 15
Batch ID Field 81
Blank Stock 148
Browse by Form 76
Browse Filers 20
Browse IRS Tax Forms 137
Browse Notes 36, 79
Browse Recipients 29
Browse Records 55, 74
Browse Transmitter 37
Browser Requirements 6
Browsing & Working with Entry Forms 77
Bump Codes 5, 73
Business Rules 52

- C -
Can’t Find Stub Loader Error 145
Carve-Out 138
Category Field 81
Cayman Islands 127
Cayman Islands AEOI Portal, 8966 Pro 127
Cayman Islands Unsuccessful XML Errors 127
CEIP Error 145
CFS vs Std 60
Change a Recipient 34
Change a Record 55, 74, 83
Change TIN Type 77
Clarion File Error 142
Clarion Trappable Runtime Errors 142
Common Error Messages & Solutions 138
Completed Electronic Filing Session List 60
Composition 26
Contact Information 23
Contact Us 9
Control Totals Report 53, 113
Copier Paper 148
Correct a Correction 83, 132
Correct a Record 83, 132
Correct Prior Year Form 83, 132
Corrected Box - Force an X 120
Correction Types 135
Corrections, An Overview 62, 130
 Corrections, Print In-House 57, 115
Could Not Load DLL Library 145
Create Submitter 37
Create Transmitter 37
Current Sort/View 81
Custom Import Maps, Delimited/Excel 69, 109
Custom Print Message 120
Custom Query 55, 74
Custom Reports 92
Custom Reports, CS Only 53, 113
Custom Screen View 81
Custom Tax Form Validation Rules 52
Customer Experience Improvement Program (CEIP) Error 145

- D -
Data Entry Preferences 80
Data Files 15
Data Path, INI File 12
Data Recovery 17
Data Security 6
Data Size Mismatch Error 139
Data Truncation 146
Data, Roll Forward 17
Deactivate Business Rules 52
Deadlines, 8966 18
Deadlines, Corrections 62, 130
Decrypt XML File (8966) 127
Delete a Record 55, 74, 83
Delete Records, Group Action 86
Delimited 123
Delimited Import Maps 69, 109
Demo Mode 6
Department Indicator 80
Digital Certificate / Key (8966) 127
Display DELETED Records 60
Drag & Drop Import 69, 109
Drivers, Printing 146
Duplex Print 114
Duplicate a Filer 21
Duplicate Filers 22

- E -
EC002 - Unable to Open Files 144
Edit, Post or Abandon Import Records 66, 97
eFile 124
eFile Archiving, CS Only 60
eFile Log Summary Report 60
eFile Reset Session 125
Electronic Filing 60
Electronic Filing Overview 124
Electronic Filing Session Reset/ Void 125
Electronic Filing Session Window 60
Email 23
Email Forms 91
Email Support 9
Email, No Client Detected 91
Employee Master List 29
Encrypted PDF Tax Forms 91
Enter, Update and View Forms 55, 74
Enterprise Upgrade 11
Entry Forms 77
Envelope / Address Print Offsets 120
Envelopes, Order 147
Error & Validation Checking 107
Error Code 0002:0005 139
Error Code 0008—Can't Find Stub Loader 145
Error Messages 138
Error Scan Wizard, CS Only 72
Error Type 1 135
Error Type 2 135
Error User32.DLL 145
Error, Clarion Trappable 142
Error, Data File 140
Error, File Path 140
Error, Read/Write/Edit Privileges 141
Error: Invalid Record Declaration (47) 139
Error: Uploaded Data Size Mismatch 139
Errors - Import Checking 107
Errors & Warnings Report 53, 113
Errors, Import 66, 97
Excel Import Files 101
Excel Import Maps, NOT Sample Import Files 69, 109
Expiration and Reuse Options 41
Export ASCII Files 123
Export Database 123
Export Maps 109
Export Wizard, ASCII Format 123

- F -
False Print 116
FAQs 9
FATCA ID, GIIN 26
FATCA Identification Number 28
Fax 23
FFI 26
Field Filters 81
File Access Error 139
File Not Found 138
File Not Found Error 140
File Not Found Information Request 145
Filer 21
Filer Listing Report 55
Filer Master List Screen 20
Filer Name / Name Line 2 23
Filer Notes 36, 79
Filer NQI, Update 38
Filer Record Details 23
Filer Specific Import File Conventions 104
Filers, Duplicate 22
Files Already In Use 145
Filing Electronically 124
FIN FATCA Identification Number 28
FIN Number 8966 37
FIN Numbers - 8966 37
Find Errors 107
Finding & Fixing Problem Records 107
FIRE Uploads 60
Fixed Length 123
Flat File Export 123
Flip Records 10
Fonts, Small 6
Force "X" 120
Foreign Address - Filer 23
Form Counts by Filer Report 54
Form Counts Report 54
Form Source Field, Aggregation, CS Only 68, 99
Forms Issued by Filer Report 54
Forms, Order 147
Frequently Asked Questions 9

- G -
Gas & Oil Fields 81
GIIN Composition 26
GIIN Filer 21
GIIN, Add 27
Global Administrative Options 40
Global Intermediary Identification Number 26
Global Notes 36, 79
Group 42
Group Actions 55, 74, 86

- H -
Halt 138
Header Record Field Descriptions 104
Header Records 101, 102
History 79
Hosting 1
Hours, Support 9

- I -
IDES Help 129
IDES Overview 129
IDES Packager 127
IDES Test File 125
IDES Testing 129
Imp/Disc Import 93
Implied Decimal Formatting 69, 109
Import Data 64, 95
Import Errors 107
Import File Conventions 102
Import File Conventions, Filer Specific 104
Import File Issues 102
Import Filers 64, 95
Import Files, Sample Files 101
Import Large Files 100
Import Map Reports 112
Import Maps 109
Import Maps, Import/Export 111
Import Recipients, CS Only 64, 95
Import Records, Review Prior to Import 66, 97
Import Session Summary Report 69, 112
Import Sessions Screen 93
Import Status 64, 95
Import Wizard Overview 64, 95
IMPORT WIZARD—Step 1: Import Data, Filers or Recipients 64, 95
IMPORT WIZARD—Step 2: Validate Data 66, 97
IMPORT WIZARD—Step 3: Post Results 68, 99
Imports 93
Increased User Security 6
INI File, Data Path 12
INI Files 15
Install Multi-User Software 12
Install Single-User Software 11
Intermediary / Sponsored Entity 21
Internet 6
Invalid Clarion File 142
Invalid Record Declaration Error 139
IRS Instructions 137
IRS Telephone Numbers 137
IRS, Support 9
Location Code, Filer 23
Locked Record, Remove Lock 13
Lookup 35
LS=0 146
LS=1 146
- M -
Manage Profiles 44
Managed Services 1
Map By Name Import 69, 109
Map Report 112
Maps Import/Export 111
Margin Alignments 122
Master Recipient Record 31
McAfee 138
Menu Bar 7
Minimum Password Length 41
Modify Access Rights 42, 43
Multiple Recipients - One TIN 31
Multi-User Considerations 13
Multi-User Installations 12
- N -
Name Control 31
NEC Status Report 52
Network Import Error 64, 95
Network Install 12
NIL Filer, 8966 Pro 21
NIL Reports 124
No Email Client Detected 91
Nonresponsive software 146
Norton 138
Notes 36, 79
- O -
Oil & Gas Fields 81
Optimize Post 100
Optional Field Filters 81
Optional Fields - 1099-MISC Specific 81
Override Rules 52
- P -
Package XML File (8966) 127
Password - Individual Tax Forms 91
Password Expiration Options 41
Password Format Options 41
Password Lockout Reset 41
Password Options 41
Password Requirements 41
Path Not Found 138
Path Not Found Error 141
Payer Code, Filer 23
PCode Filer, Duplicate 21
Pcode, Duplicate Filer 22
PDF Recipient Forms 91
Penalties 19
PFFI 26
Phone 9
PII 6
Post Results 68, 99
Postscript Drivers, Printing 146
Preferences 50
Preprinted Forms Alignment 116
Preprinted Tax Forms 148
Pressure Seal/Alternate Combined Layout 116
Print 88
Print Corrections Myself 116
Print Forms, In-House 57, 115
Print Issues 146
Print Options 120
Print Preview 114
Print Status 89
Print Tax Forms 116
Print Users By Name Report 47
Print Wizard 116
Print Zeros Instead of Blanks 120
Printer, Troubleshooting 146
Printing In-House 57, 115
Printing Tax Forms Wizard 116
Pro Tips 138
Product Key 5, 73
Professional to Enterprise Upgrade 11
Profiles 44
Program Already In Use 145
Program Areas/Functions Report 47
Protected Form Options 80, 135

- Q -
Quick 88
Quick Print 88
Quick Reprint 86
Quick-Print Print Session 86

- R -
Raw Value 66, 97
Reactivate Business Rules 52
Receipt ID, CS Only 60
Recipient Listing Report 55
Recipient Lookup Screen 35
Recipient Master List 29
Recipient Notes 36, 79
Recipient Record Details 31
Recipient Search 35
Recipient TIN Unknown 31
Record History 79
Record Locking 13
Registration 5, 73
Reject Errors 107
Reject, Import 66, 97
Renew Software 5, 73
Report, Control Totals 53, 113
Report, Error Scan 72
Report, Forms Issued by Filer 54
Reprint Print Sessions 58
Reset (Void) Import Session 113
Reset eFile Session 125
Reset Import Session 69, 112
Reset Magmedia Session 125
Reset Print Session 57, 115
Restore Data 17
Review Import Data 66, 97
Review Import Records 66, 97
Rights Summary Report 47
Roll Forward Data 17
Roll Forward Error 145
RTN 23
Rules 52
- S -
Sample Import Files 101
Sample Import Files, Conventions 102
Search By Account Number, Name or TIN 35
Search Field, Not Working 81
Search for Recipient 35
Section 6721 19
Security - Access Group: Step 2 42
Security - Add Users to a Profile: Step 5 46
Security - Add/Update Individual Users: Step 4 46
Security - Manage Profiles: Step 3 44
Security & Administration 40
Security Audit 6
Security Overview 41
Security Password Options 41
Security Reports 47
Security Settings 41
Security, TLS 1.1 6
Select a Recipient 35
Select Department 80
Select Filer 74
Select GIIN 27
Select, Tag 10
SendingCompanyIN Error 127
Server Requirements 6
Service Bureau Corrections 62, 130
Session Tracking, CS Only 60
Set Password Requirements 41
Single User Version Error 145
SOC I Type II Certification 6
Software Not Responding 146
Software, Renew 5, 73
Sole Proprietors 31
Sophos 138
Source Field 81
Spon ENT Type Codes 21
Sponsored Entity Import 21
SSA Instructions 137
SSAE 16 SOC I Type II 6
Status Overview 89
Status, Import Records 64, 95
Status, Import Sessions 93
Step 2 - Validate Data 66, 97
Step 3: Final Import / Post Results 68, 99
Stop IRS File 62, 130
Submitter Information 37
Support Options 9
System Requirements 6
System Security Settings/Password Requirements: Step 1 41
SystemID.TPS Error 140

- T -
Tag Access Groups 43
Tag Records 10
Task Panel Defined 7
Tax Form Notes 36, 79
Tax Forms, IRS Instructions 137
Tax Reporting State 80
Tax State 80
Tax Supplies 147
TCC for AIR Site 37
TCC for FIRE System 37
Technical Support 9
TIN Masking - On/Off 120
TIN Masking, Default 23
TIN Missing 31
TIN Type - Change SSN to EIN or EIN to SSN 77
TIN Type, Change 31
TIN Unknown 31
TLS 1.1 6
Toolbar 7
TOPSPEED 138
Topspeed Error 142
TPS Files 15
Transactional Import Mapping, CS Only 69, 109
Transactions 5, 73
Transmitter Control Code 37
Transmitter Information 37
Troubleshoot Import Issues 64, 95
Troubleshoot Printer Issues 146
Troubleshooting 138
Tutorials 9
Type 1 Only Corrections 83, 132
Types of Corrections 135

- U -
Unable to Open Required File (ProTips): 2—File Not Found 140
Unable to Open Required File (ProTips): 3—Path Not Found 140
Unable to Open SystemID: 2 - File Not Found 140
Unable to Open SystemID: 3 - Path Not Found 141
Unable to Open SystemID: 53—Invalid Clarion File 142
Unable to Open SystemID: 5—Access Denied 141
UNC Mapping 12
Un-Delete a Record 83
Unfiled Forms Summary Report 52
Unlock Records During Import 13
Unsuccessful XML Errors, Cayman Islands 127
Untag Records 10
Update 1094/1095, CS Only 60
Update Country Alias 39
Update Users 46
Updating a Form 77
Updating a Record 77
Upgrade Professional to Enterprise 11
Upgrade Single-User/DEMO to Multi-User 12
Upgrade Software 5, 73
User Detail Report 47
User Group Detail Report 47
USER32.DLL Error 145

- V -
Validate Import Data 66, 97
Validation Checking 107
Validation Rules 52
Video Tutorials 9
View Deleted Records 83
View Only Access Rule 43
Virus Checkers 11
Void Box - Force an X 120
Void Import Session 69, 112, 113

- W -
Warnings, Defined 107
Windows 10 6
Windows Operating Systems 6
Work With My Tax Forms 55, 74
Work With My Tax Forms, Custom View 81

- X -
XLS Data Shells 101